Operating Instructions

Personal Entertainment Organizer

PEG-SL10/PEG-SJ20/PEG-SJ30

© 2002 Sony Corporation
Table of contents

About this manual ................................. 5
  Differences between the PEG-SL10,
  PEG-SJ20, and PEG-SJ30 .......................... 6

<table>
<thead>
<tr>
<th>Chapter 1</th>
<th>Basic operations of your Sony CLIÉ Handheld</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turning your Sony CLIÉ Handheld on and off</td>
<td>8</td>
</tr>
<tr>
<td>Using the stylus</td>
<td>9</td>
</tr>
<tr>
<td>Using the Jog Dial™ navigator</td>
<td>11</td>
</tr>
<tr>
<td>Entering data into your Sony CLIÉ Handheld</td>
<td>12</td>
</tr>
</tbody>
</table>
  Using Graffiti® writing to enter data | 12 |
  Using the onscreen keyboard | 21 |
  Using your computer keyboard | 23 |
| Adjusting the screen | 24 |
| Resetting your Sony CLIÉ Handheld | 25 |
  Performing a soft reset | 25 |
  Performing a hard reset | 26 |

<table>
<thead>
<tr>
<th>Chapter 2</th>
<th>Using basic applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing schedules and events (Date Book)</td>
<td>28</td>
</tr>
</tbody>
</table>
  Scheduling an event | 28 |
  Checking schedules | 35 |
  Editing Date Book events | 41 |
  Using the Date Book menus | 46 |
| Managing addresses and phone numbers (Address Book) | 48 |
  Creating a new Address Book entry | 48 |
  Viewing Address Book entries | 50 |
  Editing Address Book entries | 54 |
  Using the Address Book menus | 60 |
| Creating memos (Memo Pad) | 70 |
  Creating a new memo | 70 |
  Reviewing memos | 72 |
  Editing memos | 75 |
  Using the Memo Pad menus | 77 |
| Using Calculator (Calc) | 78 |
  Calculating with Calculator | 78 |
  Using the Calculator buttons | 79 |
  Using the Calculator menus | 79 |

<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>Exchanging and updating data using a HotSync® operation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Performing common tasks</td>
<td>80</td>
</tr>
</tbody>
</table>
  Using the Application Launcher | 80 |
  Categorizing records | 84 |
  Finding records | 87 |
  Protecting your data (Security) | 91 |
  Attaching notes | 97 |
  Purging records | 98 |
  Using the Edit menu | 99 |
  Choosing fonts | 100 |

Continued on next page
Table of contents

What is a HotSync® operation? ........ 102
Performing a local HotSync® operation
with the USB cable ...................... 103
Using the Palm™ Desktop for CLIÉ
software ..................................... 105
   Starting the Palm™ Desktop for CLIÉ
   software ..................................... 105
   Basic operations of the Palm
   Desktop for CLIÉ software .......... 105
   Locating the Palm Desktop for CLIÉ
   components .................................. 106
Advanced HotSync® operations .... 107
   Setting the HotSync® setup options ... 107
   Customizing HotSync application
   settings (Conduit) ....................... 109
   Conducting an IR HotSync operation ... 111
   Conducting a HotSync operation
   via modem ................................ 114
   Conducting a HotSync operation
   via a network ............................ 120
   Importing data from a Windows
   application .................................. 125
   Synchronizing with external data
   (File Link) .................................. 127

Chapter 4
Communicating using your
Sony CLIÉ Handheld

Beaming between your Sony CLIÉ
Handheld and another Palm OS® PDA .... 129
   What you can do with beaming ......... 129
   Beaming information ................... 130
   Receiving beamed information .......... 131
   Tips on beaming information .......... 131
Using Memory Stick® media .......... 132

Chapter 5
Customizing your Sony CLIÉ
Handheld (Preferences)

What you can do with Preferences
............................................. 154
Changing the Buttons preferences .... 156
   Assigning applications to buttons ...... 156
   Changing the full-screen pen stroke
   activities .................................. 157
# Table of contents

Assigning applications to HotSync® buttons ............................................ 158

**Changing the Jog Dial™ navigator preferences** ........................................... 159

**Setting the display format of the time, date, and numbers (Formats)** .......... 160
  - Selecting a region default ................................................ 160
  - Selecting the time, date, and numbers formats ...................... 161

**Setting the Date & Time preferences** .................................................... 162
  - Setting the date ......................................................... 162
  - Setting the time ......................................................... 163
  - Setting the time zone and daylight saving time .................... 164

**Setting the General preferences** ......................................................... 165
  - Setting the automatic shut-off time .................................. 165
  - Setting sounds ......................................................... 166
  - Turning the Alarm LED on or off (PEG-SJ20/PEG-SJ30) .......... 167
  - Turning the Beam Receive feature on or off ...................... 168

**Entering owner information** ................................................................. 169

**Creating Graffiti® ShortCuts** ............................................................... 170

**Changing the Network preferences** .................................................... 172
  - Selecting a service ...................................................... 172
  - Entering a user name .................................................... 173
  - Entering a password .................................................... 173
  - Selecting a connection .................................................. 174
  - Adding telephone settings ............................................. 174
  - Creating additional service templates ................................ 175
  - Adding detailed information to a service template ............... 177
  - Creating log in scripts ................................................. 178
  - Using the Network preferences menus ................................ 181

**Setting the High Resolution Assist function** ........................................ 182

## Chapter 6

**Additional information**

**Backing up data of your Sony CLIÉ Handheld** ...................................... 184
  - Backing up data to your computer through a HotSync® operation .... 184
  - Backing up all CLIÉ data to a Memory Stick® media (using the Memory Stick Backup application) ......................... 185
  - Backing up CLIÉ handheld data to a Memory Stick media using the Memory Stick Gate application .................... 187

**Using data of another Sony CLIÉ Handheld** ........................................ 189
  - Using the Palm™ Desktop for CLIÉ software to transfer data ......... 189
  - Using Memory Stick® media to transfer data ........................ 191
  - Performing a HotSync® operation between your old CLIÉ handheld and the new Palm Desktop for CLIÉ software .... 193

**Precautions** ......................................................................................... 194
  - Notes on use ..................................................................... 194
  - Battery considerations (PEG-SL10) .................................... 195
  - Battery considerations (PEG-SJ20/PEG-SJ30) ....................... 198

**Troubleshooting - Frequently Asked Questions** .................................... 200
  - If you still cannot perform a HotSync® operation .................. 213

**Getting Help** ...................................................................................... 214

**Specifications** ...................................................................................... 215

**Index** .................................................................................................. 217
Welcome to the Sony Personal Entertainment Organizer (referred to as the “CLIÉ handheld” in this manual).
Your CLIÉ handheld comes with three manuals:

**Read This First**
Read This First provides an overview of your CLIÉ handheld’s features, hardware and software setup, installation instructions, and other important details. Before reading the other manuals, read the Read This First manual.

**Operating Instructions (this manual)**
This manual describes all you need to know about how to use your CLIÉ handheld and the Personal Information Management applications that come with it.

The manual shows you how to:

- Turn your CLIÉ handheld on and off, reset your CLIÉ handheld, and enter data (**Chapter 1**)  
- Use Personal Information Management applications: Date Book, Address Book, To Do List, Memo Pad, and Calculator (**Chapter 2**)  
- Perform a HotSync® operation with your computer (**Chapter 3**)  
- Exchange data with another handheld by beaming or via Memory Stick® media (**Chapter 4**)  
- Personalize your CLIÉ handheld with your own preferences settings (**Chapter 5**)  
- Maintain your CLIÉ handheld and work with the Troubleshooting section and other technical information (**Chapter 6**)  

**Add-on Application Guide**
The Add-on Application Guide describes how to install and use the supplied add-on applications, including:

- PictureGear Pocket and PictureGear 4.6Lite  
- PhotoStand  
- CLIÉ Paint  
- gMovie player  
- World Alarm Clock  
- Memory Stick Autorun (MS Autorun)  
- Memory Stick Import (MS Import) and Memory Stick Export (MS Export)
About this manual

Differences between the PEG-SL10, PEG-SJ20, and PEG-SJ30

This manual describes the operation of three CLIÉ handheld models: PEG-SL10, PEG-SJ20, and PEG-SJ30.
Following is the major differences in these models:

PEG-SL10
• Two AAA (LR03) batteries
• Monochrome LCD

PEG-SJ20
• Built-in rechargeable battery
• Monochrome LCD

PEG-SJ30
• Built-in rechargeable battery
• Color LCD

Illustrations used in this manual
All illustrations of the unit and screen images are of the PEG-SJ30, unless specified otherwise. Differences between the three models are described at relevant points throughout the manual.

Note
Some models described in this manual are unavailable in some areas.
Chapter 1

Basic operations of your Sony CLIÉ Handheld

This chapter describes how to turn your CLIÉ handheld on and off, enter data, and perform other basic operations.

Contents

Turning your Sony CLIÉ Handheld on and off ........................................... 8
Using the stylus ...................................................................................... 9
Using the Jog Dial™ navigator ............................................................ 11
Entering data into your Sony CLIÉ Handheld ......................................... 12
  Using Graffiti® writing to enter data .............................................. 12
  Using the onscreen keyboard ......................................................... 21
  Using your computer keyboard .................................................... 23
Adjusting the screen ............................................................................. 24
Resetting your Sony CLIÉ Handheld .................................................... 25
  Performing a soft reset ................................................................. 25
  Performing a hard reset ................................................................. 26
Turning on your CLIÉ handheld

Press the POWER button.
Your CLIÉ handheld is turned on, and the last screen you viewed is displayed.

When you turn on your CLIÉ handheld for the first time, the Setup screen appears.

Tip
You can set the power to turn on/off with the BACK button. For details, see page 159.

Turning off your CLIÉ handheld

Press the POWER button again.
The power is turned off. You do not have to save data, quit an application or perform any of the other shutdown procedures that your computer requires.

Note
If you press the POWER button and hold it down for two seconds or longer, you can turn the backlight on the screen on or off.
Using the stylus

With your CLIÉ handheld, you can use the supplied stylus to enter characters or specify an application you want to run.

**Taking out the stylus**

The stylus is stored in the holder on the back panel of your CLIÉ handheld. Pull it out when using your CLIÉ handheld.

To avoid losing the stylus, always put it back in its holder on your CLIÉ handheld after use.

**Tapping**

When you enter characters on the onscreen keyboard of your CLIÉ handheld, open an application, or select an item, press lightly on the desired button or icon with the stylus.

This action is called “tapping.”
Using the stylus

Dragging

Just as you can drag the mouse to select (and drag) text or move objects on your computer, you can also use the stylus to drag an item on the screen of your CLIÉ handheld. Press the stylus lightly on the item and move it along the screen surface.

Examples of dragging:
To display data above or below the current viewing area on the screen, use the stylus to drag the slider of any scroll bar.
To select multiple characters or items together, use the stylus to drag along the desired characters or items.

Full-screen dragging
By default, full-screen dragging from the bottom of the writing area to the top of the screen displays the Graffiti® Help on the screen. You can assign the full-screen dragging to another activity. See page 157 for details.
Using the Jog Dial™ navigator

Your CLIÉ handheld is equipped with a Jog Dial™ navigator, which allows you to perform all major operations without the stylus. You can operate your CLIÉ handheld using the Jog Dial navigator with just one hand.

The icon of any application that supports Jog Dial navigator operations is marked with the Jog Dial navigator mark.

For applications not supporting the Jog Dial navigator operations, you can use the JogAssist function to enable Jog Dial navigator operations. For details, see “Changing the Jog Dial™ navigator preferences” on page 159.

* The World Alarm Clock icon and PhotoStand icon and CLIÉ Paint icon do not have the Jog Dial navigator mark, but supports the Jog Dial navigator operations.

Rotating the Jog Dial navigator

Rotate the Jog Dial navigator to select various items in succession or to select an application to start.

The operations you can perform by rotating the Jog Dial navigator differ depending on the application you are using. For details, refer to the instructions for each application.

Pressing the Jog Dial navigator

Press the Jog Dial navigator to highlight the item selected by rotating the Jog Dial navigator, or to run the selected application.

The operations you can perform by pressing the Jog Dial navigator differ depending on the application you are using. For details, refer to the instructions for each application.

Rotating while holding down the Jog Dial navigator

Some applications support operations executed by rotating and pressing the Jog Dial navigator. For details, refer to the instructions for each application.
Entering data into your Sony CLIÉ Handheld

Using Graffiti® writing to enter data

This section describes the procedures for creating letters, numbers, punctuation, and symbols, and teaches you some Graffiti® tips and tricks.

What is Graffiti writing?
Most people find they can enter text quickly and accurately with only minutes of practice. Graffiti writing includes any character you can type on a standard keyboard. The Graffiti strokes closely resemble the upper case letters of the regular alphabet, which makes Graffiti writing easy to learn.

There are four basic concepts for success with Graffiti writing:
• If you draw the character shape exactly as shown in the Writing Graffiti alphabet table in this chapter, and as shown below, you can achieve 100% accuracy.

A B C D E

Graffiti writing examples:
A, B, C, D, and E

• The heavy dot on each shape shows where to begin the stroke. Certain characters have similar shapes, but different beginning and end points. Always begin the stroke at the heavy dot (you should not create the heavy dot; it is only there to show you where to begin the stroke).

• Most characters require only a single stroke. When you lift the stylus from the Graffiti writing area, your CLIÉ handheld recognizes and displays the text character immediately.

To allow you to write an entire character with a single stroke, some Graffiti strokes are portions of the regular alphabet equivalents.

• The Graffiti writing area is divided into two parts: one for writing the letters of the alphabet and one for writing numbers. The small marks at the top and bottom of the Graffiti writing area separate the two areas.
Entering data into your Sony CLIÉ Handheld

Writing Graffiti letters

1 Tap where you want your text to go.

**Note**
You need to tap above the Graffiti writing area, and you must see a flashing cursor before you write the text.

2 Use the tables on the following pages to find the stroke shape for the letter you want to create. For example, the stroke shown below creates the letter “n.”

**Note**
There are two different stroke shapes available for some letters. For these letters, choose the one that’s easiest for you.

As you will see later, you use the same shape to create both the upper case and lower case version of a letter.

3 Position the stylus in the left-hand side of the Graffiti writing area.

4 Start your stroke at the heavy dot and draw the stroke shape as it appears in the tables.

5 Lift the stylus from the screen at the end of the stroke shape. That is all there is to it. When you lift the stylus from the screen, your CLIÉ handheld recognizes your stroke immediately and prints the letter at the insertion point on the screen.

As soon as you lift the stylus from the screen, you can begin the stroke for the next character you want to write.

Continued on next page
Entering data into your Sony CLIÉ Handheld

**Note**

You must begin the character strokes in the Graffiti writing area. If you do not make Graffiti strokes in the Graffiti writing area, your CLIÉ handheld does not recognize them as text characters.

**Tips**

- Accuracy improves when you write large characters. You should draw strokes that nearly fill the Graffiti writing area.
- To delete characters, simply set the insertion point to the right of the character you want to delete and make the backspace stroke (a line from right to left) in the Graffiti writing area.
- Write at natural speed. Writing too slowly can generate recognition errors.
- Do not write on a slant. Vertical strokes should be parallel to the sides of the Graffiti writing area.
- Press firmly.

**To display the Graffiti onscreen help**

Drag the stylus from the bottom of the writing area to the top of the screen. Graffiti Help opens a series of screens that show the complete Graffiti character set.
Entering data into your Sony CLIÉ Handheld

Writing Graffiti alphabet
Write Graffiti letters corresponding to the letters of the alphabet, as shown below, in the left-hand side of the Graffiti writing area.

<table>
<thead>
<tr>
<th>A</th>
<th>N</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>O</td>
</tr>
<tr>
<td>C</td>
<td>P</td>
</tr>
<tr>
<td>D</td>
<td>Q</td>
</tr>
<tr>
<td>E</td>
<td>R</td>
</tr>
<tr>
<td>F</td>
<td>S</td>
</tr>
<tr>
<td>G</td>
<td>T</td>
</tr>
<tr>
<td>H</td>
<td>U</td>
</tr>
<tr>
<td>I</td>
<td>V</td>
</tr>
<tr>
<td>J</td>
<td>W</td>
</tr>
<tr>
<td>K</td>
<td>X</td>
</tr>
<tr>
<td>L</td>
<td>Y</td>
</tr>
<tr>
<td>M</td>
<td>Z</td>
</tr>
<tr>
<td>Space</td>
<td>Back Space</td>
</tr>
<tr>
<td>Carriage Return</td>
<td>Period Tap twice</td>
</tr>
</tbody>
</table>

Continued on next page
Entering data into your Sony CLIÉ Handheld

To write capital letters
Shift to caps and then you can make capital letters with the same stroke shapes as the basic alphabet characters.

• To draw the first letter of a word as a capital letter
Use the Caps Shift stroke ↓.

To return to the lower case, use the Backspace stroke ——.

**Note**
When you create a new sentence or a new record (by tapping New or a blank line), the first letter is automatically capitalized.

• To enter only capital letters (Caps Lock)
Use the Caps Lock stroke ↓↓.

To return to the lower case, use the Caps Shift stroke ↓.

Writing numbers
Write the following Graffiti numbers on the right-hand side (numbers side) of the Graffiti writing area.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>ᵃ</td>
<td>ᵃ</td>
</tr>
<tr>
<td>1</td>
<td>→</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>²</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>³</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>⁵</td>
<td>⁵</td>
</tr>
<tr>
<td>6</td>
<td>⁶</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>⁷</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>⁸</td>
<td>⁸</td>
</tr>
<tr>
<td>9</td>
<td></td>
<td>⁹</td>
</tr>
</tbody>
</table>
### Writing punctuation marks

Make a single tap on the Graffiti writing area to activate Punctuation Shift. The next stroke you make anywhere in the Graffiti area (the letters or numbers side) creates a punctuation mark.

<table>
<thead>
<tr>
<th>Punctuation Mark</th>
<th>Symbol</th>
</tr>
</thead>
<tbody>
<tr>
<td>(. ) Period</td>
<td>.</td>
</tr>
<tr>
<td>(, ) Comma</td>
<td>,</td>
</tr>
<tr>
<td>(‘) Apostrophe</td>
<td>′</td>
</tr>
<tr>
<td>(?) Question</td>
<td>?</td>
</tr>
<tr>
<td>(!) Exclamation</td>
<td>!</td>
</tr>
<tr>
<td>(@) At</td>
<td>@</td>
</tr>
<tr>
<td>(#) Number</td>
<td>#</td>
</tr>
<tr>
<td>(%) Percent</td>
<td>%</td>
</tr>
<tr>
<td>(^) Circumflex</td>
<td>^</td>
</tr>
<tr>
<td>(&amp;) Ampersand</td>
<td>&amp;</td>
</tr>
<tr>
<td>(*) Asterisk</td>
<td>*</td>
</tr>
<tr>
<td>(&lt;) Left angle bracket</td>
<td>&lt;</td>
</tr>
<tr>
<td>(&gt;) Right angle bracket</td>
<td>&gt;</td>
</tr>
<tr>
<td>(_) Under bar</td>
<td>_</td>
</tr>
<tr>
<td>(&quot;’) Ditto</td>
<td>’</td>
</tr>
</tbody>
</table>

- Make a single tap on the Graffiti writing area to activate Punctuation Shift.
- The next stroke you make anywhere in the Graffiti area (the letters or numbers side) creates a punctuation mark.
### Writing symbols and extended characters

Make a Symbol Shift stroke \ on the Graffiti writing area to activate Symbol Shift. The next stroke you make creates a symbol or extended character.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Stroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>(•) Bullet</td>
<td>•</td>
</tr>
<tr>
<td>(™) Trademark</td>
<td>™</td>
</tr>
<tr>
<td>(®) Registered</td>
<td>®</td>
</tr>
<tr>
<td>(©) Copyrighted</td>
<td>©</td>
</tr>
<tr>
<td>(‘) Left single quotation</td>
<td>‘</td>
</tr>
<tr>
<td>(‘) Right single quotation</td>
<td>‘</td>
</tr>
<tr>
<td>(“) Left double quotation</td>
<td>“</td>
</tr>
<tr>
<td>(”) Right double quotation</td>
<td>”</td>
</tr>
<tr>
<td>(§) Section</td>
<td>§</td>
</tr>
<tr>
<td>(°) Degree</td>
<td>°</td>
</tr>
<tr>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>x</td>
<td>x</td>
</tr>
<tr>
<td>+</td>
<td>+</td>
</tr>
<tr>
<td>=</td>
<td>=</td>
</tr>
<tr>
<td>¥</td>
<td>¥</td>
</tr>
<tr>
<td>£</td>
<td>£</td>
</tr>
<tr>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>א</td>
<td>א</td>
</tr>
<tr>
<td>i</td>
<td>i</td>
</tr>
<tr>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>μ</td>
<td>μ</td>
</tr>
<tr>
<td>f</td>
<td>f</td>
</tr>
<tr>
<td>O</td>
<td>O</td>
</tr>
</tbody>
</table>
**Writing accented characters and non-English characters**

To create accented characters, draw the stroke normally used to create the letter, followed by an accent stroke. Graffiti writing then adds the accent to the letter.

To enter “é,” for example, draw ȇ and then serialization.

<table>
<thead>
<tr>
<th>âèíóú</th>
<th>âéíóúú</th>
<th>àëiòù</th>
<th>àéíóúú</th>
</tr>
</thead>
<tbody>
<tr>
<td>âéíóú</td>
<td>ãëiòóú</td>
<td>ãëiòóú</td>
<td>ãëiòóú</td>
</tr>
<tr>
<td>åëiòóú</td>
<td>ãëiòóú</td>
<td>ãëiòóú</td>
<td>ãëiòóú</td>
</tr>
</tbody>
</table>

**To write non-English characters**

You can write the following characters without any special punctuation or shifting:

<table>
<thead>
<tr>
<th>ç</th>
<th>æ</th>
</tr>
</thead>
<tbody>
<tr>
<td>ç</td>
<td>æ</td>
</tr>
</tbody>
</table>

**Note**

You must write these non-English characters on the left side of the Graffiti writing area.
Entering data into your Sony CLIÉ handheld

Using Navigation strokes
In addition to character symbols, Graffiti writing includes special strokes that you can use to navigate within text or fields in your applications.

| Move cursor right | ←          |
| Move cursor left  | ←          |
| Go to the previous field (Address Book only) | ↑          |
| Go to the next field (Address Book only) | ↓          |
| Open Address Record (Address Book only) | /          |

Using Graffiti ShortCuts
Graffiti ShortCuts, similar to the glossary or autotext features of some word processors, allow you to enter commonly used words or phrases quickly and easily. In addition to the following predefined ShortCuts, you can create your own ShortCuts for your name or the header of a memo (page 170). Each ShortCut can represent up to 45 characters.
To use a ShortCut, draw the ShortCut stroke followed by the ShortCut characters. When you draw the ShortCut stroke, the ShortCut symbol appears at the insertion point to show that you are in ShortCut mode.
When you enter and dts (D, , and S), you can enter date and time stamps.

| Date stamp  | ds          |
| Time stamp  | ts          |
| Date/time stamps | dts       |
| Meeting       | me          |

| Breakfast    | br          |
| Lunch        | lu          |
| Dinner       | di          |
Entering data into your Sony CLIE Handheld

Using the onscreen keyboard

You can open the onscreen keyboard any time you need to enter text or numbers into your CLIE handheld. Note that you cannot enter Graffiti characters while using the onscreen keyboard.

To use the onscreen keyboard:

1. Open any application (such as Memo Pad).
2. Tap any record, or tap New.

3. Tap “a” to open the alphabetic keyboard, or tap “1” to open the numeric keyboard.

The selected keyboard is displayed.
Entering data into your Sony CLIÉ Handheld

4 Select the desired keyboard and tap the characters to enter text and numbers.

You can use the onscreen keyboard in the same way as in the keyboard of your computer. To enter capital letter, tap cap and then tap the character button. To delete a character, tap \[\text{Backspace}\].

5 After you finish, tap \text{Done} to close the onscreen keyboard and place the text in the record.
Entering data into your Sony CLIÉ Handheld

Using your computer keyboard

If you have a lot of data to enter, or prefer to use the computer keyboard, you can use the Palm™ Desktop for CLIÉ software or any other supported personal information manager (PIM), such as Microsoft Outlook®, to enter information. You can then perform a HotSync® operation to synchronize the information on your computer with the information on your CLIÉ handheld. All the main applications on your CLIÉ handheld are also available in the Palm Desktop for CLIÉ software and in most PIMs, so you don’t need to learn different applications.

Refer to the Palm Desktop for CLIÉ software online Help for more information on entering data on your computer.

To import data from your computer or another handheld

If you have data stored in computer applications such as spreadsheets, databases, or if you want to import data from another handheld, you can transfer the data to your CLIÉ handheld and use it without entering data manually. Save the data in a compatible file format (.csv, .txt, .tab, .tsv, .dba, .aba, .tda, .mpa), import it into your Palm Desktop for CLIÉ software, and then perform a HotSync operation to transfer the data to your CLIÉ handheld. For details, see “Chapter 3: Exchanging and updating data using a HotSync® operation.”
Adjusting the screen

You can turn the backlight on or off, and adjust the contrast (PEG-SL10/PEG-SJ20) or brightness (PEG-SJ30) according to the lighting conditions or temperature of the environment where you use your CLIÉ handheld.

Turning the backlight off and on

Press and hold down the POWER button for more than two seconds to turn the backlight off or on.

Adjusting the contrast or brightness

Using the onscreen contrast (PEG-SL10/PEG-SJ20) or brightness (PEG-SJ30) control, adjust the screen contrast or brightness as follows:


   ![PEG-SL10/PEG-SJ 20](image1)
   ![PEG-SJ 30](image2)

   Tap this icon.

   The adjustment control screen is displayed.

2. To change the level in small increments, tap to the left or right.
   To change the brightness/contrast level in larger increments, drag the slider to the left or right.

   **Tip**

   You can also press the scroll button or rotate the Jog Dial navigator to move the slider incrementally.

3. Tap Done.

   **Note**

   If the digitizer is not configured correctly, you may not be able to make the adjustments properly. For details, see “Turning on your Sony CLIÉ Handheld for the first time” in the Read This First manual.
Resetting your Sony CLIÉ Handheld

Under normal circumstances, you do not have to reset your CLIÉ handheld. On rare occasions, however, your CLIÉ handheld may no longer respond to buttons or the screen due to insufficient memory or other reasons. In this case, you need to perform a reset to get your CLIÉ handheld running again.

Performing a soft reset

A soft reset tells your CLIÉ handheld to stop what it’s doing and start over again. All records and entries stored in your CLIÉ handheld are retained in a soft reset.

1. Take out the reset tip by unscrewing the metal barrel from the stylus quill.

2. Use the reset tip to gently press the reset button inside the hole on the back panel of your CLIÉ handheld.

The system shuts down and then restarts. After restarting, the system displays “palm powered,” “CLIÉ,” and “SONY,” followed by the preferences screen for setting the time and date.
Resetting your Sony CLIÉ Handheld

Performing a hard reset

If the soft reset does not solve the problem, you need to perform a hard reset to restart your CLIÉ handheld.

**Note**

With a hard reset, all records and entries stored in your CLIÉ handheld are erased. Perform a hard reset only if a soft reset does not solve your problem.

You can restore your CLIÉ handheld data if you save a back-up on your computer or Memory Stick media. For details on how to save a back-up, see “Back up of data of your Sony CLIÉ handheld” on page 184.

1. Hold down the POWER button on your CLIÉ handheld.
2. While holding down the POWER button, use the reset tip to gently press and release the reset button.

   ![Reset button](image)

   The Palm Powered logo screen is displayed.

3. After 3 seconds, release the POWER button.

   A message warning that you are about to erase all the data stored on your CLIÉ handheld is displayed.

4. Press the scroll button on the front panel of your CLIÉ handheld upwards.

   Your CLIÉ handheld undergoes a hard reset.

   After a hard reset, only the current date and time are retained. Formats, Preferences, and other settings are restored to their factory default settings.

   **Note**

   If the scroll button was used just prior to hard-resetting, the hard-reset may not be performed.
Chapter 2

Using basic applications

This chapter describes how to perform tasks that are specific to the basic applications of your CLIÉ handheld: Date Book, Address Book, To Do List, Memo Pad, and Calculator.

Contents

- Managing schedules and events (Date Book) .................. 28
  Scheduling an event ..................................................... 28
  Checking schedules ...................................................... 35
  Editing Date Book events ............................................ 41
  Using the Date Book menus ......................................... 46

- Managing addresses and phone numbers (Address Book) ........................................ 48
  Creating a new Address Book entry ................. 48
  Viewing Address Book entries ................................. 50
  Editing Address Book entries .................................. 54
  Using the Address Book menus ................................. 60

- Managing tasks and things to do (To Do List) .............. 62
  Creating To Do List items .............................. 62
  Viewing To Do List items .................................. 63
  Checking off a To Do List item ......................... 64
  Working with To Do List .................................. 65
  Using the To Do List menus ................................. 69

- Creating memos (Memo Pad) .................................. 70
  Creating a new memo ............................................. 70
  Reviewing memos ................................................. 72
  Editing memos ...................................................... 75
  Using the Memo Pad menus .................................. 77

- Using Calculator (Calc) ............................................. 78
  Calculating with Calculator .................................. 78
  Using the Calculator buttons ................................ 79
  Using the Calculator menus ................................ 79

- Performing common tasks ........................................ 80
  Using the Application Launcher .......................... 80
  Categorizing records ............................................ 84
  Finding records ..................................................... 87
  Protecting your data (Security) ................................. 91
  Attaching notes ...................................................... 97
  Purging records ..................................................... 98
  Using the Edit menu .................................... 99
  Choosing fonts ..................................................... 100
Managing schedules and events (Date Book)

Date Book lets you quickly and easily schedule appointments or any activity associated with a date, or a date and time. A record in Date Book is called an “event.”

Scheduling an event

Scheduling an event for the current date

1. Press the Date Book button on the front panel.
   Date Book starts up. Today’s schedule is displayed with a list of times for a standard business day.

   Tip
   Press the Date Book button repeatedly to cycle through the Day, Week, Month, and Agenda views. The Date Book views are displayed at the bottom left of the screen.

2. Tap the time line that corresponds to the beginning of the event.
Managing schedules and events (Date Book)

3. Enter a description of the event.
   You can enter a description or a note of up to 255 characters in length.

4. If the event is one hour long, skip to step 7. If the event is longer or shorter than one hour, tap the time of the event to open the Set Time dialog box.

5. Perform one of the following to set the duration of the event:
   • Tap the time columns on the right side of the Set Time dialog box to set the Start Time, and tap the End Time box. Then tap the time columns to set the End Time.
   • Tap All Day to automatically insert the start and end time of the event as defined in your Date Book preferences.

6. Tap OK.

7. Tap a blank area of the screen to deselect the event.
   A vertical line appears next to the time, indicating the duration of the event.

Continued on next page
Managing schedules and events (Date Book)

Tip
You can open the Set Time dialog box (to select a start time) by writing a number on the number side of the Graffiti writing area and making sure no event is selected.

To schedule an untimed event
In step 5, tap No Time. A new untimed event is displayed in the first line in Date Book with a ♦ mark.

Scheduling a timed event for another date

1. Press the Date Book button on the front panel.
   Date Book starts up.

2. Do one of the following to select the date you want for the event:
   • Tap the day of the week on top of the Date Book screen.
     To move to another week, tap one of the scroll arrows of either side of the day of the week area.
   • Tap Go To at the bottom of the screen.
     The Go To Date dialog box appears. Select a date by tapping a year, month, and day in the calendar.

3. Follow the steps for “Scheduling an event for the current date.”

Continued on next page
Managing schedules and events (Date Book)

Tip
You can also use the scroll button on the front panel to move forward or backward one day or one month at a time.

To schedule an untimed event
In step 3, tap New and then tap No Time. Then follow the steps for “Scheduling an event for the current date.”

Tip
You can create a new untimed event by making sure no event is selected and then writing letters in the Graffiti writing area. When you start writing, the untimed event appears at the top of the screen.

Scheduling repeating or continuous events
The Repeat function lets you schedule events that recur at regular intervals or extend over a period of consecutive days.

Examples of repeating or continuous events
• Birthday: an event that repeats annually
• Weekly guitar lesson: an event that falls on the same day of the week and the same time of day
• Business trip or vacation: a continuous event

1 Press the Date Book button on the front panel.
   Date Book starts up.
2 Tap the description of the event.
3 Tap Details.
The Event Details dialog box appears.

Continued on next page
Managing schedules and events (Date Book)

4 Tap the Repeat box. The Change Repeat dialog box appears.

![Change Repeat dialog box]

5 Tap Day, Week, Month, or Year to set how often the event repeats.
   For a continuous event, tap Day.

![Change Repeat dialog box]

6 Enter a number that corresponds to how often you want the event to repeat on the Every line.
   • **When you tap Week:** Tap a letter representing each day of the week on Repeat on line to specify the day you want the event to repeat.

![Change Repeat dialog box]

Continued on next page
Managing schedules and events (Date Book)

• **When you tap Month:** On the Repeat by line, tap Day to repeat the event on the specified day of the same week each month, or tap Date to repeat the event on the specified date each month.

7 To specify an end date for the repeating or continuous event, tap the arrow ▼ next to End on to display the drop-down list and tap Choose Date.

The Ending On screen appears.

8 Tap the end date on the screen.

The Change Repeat screen appears again.

9 Tap OK.

The Event Details screen appears again.

---

Continued on next page
Managing schedules and events (Date Book)

10 Tap OK.

The Date Book screen is displayed again.

Make sure that the repeat icon is displayed to the far right of the event.

Notes

• If you change the start date of a repeating event, your CLIÉ handheld calculates the number of days you moved the event. Your CLIÉ handheld then automatically changes the end date to maintain the duration of the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a repeating event, past occurrences (prior to the day on which you change the setting) are not changed, and your CLIÉ handheld creates a new repeating event.

• If you change the date of an occurrence of a repeating event (e.g., from January 14 to January 15) and apply the change to all occurrences, the new date becomes the start date of the repeating event. Your CLIÉ handheld adjusts the end date to maintain the duration of the event.

• If you change other repeat settings (e.g., time, alarm, private) of a repeating event and apply the change to all occurrences, your CLIÉ handheld creates a new event. The start date of this new event is the day on which the setting is changed. Past occurrences (prior to the day of the change) are not changed.

• If you apply a change to a single occurrence of a repeating event (e.g., time), that occurrence no longer shows the repeat icon.
Managing schedules and events (Date Book)

Checking schedules

Displaying the Day view

You can display and check the events for a specific day.

1. Press the Date Book ≧ button on the front panel.
   Date Book starts. Today’s schedule is displayed.

2. Rotate the Jog Dial™ navigator to display the events for yesterday or tomorrow.
   You can display the schedule for a specific day and time.

To change the Date Book view

In addition to displaying the time list for a specific day, you can also display a whole week, a month, or an agenda.

To display the next view, press the Jog Dial navigator repeatedly.

Tip

You can also select the Date Book view by tapping an icon on the Date Book screen.
Tap one of the following icons to rotate to the corresponding calendar view:

- ☐: Day view
- ☐: Week view
- ☐: Month view
- ☐: Agenda view
Managing schedules and events (Date Book)

Displaying the Week view

Week view displays a calendar of your events for an entire week. This view lets you quickly review your appointments and available time slots. In addition, the graphical display helps you spot overlaps and conflicts in your schedule.

1. Press the Date Book button on the front panel.
   Date Book starts up.

2. Press the Jog Dial navigator repeatedly or tap the Week view icon.
   The Week view appears. Untimed events are also displayed in the Week view.

3. Rotate the Jog Dial navigator to select the day that you want to review.
   To select the next day, rotate the Jog Dial navigator.

4. Press the Jog Dial navigator.
   The details of the selected day are displayed.

Tips

• To reschedule an event while in the Week view, tap and drag the event to a different time or day.
• Tap a blank time on any day to move to that day and have the time selected for a new event.
• Tap any day or date that appears at the top of the Week view to move directly to that day without selecting an event.
• The Week view displays the time span defined by the Start Time and End Time in the Date Book Preferences settings. If you have an event before or after this time span, a bar appears at the top or bottom of that day’s column. Use the onscreen scroll arrows to scroll to the event.
Managing schedules and events (Date Book)

To view the detail of an event

Tap each time bar to view the detail of that event.

To spot event conflicts

An event conflict (time overlap) appears in the Week view as overlapping time bars and in the Day view as overlapping brackets to the left of the conflicting times.
Managing schedules and events (Date Book)

Displaying the Month view

The Month view screen shows which days have events scheduled. Dots and lines in the Month view indicate events, repeating events, and untimed events.

1. Press the Date Book button on the front panel.
   Date Book starts up.

2. Press the Jog Dial navigator repeatedly or tap the Month view icon.
   The Month view screen appears.

3. Rotate the Jog Dial navigator to select the day that you want to review.
   To select the next day, rotate the Jog Dial navigator.

4. Press the Jog Dial navigator.
   The details of the selected day are displayed.

Tips

- Tap a day in the Month view to display that day in the Day view.
- Tap the scroll arrows in the upper right corner to move forward or backward a month.
- Tap Go To to open the Go To Date dialog box to select a different month.
- Use the scroll buttons on the front panel of your CLIÉ handheld to move between months. Press the scroll button upwards to display the previous month, or downwards to display the next month.
Managing schedules and events (Date Book)

Displaying the Agenda view
The Agenda view shows you your appointments, untimed events, and To Do List items in a single screen. As well as checking the detailed information of an event, you can also use the Agenda view to check off completed To Do List items.

1. Press the Date Book button on the front panel.
   Date Book starts up.

2. Press the Jog Dial navigator repeatedly or tap the Agenda view icon.
   The Agenda view screen appears. Today’s schedule and To Do List is displayed.

3. Rotate the Jog Dial navigator to select the day that you want to review.
   To select the next day, rotate the Jog Dial navigator.

   Tips
   • Tap any appointment while in Agenda view to display the Day view of the appointment.
   • Check off completed To Do List items in the Agenda view, or tap a description of an item to go directly into the To Do List application.
Managing schedules and events (Date Book)

Changing Date and Time view

Tap and hold the date in the title bar of Date Book. The current time appears.

When you release the stylus, the menu bar appears. If you want to avoid displaying the menu when releasing the stylus, drag the stylus away from the date indication after the current time appears.
Managing schedules and events (Date Book)

Editing Date Book events

Changing a date or time for an event

1. On the Date Book screen, tap the event you want to edit.
2. Tap Details.
   The Event Details dialog box appears.

3. • To change the time, tap the Time box and select a new time.
   The Set Time dialog box appears. Tap the Start Time and the End Time.

   • To change the date, tap the Date box and select a new date.
   The Set Date dialog box appears. Specify the year, month, and day in the calendar.

4. Tap OK.
Managing schedules and events (Date Book)

Changing a timed event to an untimed event

1. On the Date Book screen, tap the event you want to edit.
2. Tap Details.
3. Tap the Time box.
   The Set Time screen appears.
4. Tap No Time.
   The Event Details screen appears.

5. Tap OK.
   The untimed event is displayed in the first line with the untimed ◆ mark.
Managing schedules and events (Date Book)

Setting an alarm for an event

The Alarm setting enables you to set an audible alarm for events in your Date Book. The default Alarm setting is 5 minutes before the time of the event, but you can change this to any number of minutes, hours, or days. When you set an alarm, an alarm icon appears to the far right of the event with the alarm.

Tip

You can also set your CLIÉ handheld to flash its LED for an event instead of, or in addition to, an audible alarm. For details, see “Turning the LED alarm on or off (PEG-SJ20/PEG-SJ30)” on page 167.

1 On the Date Book screen, tap the event to which you want to assign an alarm.

2 Tap Details. The Event Details dialog box appears.

3 Tap the Alarm check box to select it. The alarm is set.

Tip

You can also set your CLIÉ handheld to flash its LED for an event instead of, or in addition to, an audible alarm. For details, see “Turning the LED alarm on or off (PEG-SJ20/PEG-SJ30)” on page 167.

4 Tap the arrow ▼ to select the time unit from among Minutes, Hours, or Days.

5 Tap the “5” next to the Alarm check box and enter any number from 0 to 99 as the number of time units.

6 Tap OK.

Continued on next page
Managing schedules and events (Date Book)

Setting an alarm for an untimed event

You can set a silent alarm for an untimed event. In this case, the alarm triggers at the specified period of minutes, hours, or days before midnight (beginning) of the day of the untimed event. No audible alarm sounds for an untimed event. The reminder message appears onscreen instead.

Example: When you set an alarm for an untimed event that occurs on February 4 and if the alarm is set for 5 minutes, the reminder message appears at 11:55 PM on the night of February 3. The reminder remains onscreen until you turn on your handheld and tap OK to erase it.

Making an event private

You can hide records that you mark as private. If you define a password for your CLIÉ handheld, you must enter it to display private records.

1. On the Date Book screen, tap the event you want to mark as private.
2. Tap Details.
   The Event Details dialog box appears.
3. Tap the Private check box.
4. Tap OK.
   The event is marked as private. For hiding or masking private events, see “Protecting your data (Security)” on page 91.
Managing schedules and events (Date Book)

Deleting events

You can delete existing events in Date Book.

**Note**

If you delete the contents of a reoccurring event, all the related events will be deleted. When deleting an event in Delete Event dialog box, you can delete a single event as an exception or all the related events.

1. On the Date Book screen, tap the event you want to delete.
2. Tap Details.
3. Tap Delete.
   The Delete Event dialog box appears.
4. Tap OK to delete the event.
   The selected event is deleted. To cancel deletion, tap Cancel.

**Tip**

If you select the “Save archive copy on PC” check box, the deleted event will be saved onto the Palm™ Desktop for CLIÉ software on your computer during the next HotSync® operation.
## Managing schedules and events (Date Book)

### Using the Date Book menus

This section describes the menu commands specific to Date Book. For the Edit menu, see “Using the Edit menu” on page 99.

#### Record menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Event</strong></td>
<td>Creates a new event. The Set Time dialog box for selecting the start and end times is displayed.</td>
</tr>
<tr>
<td><strong>Delete Event</strong></td>
<td>Deletes the currently selected event. The Delete Event dialog box appears.</td>
</tr>
<tr>
<td><strong>Attach Note</strong></td>
<td>Attaches notes to the current event. A dialog box for entering comments appears.</td>
</tr>
<tr>
<td><strong>Delete Note</strong></td>
<td>Deletes notes from the current event. The Delete Note dialog box is displayed.</td>
</tr>
<tr>
<td><strong>Purge</strong></td>
<td>You can specify a certain period based on the current date and discard any events that were formed before the specified date. Use this function to save memory space.</td>
</tr>
</tbody>
</table>

**Notes**
- A reoccurring event will not be deleted.
- By default, the events that you purge will be saved in the Palm Desktop for CLIÉ software on your computer at the next HotSync® operation. To delete the events completely, deselect the check box (☐) for “Save archive copy on PC” in the Purge dialog box.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Beam Event</strong></td>
<td>Sends the current event to another CLIÉ handheld via the infrared communications port.</td>
</tr>
</tbody>
</table>

#### Options menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font</strong></td>
<td>You can select a desired font in the Select Font dialog box.</td>
</tr>
</tbody>
</table>
Managing schedules and events (Date Book)

Preferences

- **Start/End Time:** Defines the start and end times for Date Book screens. If the time slots you select do not fit on one screen, you can tap the scroll arrows ⬇️ to scroll up and down.
- **Alarm Preset:** Automatically sets an alarm for each new event. The silent alarm for untimed events is defined by minutes, days, or hours before midnight of the date of the event.
- **Alarm Sound:** Selects the sound that is played as the alarm.
- **Remind Me:** Defines how many times the alarm sounds. The choices are Once, Twice, 3 Times, 5 Times, and 10 Times.
- **Play Every:** Defines how often the alarm sounds. The choices are a Minute, 5 minutes, 10 minutes, and 30 minutes.

Display Options

Changes the Date Book’s appearance and which events display.

- **Show Time Bars:** Activates the time bars that appear in the Day view. The time bars show the duration of an event and illustrate event conflicts.
- **Compress Day View:** Controls how times appear in the Day view. When Compress Day view is off, all time slots are displayed. When it is on, start and end times display for each event, but blank time slots toward the bottom of the screen disappear to minimize scrolling.
- **Month View settings:** These check boxes apply to the Month view of Date Book. You can activate any or all of these settings to show that you have Timed, Untimed, or Daily Repeating events in the Month view only.

Phone Lookup

The Phone Number Lookup screen appears. If there is an Address Book entry, you can look up the phone number of the selected item.

Security

Hides the current item unless the password is entered. You can select the view option among Show Records, Mask Records, or Hide Records.

About Date Book

Shows version information for Date Book.
Managing addresses and phone numbers (Address Book)

Address Book lets you keep names, addresses, telephone numbers, and other information about your personal or business contacts.

An item in Address Book is called an “entry.”

Creating a new Address Book entry

1. Press the Address Book button on the front panel.
   The Address screen is displayed.

   **Note**
   Press the Address Book button repeatedly to cycle through the categories in which you have entries.

2. Tap New.
   The Address Edit screen appears.

3. Enter the last name of the person you want to add to Address Book.
   The first letter of each field (except numeric and e-mail fields) is automatically capitalized.

4. Tap First name.
   The cursor shifts to the first name field.
   You can also use Graffiti® writing to move the cursor to the next field by entering ↑.
5 Enter the first name in the First name field.

6 Repeat steps 4 and 5 to enter the other items of information that you want to include.
You can tap the scroll arrow ▼ next to each item to display the list of choices and then tap the desired item in the list.

7 To move to the next page of information, tap the scroll arrow ▼ on the bottom-right corner of the screen.

8 After you finish entering all the necessary information, tap Done.
The Address screen is displayed again.

Tip
You can also use the Palm™ Desktop for CLIE software to create entries on your computer and then download them to your CLIE handheld with your next HotSync® operation. See “Performing a local HotSync® operation with the USB cable” on page 103 for details.
Managing addresses and phone numbers (Address Book)

Viewing Address Book entries

1. Press the Address Book button on the front panel. The Address screen is displayed, listing your current entries.

2. Rotate the Jog Dial™ navigator to select the address entry you want to view. If the desired address entry is not displayed, rotate the Jog Dial navigator further to scroll up or down the entire list.

3. Press the Jog Dial navigator. The Address View screen of the selected entry is displayed.

4. To return to the list of address entries, press the Jog Dial navigator again or press the BACK button. The Address screen is displayed again.

Tips

- If there are multiple pages of information, the scroll button moves up or down an address list or the Address View screen. If you hold down the scroll button, you accelerate the scrolling and display every third screen.
- You can also use the stylus to tap the onscreen scroll arrows to scroll to the entry.

To view an image pasted to an address entry
Tap an image on the Address View screen. The image is displayed across the whole screen. To return the Address View screen, tap the image again.

To view the next page of the Address View screen
Rotate the Jog Dial navigator. The next or previous page within the data is displayed.
Managing addresses and phone numbers (Address Book)

Viewing addresses by category

Press the Jog Dial navigator when the address list is displayed but none of the listed entries are selected. Each time you press the Jog Dial navigator, the display toggles through all the available categories.

To select category from the categories list

Tap the arrow ▼ at the upper right corner of the screen to display the category list. You can select the desired category from the list.
Managing addresses and phone numbers (Address Book)

Sorting the address entries in the list

You can sort the address entries in your desired order: listing by last and then first name, or listing by company and then last name. The address entries will be displayed in the selected order when you start Address Book. Any changes in the address order, however, do not affect the original address entries.

1. Press the Address Book button on the front panel. The Address screen is displayed, listing your current entries.
2. Tap the Menu icon. Address Book menu is displayed.
3. Tap Options, and tap Preferences. The Address Book Preferences dialog box appears.

   ![Address Book Preferences]

   - **List By:** Last Name, First Name
   - **List By:** Company, Last Name

4. Tap the desired order of the address entries in the List By field. Select the desired order in which the address entries are to be listed when Address Book starts.
5. Tap OK. The address entries are sorted in the selected order.

   **Notes**

   - When you tap Last Name, First Name, the address entries are sorted in alphabetical order of an individual’s last name and then first name.
   - When you tap Company, Last Name, the address entries are sorted in alphabetical order of the company name, and then an individual’s last name.
Managing addresses and phone numbers (Address Book)

Looking up an address entry

The Look Up feature helps you to quickly scroll to any of your address entries.

1. On the Address Book list screen, enter the first letter of the entry you want to find.
   The list scrolls to the first entry that begins with that letter. If you write another letter, the list scrolls to the first entry that starts with those two letters.
   For example, writing an “s” scrolls to “Sands,” and writing “sm” scrolls further to “Smith.” If you sort the list by company name, the Look Up feature scrolls to the first letter of the company name.

2. Tap the entry you want to view or press the Jog Dial navigator.
   The entry you selected is shown.
Managing addresses and phone numbers (Address Book)

Editing Address Book entries

Pasting an image to an address entry

You can paste an image to the address entry. Paste a photograph of a person or restaurant, for example, as a reminder of an address entry.

To paste an image, you must first ready an image on your CLIÉ handheld with the PictureGear™ Pocket application. For details, see “Viewing image files (Picture Gear Pocket)” in the Add-on Application Guide.

1 Tap the address entry in the address list to which you want to paste an image.
The Address View screen of the selected address record appears.

2 Tap Edit.
The Address Edit screen appears.

3 Tap No Image in the upper right of the screen.

![Address Edit Screen]

Tap No Image.

The Select Image(s) screen appears.

![Select Image(s) Screen]

1 continued on next page
Managing addresses and phone numbers (Address Book)

4 Tap the image you want to paste.
The image you selected is pasted to the address entry.

5 Tap Done.
The Address screen is displayed again.
A camera icon is attached to the entry that has the pasted image.

Note
If you use the Palm Desktop for CLIÉ software to change the category of the address entry that has a pasted image, the image will no longer be associated with the address entry after the next HotSync® operation. To edit an address entry with a pasted image, use the Address Book application in your CLIÉ handheld.

To change the image
Tap the pasted image in the Address Edit screen. The Select image(s) screen appears. Tap to select another image.

To remove the image
Tap the pasted image in the Address Edit screen. The Select image(s) screen appears. Tap No images.
Managing addresses and phone numbers (Address Book)

Modifying an address entry
You can modify part of the address entry.

1. On the Address Book list screen, tap the entry you want to modify.
   The Address View screen of the selected entry appears.

2. Tap Edit.
   The Address Edit screen appears.

3. Tap the field that you want to edit.
   You can edit the tapped field.

4. Edit the entry.

5. When modification is complete, tap Done.
   The Address screen is displayed again.

To select types of phone numbers
You can select the types of phone numbers or e-mail addresses that you associate with an Address Book entry. Any changes you make apply only to the current entry. To select other types of phone numbers in an entry, tap the arrow ▼ and select the desired label from the drop-down list.
Managing addresses and phone numbers (Address Book)

Duplicating an address entry
You can copy existing address entries you have created. This feature is useful when you use the address of one person or edit part of the address for another person.

1. On the Address Book list screen, tap the entry you want to copy.
The Address View screen of the selected record appears.

2. Tap the Menu icon.
The Address Book menu is displayed.

3. Tap Duplicate Address from the Record menu.
The entry you selected in step 2 is copied.
The word “Copy” is added to the end of the name field of the copied information.

4. Tap Done.
The Address screen is displayed again.

Note
The pasted image is not duplicated.
Managing addresses and phone numbers (Address Book)

Deleting an address entry

1. On the Address Book list screen, tap the entry you want to delete.
   The Address View screen of the selected record appears.

2. Tap Edit.
   The Address Edit screen appears.

3. Tap Details.
   The Address Entry Details dialog box appears.

4. Tap Delete.
   The Delete Address dialog box appears.

5. Tap OK to delete the entry.
   The selected entry is deleted. To cancel deletion, tap Cancel.

Tip

If you select the “Save archive copy on PC” check box, the deleted data will be saved onto the Palm Desktop for CLIE software on your computer during the next HotSync® operation.
Managing addresses and phone numbers (Address Book)

Changing the address entry details
You can change the type of information that appears in the address list screen, categorize an entry, and hide an entry for security reasons. You can also delete entries.

1. On the Address Book list screen, tap the entry you want to change. The Address View appears.
2. Tap Edit. The Address Edit screen appears.
3. Tap Details. The Address Entry Details dialog box appears.
   - **Show in List**: Select which type of entries or other information appears in the Address list screen. Tap the arrow ▼ and select from Work, Home, Fax, Other, or E-mail.
   - **Category**: Assign the entry to a category.
   - **Private**: Select the Private check box to hide the current entry when Security is turned on. For details on Security, see “Protecting your data (Security)” on page 91.

5. Tap OK. The address entry details are saved.
Managing addresses and phone numbers (Address Book)

Using the Address Book menus

This section describes the menu commands specific to Address Book. For the Edit menu, see “Using the Edit menu” on page 99. The Record and Options menus differ depending on whether you are displaying the Address List screen or the Address View screen.

Record menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
</table>
| Delete Address   | Deletes the current address entry. The Delete Address dialog box appears.    | • By default, the entry that you delete will be saved onto the Palm Desktop for CLIÉ software on your computer during the next HotSync® operation. To delete the entry completely, deselect the check box (☐) for “Save archive copy on PC” in the Delete Address dialog box.  
• If the current entry has an image pasted, the image will not be deleted. |
| Duplicate Address| Makes a copy of the current entry and displays the copy in Address Edit so you can make changes to the copied entry. The copy has the same category and attached notes as the original entry. |                                                                                         |
| Beam Address     | Sends all the address entries in the currently selected category to another CLIÉ handheld via the infrared communications port. |                                                                                         |
| Beam Category    | Sends all the Address Book entries in the currently selected category to another CLIÉ handheld via the infrared communications port. |                                                                                         |
| Attach Note      | Adds comments to the current address entry. Choosing this menu opens up a screen for entering comments. |                                                                                         |
| Delete Note      | Deletes comments from the current address entry. Choosing this menu opens up the Delete Note dialog box. Tap Yes to delete comments and No to cancel the delete function. |                                                                                         |
| Select Business Card | Defines the current address entry on a business card. A business card icon (ﬁ) is displayed when you set an entry as a business card. |                                                                                         |
| Beam Business Card | Sends the current business card to another CLIÉ handheld via the infrared communications port. | **Tip** You can also send a business card via the infrared communications port by pressing and holding down the Address Book button for longer than 2 seconds. |
# Managing addresses and phone numbers (Address Book)

## Options menus

<table>
<thead>
<tr>
<th>Font</th>
<th>You can select a desired font in the Select Font dialog box.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferences</td>
<td><strong>Remember last category:</strong> Determines how Address Book appears when you return to it from another application. If you select this check box, Address Book shows the last category you selected. If you clear it, Address Book displays the All category.</td>
</tr>
<tr>
<td>Rename Custom Fields</td>
<td>These custom fields appear at the end of the Address Edit screen. Rename them to identify the kind of information you enter in them. The names you give the custom fields appear in all entries.</td>
</tr>
<tr>
<td>Security</td>
<td>Hides the current record unless the password is entered. You can select the view option among Show Records, Mask Records, or Hide Records.</td>
</tr>
<tr>
<td>About Address Book</td>
<td>Shows the version information for Address Book.</td>
</tr>
</tbody>
</table>
Managing tasks and things to do (To Do List)

A To Do List is a reminder of some task you have to complete. A record in To Do List is called an “item.”

Creating To Do List items

1. Press the To Do List button on the front panel. To Do List opens and displays the category of items you last viewed.

   **Note**

   Press the To Do List application button repeatedly to cycle through the categories in which you have items.

2. Tap New. A new To Do item is added to To Do List.

3. Enter the text of the To Do item. You can enter multiple lines of text.

4. Tap anywhere onscreen to deselect the To Do List item. The item is deselected and the new item is recorded to To Do List.

   **Tips**

   • If no To Do List item is currently selected, writing in the Graffiti® writing area automatically creates a new item.
   • To display text that does not fit on the screen, tap the text line.
Managing tasks and things to do (To Do List)

Viewing To Do List items

You can check the items you recorded in To Do List.

1. Press the To Do List button on the front panel.
   The To Do screen appears.

2. Rotate the Jog Dial™ navigator to select the To Do List item that contains the note you want to view.

3. Press the Jog Dial navigator.
   The notes of the selected item are displayed. If the item does not fit on the screen, rotate the Jog Dial navigator to scroll the screen.

4. Press the Jog Dial navigator.
   The To Do List box reappears.

Viewing To Do List items by category

Press the Jog Dial navigator when To Do List is displayed but no To Do item is selected.

Each time you press the Jog Dial navigator, the display toggles through all the available categories.

To select the desired category from the categories list

Tap the arrow ▼ at the upper right corner of the screen to display the category list. You can select the desired category from the list.
Managing tasks and things to do (To Do List)

Checking off a To Do List item

You can check off a To Do List item to remind you that you’ve completed it. You can set To Do List to record the date that you completed the To Do item, and you can choose to show or hide completed items. For details, see “Changing the appearance of To Do List” on page 68.

1. Press the To Do List button on the front panel.
   The To Do screen appears.
2. Tap to select the check box on the left side of the item.
   The check box changes to ✔️.
Managing tasks and things to do (To Do List)

Working with To Do List

Setting the priority of an item

The priority setting for items lets you arrange the tasks in your To Do List according to their importance or urgency. The default setting for To Do List is to arrange items by priority and due date, with priority 1 items at the top. If you have a number of items in your list, changing an item’s priority setting may move its position in the list.

On the To Do List screen, tap the Priority number on the left side of the item and then tap the desired Priority number.

You can select the Priority numbers 1 through 5, with 1 being the most important.

Tip

You can also set the priority from the To Do Item Details dialog box.
Managing tasks and things to do (To Do List)

Setting the due date for an item
You can associate a due date with any To Do List item. You can also sort the items that appear in the list based on their due date.

1. On the To Do List screen, tap the text of the item whose due date you want to set.
2. Tap Details.
3. Tap the arrow ▼ next to Due Date, and tap a desired due date from the drop-down list.
You can select one of the following options:

- **Today**: Assigns the current date.
- **Tomorrow**: Assigns the next day’s date.
- **One week later**: Assigns the date exactly one week from the current date.
- **No Date**: Assigns no due date.
- **Choose Date**: Opens the Due Date screen, where you can choose any date from the calendar.

4. Tap OK.

Tip
If you turn on the Show Due Dates option in the To Do Preferences dialog box, you can tap directly on the due date in To Do List to select a desired due date.
Managing tasks and things to do (To Do List)

Deleting an item
You can delete items from To Do List.

1. On the To Do List screen, tap the item you want to delete.

2. Tap Details.
   The To Do Item Details dialog box appears.

3. Tap Delete.
   The Delete To Do dialog box appears.

   ![Delete To Do dialog box]

4. Tap OK to delete the item.
   The selected event is deleted. To cancel deletion, tap Cancel.

Tip
If you check the “Save archive copy on PC” check box, the deleted item will be saved onto the Palm Desktop for CLIÉ software on your computer during the next HotSync® operation.
Managing tasks and things to do (To Do List)

Changing the appearance of To Do List

The To Do Preferences dialog box enables you to change the appearance of To Do List.

1. On the To Do List screen, tap Show.
   The To Do Preferences dialog box appears.

   ![To Do Preferences dialog box]

   - **Sort by:** Priority, Due Date
   - **Show Completed Items**
   - **Show Only Due Items**
   - **Record Completion Date**
   - **Show Due Dates**
   - **Show Priorities**
   - **Show Categories**

2. Change the To Do Preferences settings.
   You can choose any of the following settings:
   - **Show Completed Items:** Displays your completed items in To Do List. If you turn off this setting, your To Do items disappear from the list when you complete (check) them.
   - **Show Only Due Items:** Shows only the items that are currently due, past due, or have no due date specified. When this setting is active, items that are not yet due do not appear in the list until their due date.
   - **Record Completion Date:** Replaces the due date with the actual date when you complete (check) the item. If you do not assign a due date to an item, the completion date still records when you complete the item.
   - **Show Due Dates:** Displays the due dates associated with items in To Do List and displays an exclamation mark next to items that remain incomplete after the due date passes.
   - **Show Priorities:** Shows the priority setting for each item.
   - **Show Categories:** Shows the category for each item.

3. Tap OK.
Managing tasks and things to do (To Do List)

Using the To Do List menus

This section describes the menu commands specific to To Do List. For the Edit menu, see “Using the Edit menu” on page 99.

Record menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Delete Item</strong></td>
<td>Deletes the current To Do item. The Delete To Do dialog box appears.</td>
</tr>
<tr>
<td><strong>Attach Note</strong></td>
<td>Adds comments to the current To Do item. Choosing this menu item opens up a screen for entering comments.</td>
</tr>
<tr>
<td><strong>Delete Note</strong></td>
<td>Deletes comments from the current To Do item. Choosing this menu item opens up the Delete Note dialog box.</td>
</tr>
<tr>
<td><strong>Purge</strong></td>
<td>Allows you to delete any completed items from To Do List. Run this command to save memory if you find too many recorded To Do items in your CLIÉ handheld.</td>
</tr>
</tbody>
</table>

**Note**

By default, the items that you purge will be saved onto the Palm Desktop for CLIÉ software on your computer during the next HotSync® operation. To delete the items completely, deselect the check box (☐) for “Save archive copy on PC” in the Purge dialog box.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Beam Item</strong></td>
<td>Sends the current To Do item to another CLIÉ handheld via the infrared communications port.</td>
</tr>
<tr>
<td><strong>Beam Category</strong></td>
<td>Sends all the To Do items in the currently selected category to another CLIÉ handheld via the infrared communications port.</td>
</tr>
</tbody>
</table>

Options menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font</strong></td>
<td>You can select a desired font in the Select Font dialog box.</td>
</tr>
<tr>
<td><strong>Phone Lookup</strong></td>
<td>The Phone Number Lookup screen appears. If there is an Address Book entry, you can look up the phone number of the selected item.</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Hides the current item unless the password is entered. You can select the view option among Show Records, Mask Records, or Hide Records.</td>
</tr>
<tr>
<td><strong>About To Do List</strong></td>
<td>Shows the version information for To Do List.</td>
</tr>
</tbody>
</table>
Creating memos (Memo Pad)

You can use Memo Pad to create brief memos on your CLIÉ handheld. You can also display TXT or CSV (Comma Separated Value) document files created on your computer (page 125). A record in Memo Pad is called a “memo.”

Creating a new memo

A memo can contain up to 4,000 characters. The number of memos you can store is limited only by the memory available on your CLIÉ handheld.

1. Press the Memo Pad button on the front panel.
   Memo Pad starts up. Memo Pad opens to display the last Memo Pad screen that you viewed.

   Tip
   Press the Memo Pad button repeatedly to cycle through the categories in which you have memos.

2. Tap New.
   A new memo is created.
Creating memos (Memo Pad)

3 Enter the text you want to appear in the memo.
   To move down to a new line, tap the Enter key when using the onscreen keyboard or write \ when using Graffiti® writing.

4 Tap Done or press the BACK button when you finish.
   The first line of the memo is displayed.

Tips

- You can also create a new memo by beginning your memo in the Graffiti writing area on the Memo screen. The first letter is automatically capitalized and begins your new memo.
- While entering text, the text may overlap the Done or Details buttons. After you finish entering the text, the overlap disappears.
Creating memos (Memo Pad)

Reviewing memos

The first line of a memo appears in the Memo List. This makes it easy to locate and review your memos.

1. Press the Memo Pad button on the front panel.
   Memo Pad starts and the Memo List is displayed.

2. Rotate the Jog Dial™ navigator to select the memo you want to view.
   If the desired memo is not displayed, rotate the Jog Dial navigator further to scroll up or down the memo list.

3. Press the Jog Dial navigator.
   The contents of the selected memo are displayed. If the memo text does not fit on the screen, rotate the Jog Dial navigator to scroll the screen.

4. Press the Jog Dial navigator.
   The Memo list is displayed again.
Creating memos (Memo Pad)

Viewing memos by category

Press the Jog Dial navigator when the memo list is displayed but no memo is selected.
Each time you press the Jog Dial navigator, the display toggles through all the available categories.

Selecting the desired category from the categories list
Tap the arrow ▼ at the upper right corner of the screen to display the category list. You can select the desired category from the list.

Sorting memos

You can change the order in which Memo Pad shows your memos.

1. Press the Memo Pad button on the front panel.
   Memo Pad starts and the Memo list is displayed.

2. Tap the Menu icon.
   A menu of commands appears.

3. Tap Options, and tap Preferences.
   The Memo Preferences dialog box appears.
Creating memos (Memo Pad)

4 Tap the desired order of the memos in the Sort by field.

- **Manual**: Sorts the memos manually.
- **Alphabetic**: Sorts the memos in numerical and then alphabetical order.

5 Tap OK.

To sort the memos manually

In step 4, select Manual to activate manual sorting.
Tap the memo you want to move in the Memo screen and drag it to the desired location. The memo is placed where you released the stylus.
The memos are renumbered accordingly.
Creating memos (Memo Pad)

Editing memos

Deleting a memo

You can delete an unnecessary memo from Memo Pad.

1. On the Memo Pad screen, tap the memo you want to delete. The contents of the memo you tapped appears.

2. Tap Details. The Memo Details dialog box appears.

3. Tap Delete. The Delete Memo dialog box appears.

4. Tap OK to delete the memo. The selected record is deleted. To cancel deletion, tap Cancel.

Tip

If you select the “Save archive copy on PC” check box, the deleted memo will be saved onto the Palm Desktop for CLIÉ software on your computer during the next HotSync® operation.
Creating memos (Memo Pad)

Categorizing a memo
You can categorize your memo. In step 2 of “Deleting a memo,” tap the arrow ▼ next to Category to display the list of available categories and then tap the desired category for the memo.

Making a memo private
You can hide a memo that you mark as private. If you define a password for your CLIÉ handheld, you must enter it to display private records.

1. On the Memo Pad screen, tap the memo you want to mark as private.
2. Tap Details.
The Memo Details dialog box appears.
3. Tap and select the Private check box.
4. Tap OK.
The memo is marked as private. For details on hiding or masking private events, see “Protecting your data (Security)” on page 91.
Creating memos (Memo Pad)

Using the Memo Pad menus

This section describes the menu commands specific to Memo Pad. For the Edit menu, see “Using the Edit menu” on page 99. The Record and Options menus differ depending on the screen displayed.

### Record menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Beam Category</strong></td>
<td>Sends all the memos in the currently selected category to another CLIÉ handheld via the infrared communications port.</td>
</tr>
<tr>
<td><strong>New Memo</strong></td>
<td>Creates a new memo.</td>
</tr>
<tr>
<td><strong>Delete Memo</strong></td>
<td>Deletes the current memo. The Delete Memo dialog box appears.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>By default, the memos that you delete will be saved onto the Palm Desktop for CLIÉ software on your computer during the next HotSync® operation. To delete the memos completely, deselect the check box (☐) for “Save archive copy on PC” in the Delete Memo dialog box.</td>
</tr>
<tr>
<td><strong>Beam Memo</strong></td>
<td>Sends the current memo to another CLIÉ handheld via the infrared communications port.</td>
</tr>
</tbody>
</table>

### The Options menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Font</strong></td>
<td>You can select a desired font in the Select Font dialog box.</td>
</tr>
<tr>
<td><strong>Phone Lookup</strong></td>
<td>Phone Number Lookup screen appears. If there is an Address Book entry, you can look up the phone number of the selected memo.</td>
</tr>
<tr>
<td><strong>Preferences</strong></td>
<td>Specifies how the memos are displayed. The Memo Preferences screen appears.</td>
</tr>
<tr>
<td><strong>Security</strong></td>
<td>Hides the current memo unless the password is entered. You can select the view option among Show Records, Mask Records, or Hide Records.</td>
</tr>
<tr>
<td><strong>About Memo Pad</strong></td>
<td>Shows the version information for Memo Pad.</td>
</tr>
</tbody>
</table>
Using Calculator (Calc)

Calculating with Calculator

1. Perform either of the following to start the Calculator:
   - Tap the Calculator icon.
   - Rotate the Jog Dial™ navigator to select Calc and press the Jog Dial navigator.
   - Tap the Calc icon on the Application Launcher screen.
   The Calculator screen appears.

2. Perform calculations using Calculator.
   To use Calculator, tap the numbers and symbol icons on the screen with the stylus.
Using the Calculator buttons

Calculator has several buttons to help you perform calculations.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CE</td>
<td>Clears the last number you entered. Use this button if you make a mistake while entering a number in the middle of a calculation. This button enables you to re-enter the number without starting the calculation over.</td>
</tr>
<tr>
<td>C</td>
<td>Clears the entire calculation and enables you to begin a new calculation.</td>
</tr>
<tr>
<td>+/-</td>
<td>Toggles the current number between a negative and positive value. If you want to enter a negative number, enter the number first and then press the +/- button.</td>
</tr>
<tr>
<td>M+</td>
<td>Places the current number in memory. Each new number you enter with the M+ button is added to the total stored in memory. The number that you add can be either a calculated value or any number you enter by pressing the number buttons. Pressing this button has no effect on the current calculation (or series of calculations); it merely places the value into memory until it is recalled.</td>
</tr>
<tr>
<td>MR</td>
<td>Recalls the stored value from memory and inserts it in the current calculation.</td>
</tr>
<tr>
<td>MC</td>
<td>Clears any value that is stored in the Calculator memory.</td>
</tr>
<tr>
<td>√</td>
<td>Calculates the square root of the entered number. Tap the button after entering the number.</td>
</tr>
</tbody>
</table>

Using the Calculator menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy, Paste</td>
<td>Copies a number from Calculator and pastes it into another application. Similarly, you can also paste numeric values you copied from another application such as Memo Pad into Calculator.</td>
</tr>
<tr>
<td>Recent Calculations</td>
<td>You can review the last series of calculations.</td>
</tr>
<tr>
<td>About Calculator</td>
<td>Shows the version information for Calculator.</td>
</tr>
</tbody>
</table>
Performing common tasks

This section describes how to perform tasks that you can do in most or all of the basic applications.

Using the Application Launcher

This section describes how to switch between applications, how to change application settings so they are customized to your work methods, and how to categorize applications so you view them in related groups.

1. To open the Application Launcher screen, tap the Home icon.

   ![Application Launcher Screen]

   **Tip**

   In addition to providing a way for you to open applications, the Application Launcher screen displays the current time, battery level, and the application category.

Selecting applications

To open an application, choose from the following options:

- Tap the icon of the application you want to open. If you have many applications installed on your CLIÉ handheld, tap the scroll bar to see all the available applications.
- Rotate the Jog Dial™ navigator to select the application. Push the Jog Dial navigator to launch the selected application.
- Press an application button ☎️, 📞, 📖, or 📫 on the front panel to display the corresponding application immediately.
Performing common tasks

Categorizing applications

The category feature enables you to manage the number of application icons that appear in the Application Launcher screen. You can assign an application to a category and then display a single category or all your applications.

To categorize an application

1. Tap the Home icon.
2. Tap the Menu icon.
3. Tap Category from the App menu.
   The Category screen appears.

4. Tap the arrow \( \downarrow \) next to each application to select a category from the drop-down list.

   Tip
   To create a new category for an application, tap Edit Categories from the drop-down list. Tap New, enter the category name, and tap OK to add the category. Tap OK again.

5. Tap Done.

To display applications by category

1. Tap the Home icon.
2. Do one of the following:
   - Tap the Home icon repeatedly to cycle through all the categories.
   - Tap the arrow \( \downarrow \) in the upper right corner of the screen and tap the desired category from the drop-down categories list.
   - Push the Jog Dial navigator repeatedly while no applications are highlighted.
Performing common tasks

Note
If you have a Memory Stick® media inserted in your CLIÉ handheld, a Card icon appears at the bottom of the drop-down categories list. For details on how to use the Memory Stick media, see page 136.

Changing the Application Launcher display
By default, the Application Launcher displays each application as an icon. Alternatively, you can display applications in a list format, or in a smaller icon/list. You can also choose to view the same category of applications each time you open the Application Launcher screen.

To change the view of applications

1 Tap the Home icon.
2 Tap the Menu icon.
   The menu is displayed.
3 Tap Options, and tap Preferences.
   The Preferences screen is displayed.

4 Tap the arrow next to View By, and tap to select from List, List (Small), or Icon (Small).
5 Tap OK.

The applications are displayed in the selected format.
Performing common tasks

To open the Application Launcher screen to the last-opened category or the last-used application

1. Tap the Home icon.
2. Tap the Menu icon.
   The menu is displayed.
3. Tap Options, and tap Preferences.
   The Preferences screen is displayed.
4. Tap the Remember Last Category check box to select it or the Remember Last Used App to select it.
5. Tap OK.

**Note**

Only applications opened from the Application Launcher screen are recognized as the last opened applications.

To display the Pop-up application menu with the Jog Dial navigator

In step 4, tap the arrow ▼ next to Jog Select and tap PopUp.
Performing common tasks

Categorizing records

You can categorize records in Address Book, To Do List, and Memo Pad applications for easy retrieval. (Date Book does not have categories.) When you create a record, it is automatically assigned to the currently displayed category. For example, if the All category is displayed, the record is assigned to the Unfiled category. A record can remain unfiled or it can be assigned to a category at any time.

System-defined and user-defined categories

By default, your CLIÉ handheld includes system-defined categories, such as All and Unfiled, and user-defined categories, such as Business and Personal. You cannot modify the system-defined categories, but you can rename or delete the user-defined categories. In addition, you can create your own user-defined categories. You can have a maximum of 15 user-defined categories in each application.

Tip

Address Book contains the QuickList user-defined category, in which you can store the names, addresses, and phone numbers that you might need in emergencies (doctors, fire department, lawyers, etc.).
Performing common tasks

Moving a record into a category

1 Tap the record that you want to categorize.
2 Address Book only: Tap Edit. The Address Edit screen appears.
3 Tap Details.
4 Tap the arrow ▼ next to Category to display the list of available categories.
5 Tap the desired category for the item.
6 Tap OK.

Displaying the category of records

1 Tap the arrow ▼ at the upper right corner of the screen. A list of available categories appears.
2 Tap the category you want to view. The list screen now displays only the records assigned to that category.
Performing common tasks

Defining a new category

1. Tap the arrow ▼ at the upper right corner of the screen. A list of available categories appears.

2. Tap Edit Categories. The Edit Categories screen is displayed.

3. Tap New. The Edit Categories dialog box is displayed.

4. Enter a new category name and tap OK. You can assign any of your entries to the new category.
Performing common tasks

Finding records

Your CLIÉ handheld lets you find information by entering text in the Find option dialog box or searching for a phone number using the Phone Lookup option. These two options are available for all the basic CLIÉ applications. Each application offers ways to find information:

- **Date Book, To Do List, Memo Pad**: Phone Lookup displays the Address List screen and lets you add the information that appears in this list to a record.

- **Address Book**: The Look Up line lets you enter the first letters of a name to scroll immediately to that name.

Using the Find option

The Find option lets you locate any text you specify in any application. For example, if the text appears in Address Book and Date Book, the Find option displays both occurrences in the Find dialog box.

1. Tap the Find icon.
   The Find dialog box appears.

2. Enter the text you want to find.
   You can enter letters, symbols, or numbers.
Performing common tasks

3 Tap OK.
Find searches for the text in records and notes and displays the results.

<table>
<thead>
<tr>
<th>Find</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matches for “Carter”</td>
</tr>
<tr>
<td>Addresses</td>
</tr>
<tr>
<td>Carter, Melanie</td>
</tr>
<tr>
<td>Datebook</td>
</tr>
<tr>
<td>Mail Messages</td>
</tr>
<tr>
<td>Memo</td>
</tr>
<tr>
<td>To-Do Items</td>
</tr>
</tbody>
</table>

4 Tap the text in the find result list that you want to review.
The application associated with the data automatically starts to display the data.

**To stop searching midway**
Tap Stop. To resume the search, tap Find More.

**Note**
The Find option is not case sensitive; searching for “sony” also finds “Sony.”

**Tip**
Select text in an application before tapping the Find icon to automatically place the text in the Find dialog box.
Performing common tasks

Using the Phone Lookup option

The Phone Lookup option lets you find a telephone number from the Address list screen and lets you add the information that appears in this list to a record. For example, you can add a telephone number from the Address list to an entry in Memo Pad.

1 Display the record in which you want to insert a phone number.
The record can be in Date Book, To Do List, or Memo Pad.

2 Tap the Menu icon.
The menu of the application appears.

3 Tap Options, and tap Phone Lookup.
The Phone Number Lookup screen appears.

4 Tap the phone number you want to add.

Tip
To quickly find a phone number, enter the first few letters of the name you want to find in the Look Up field in the lower screen.

Continued on next page
Performing common tasks

5 Tap Add.
   The Phone Lookup closes and the name and phone number are added to the record you displayed in step 1.

To activate Phone Lookup with Graffiti®
Write the Graffiti® Command stroke / ⇧ to activate Phone Lookup.

Phone Lookup using text
Drag and highlight text and then write the Graffiti Command stroke / ⇧. The selected text is replaced with the found name and phone number. If multiple records are found, the Phone Number Lookup screen appears.
Performing common tasks

Protecting your data (Security)

Your CLIÉ handheld includes a Security application that allows you to protect your data from unauthorized users.

In Security, you can do the following:

• Lock and turn off your CLIÉ handheld so that it does not operate until you enter the correct password.

• Set the CLIÉ handheld to automatically lock at/after a preset time, or whenever you turn it off.

• Mask all records that you mark as private so the information appears greyed out.

• Hide all records that you mark as private so they do not appear on any screen.

Tip

All private records can be masked or hidden, with or without a password. Without a password, the masked record will be unmasked when you tap it. With a password, you must enter the password to view the private records.

Assigning a password

You can assign a password to protect your private records and to lock your CLIÉ handheld.


The Security screen appears.

<table>
<thead>
<tr>
<th>Security</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Password:</strong></td>
</tr>
<tr>
<td><strong>Auto Lock Handheld:</strong></td>
</tr>
<tr>
<td><strong>Current Privacy:</strong></td>
</tr>
</tbody>
</table>

Lock & Turn Off | Help

Continued on next page
Performing common tasks

2 Tap Unassigned.
The Password dialog box appears.

3 Enter a password and a hint to remember it, then tap OK.
The dialog box for verifying the password appears.

4 Enter the same password again to verify it and tap OK.
Your password is assigned. In Password, “-Assigned-” is displayed.
To lock your CLIÉ handheld with this password, see page 94.

Changing or deleting a password

1 Rotate the Jog Dial navigator to select Security and press the Jog Dial navigator. Or tap the Security icon on the Application Launcher screen.
The Security screen appears.

2 Tap -Assigned-.
The Password dialog box appears.

3 Enter the current password and tap OK.
The dialog box used to enter a new password appears.
Performing common tasks

4. To change the password, enter a new password and tap OK.
   - To delete the password, tap Unassign.

If you forget your password

If you forget your password, you can delete it. Note, however, that deleting a forgotten password also deletes all entries and records marked as Private. (If you synchronize with your computer before deleting a forgotten password, you can restore your private records at the next HotSync® operation.)

1. Tap Lost Password in step 3.
   The Delete Password dialog box appears.

2. Tap Yes.
   Your password and private records are deleted.
Performing common tasks

Locking your CLIÉ handheld with a password
You can lock your CLIÉ handheld so that you have to enter your password to operate it.

**Note**
If you lock your CLIÉ handheld, you must enter the exact password to restart your CLIÉ handheld. If you forget the password, you must perform a hard reset to resume using your CLIÉ handheld. Performing a hard reset deletes all the records in your CLIÉ handheld; however, you can restore all synchronized data at the next HotSync® operation.

1. Perform a HotSync operation to synchronize the data between your CLIÉ handheld and your computer. See “Chapter 3: Exchanging and updating data using a HotSync® operation” for more information.

2. Assign a password and a hint to remember it. Follow the steps described in “Assigning a password” on page 91.


The Security screen appears.

4. Tap Lock & Turn Off.
The System Lockout dialog box appears.

Continued on next page
Performing common tasks

5 Tap Off & Lock.
Your CLIÉ handheld is turned off and locked.
To start your CLIÉ handheld, turn it on and enter the password.

Setting your CLIÉ handheld to lock automatically
You can set your CLIÉ handheld to lock whenever you turn it off.

1 Back up your data and assign a password.
Follow the steps described in “Assigning a password” on page 91.

2 Tap Never.
The Password screen appears.

3 Enter your password, and tap OK.
The Lock Handheld screen appears.

4 Tap your choice from the list.
- **Never**: Your CLIÉ handheld will not lock automatically. To lock it manually, you must tap Lock & Turn Off in the Security screen.
- **On power off**: Your CLIÉ handheld will lock when it is turned off.
- **At a preset time**: The Set Time dialog box appears. Set a time so your CLIÉ handheld will lock at that preset time.
- **After a preset delay**: Set your CLIÉ handheld to lock if inactive for a preset time. Enter the time, and tap the arrow ▼ next to it to select minute(s) or hour(s).

5 Tap OK.
Making records private

In all basic applications, you can make individual records private. Private records remain visible and accessible, until you select the Security setting to hide all private records.

To mask or hide private records

You can mask or hide your private records. To view the masked or hidden records, you need to enter the password.

1 Rotate the Jog Dial navigator to select Security or tap the Security icon on the Application Launcher screen. The Security screen appears.
2 Tap the arrow next to Current Privacy to select Mask Records or Hide Records from the drop-down list.
   - **Mask Records**: Masked records appear as grey placeholders in their position with a lock mark.
   - **Hide Records**: Hidden records disappear completely from the screen.
3 Tap OK.

To display private records

In step 2, select Show Records.
If you have a password, the Show Records screen appears. Enter the password and tap OK.
Performing common tasks

Attaching notes

In all basic applications except Memo Pad, you can attach a note to a record. A note can be up to several thousand characters long. For example, for an appointment in Date Book, you can attach a note with directions to a location.

1. Tap the record to which you want to add a note.
2. **Address Book only:** Tap Edit.
   The Address Edit screen appears.
3. Tap Details.
4. Tap Note.
5. Enter your note.

![Note icon](image)

6. Tap Done.
A small note icon appears at the right side of any item that has a note.

**Tip**

To display the note, tap the note icon. You can review or edit the note. To delete the note, tap Delete, and tap Yes.
Performing common tasks

Purging records

If outdated records of Date Book or To Do List take up memory on your CLIÉ handheld, it’s a good idea to remove them by using Purge. If you think Date Book or To Do List records might prove useful later, you can save them in an archive file on your computer. Purging is not available in Address Book or Memo Pad, so delete outdated records from these applications.

1. Open the application.
2. Tap the Menu icon.
3. Tap Purge from the Record menu.
   The Purge screen appears.

4. Tap the arrow ▼ and select how old a record must be to be purged.
5. If you want to save a copy of the purged records on your computer, select the “Save archive copy on PC” check box. If you want to delete the records completely, clear it.
6. Tap OK.
   If you chose to save a copy of the purged records, your CLIÉ handheld transfers them to an archive file on your computer the next time you perform a HotSync® operation.

Note

Purging does not happen automatically. You must tap the command to make it happen.
Performing common tasks

Using the Edit menu

The Edit menu is available with any screen where you enter or edit text. In general, commands available in the Edit menu apply to the text that you select in an application.

Selecting text in an application

1. Tap the beginning of the text that you want to select.
2. Drag the stylus over the text to highlight it.

Notes
- You can also double tap to select a word, or triple tap to select a line of text.
- You can also drag across the text to select additional words, or drag down to select a group of lines.

Edit menu

To display the Edit menu, tap the Menu  icon and select Edit.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td>Reverses the action of the last edit command. For example, if you used Cut to remove text, Undo restores the text you removed. Undo also reverses deletions done by using backspace.</td>
</tr>
<tr>
<td>Cut</td>
<td>Removes the selected text and stores it temporarily in the memory of your CLIÉ handheld. You can paste the text you cut into another area of the current application or into a different application.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected text and stores it temporarily in the memory of your CLIÉ handheld. You can paste the text that you copy into another area of the current application or into a different application.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts the text that you cut or copied at the selected point in a record. The text you paste replaces any selected text. If you did not previously cut or copy text, Paste does nothing.</td>
</tr>
<tr>
<td>Select All</td>
<td>Selects all of the text in the current record or screen. This enables you to cut or copy all of the text and paste it elsewhere.</td>
</tr>
<tr>
<td>Keyboard</td>
<td>Opens the onscreen keyboard. When you finish with the onscreen keyboard, tap Done.</td>
</tr>
<tr>
<td>Graffiti Help</td>
<td>Opens screens that show all the Graffiti® character strokes. Use this command any time you forget a stroke for a character.</td>
</tr>
</tbody>
</table>
Performing common tasks

Choosing fonts

In all basic applications, you can change the font style to make the text easier to read. You can choose a different font style for each application.

1. Open an application.
2. Tap the Menu icon.
   The menu is displayed.
3. Tap Options, and tap Font.
4. Tap the font style you want to use.
   You can select small, bold, or large font.

   ![Select Font](image)

5. Tap OK.
   The text in the application is displayed in the selected font style.
Chapter 3

Exchanging and updating data using a HotSync® operation

This chapter describes how to select HotSync® operation options and how to perform a HotSync operation via USB cable, infrared communications port, or network. Other advanced HotSync operations include how to use file link functions and how to import data from Windows applications.

Contents

What is a HotSync® operation? .............................................. 102
Performing a local HotSync® operation with the USB cable ... 103
Using the Palm™ Desktop for CLIÉ software ....................... 105
  Starting the Palm™ Desktop for CLIÉ software .................. 105
  Basic operations of the Palm Desktop for CLIÉ software .... 105
  Locating the Palm Desktop for CLIÉ components .......... 106
Advanced HotSync® operations .............................................. 107
  Setting the HotSync® setup options .............................. 107
  Customizing HotSync application settings (Conduit) ............ 109
  Conducting an IR HotSync operation ................................ 111
  Conducting a HotSync operation via modem .................... 114
  Conducting a HotSync operation via a network ............... 120
  Importing data from a Windows application ..................... 125
  Synchronizing with external data (File Link) .................... 127
What is a HotSync® operation?

A HotSync® operation is a one-step operation that allows you to synchronize data between your CLIÉ handheld and your computer. With just one press on the HotSync button, you can synchronize your CLIÉ handheld application data with the Palm™ Desktop for CLIÉ software data on your computer, back up the data of your CLIÉ handheld on your computer, or install add-on applications.

1. Synchronize the Date Book, Address Book, To Do List, and Memo Pad data on your CLIÉ handheld and your computer. The Palm Desktop for CLIÉ software can manage the data of multiple CLIÉ handhelds independently.

2. Back up the data stored on your CLIÉ handheld onto your computer. Synchronization ensures that your data is always safe and up-to-date. In case you need to perform a hard reset, a HotSync operation allows you to restore the data.

3. Import the data on your computer or install add-on applications onto your CLIÉ handheld.
Performing a local HotSync® operation with the USB cable

This section describes how to perform a HotSync® operation using the USB cable (local HotSync), assuming that you have performed all the necessary preparations and installations for your CLIÉ handheld and your computer. For the required preparations and software installation, and for information on performing a HotSync for the first HotSync operation, see the Read This First manual.

1. Connect the CLIÉ handheld to the USB cable.

2. On your CLIÉ Handheld, rotate the Jog Dial™ navigator to select HotSync and then press the Jog Dial navigator. Or tap the HotSync icon on the Application Launcher screen.

   The HotSync screen appears on your CLIÉ handheld.

   ![HotSync screen]

3. Tap the HotSync icon.

   The HotSync operation starts.

   When the HotSync operation is complete, a message showing the HotSync completion is displayed on your CLIÉ handheld.

   **Note**

   Do not disconnect your CLIÉ handheld from the USB cable until the HotSync operation is complete. Otherwise, the Palm Desktop for CLIÉ software may not quit normally.

   **If the HotSync operation does not start**

   Make sure that the HotSync icon is displayed in the Windows task tray on your computer screen and Local Serial is not selected from the shortcut menu. If the HotSync icon is not shown in the task tray, click Start, point to Programs (All Programs in Windows XP), Sony Handheld, and click HotSync Manager. Tap the HotSync icon on your CLIÉ handheld to start the HotSync operation.

   [Continued on next page]
Performing a local HotSync® operation with the USB cable

If a message stating that the selected COM port is not available is displayed
Follow the procedures below. If the same message appears again, uninstall the Palm Desktop for CLIÉ software and re-install it.

1. Click the HotSync icon in the Windows® task tray (bottom-right corner of the taskbar).
   A shortcut menu is displayed.
2. Make sure that Local USB is selected.
   If it is not selected, click Local USB to select it.

Notes
• Do not disconnect your CLIÉ handheld from the USB cable during a HotSync operation.
• Do not press the HotSync button during a HotSync® operation. It might cause errors and force the operation to quit.
• Do not enter power saving mode during a HotSync operation. If your computer enters power saving mode during a HotSync operation, the HotSync Manager will be forced to quit.

To change the user name
1. In the Palm™ Desktop for CLIÉ window, click Users from the Tools menu.
   The Users dialog box is displayed.
2. Click the user name you want to change in the list box and click Rename.
   The Rename User dialog box is displayed.
3. Enter a new user name and click OK.
   Your CLIÉ handheld user name is changed at the next HotSync operation.
Using the Palm™ Desktop for CLIÉ software

The Palm™ Desktop for CLIÉ software duplicates Date Book, Address Book, To Do List, and Memo Pad applications on your CLIÉ handheld, so you can view, enter, and modify data stored on your CLIÉ handheld with your computer. You can also import data from Windows software onto your CLIÉ handheld.

Starting the Palm™ Desktop for CLIÉ software

Double-click the Palm Desktop for CLIÉ software icon on the Windows desktop or click Start, select Programs (All Programs in Windows XP), Sony Handheld, and click Palm Desktop for CLIÉ. The Palm Desktop for CLIÉ software starts.

To quit the Palm Desktop for CLIÉ software
Click the close button in the upper right of the screen or click File, and then Exit.

Basic operations of the Palm Desktop for CLIÉ software

Click the icon of the application that you want to use. The screen switches to the selected application screen.

Basic operations for each application are the same as those of the corresponding CLIÉ application. For details, see the Palm Desktop online help. To display the online help, click Help and then Palm Desktop Help.
**Locating the Palm Desktop for CLIÉ components**

1. **List pane**
   Displays the records in the current Desktop application.

2. **Application Launch bar**
   Provides one-click access to each Desktop application. Click an icon to open its associated application.

3. **Install Tool icon**
   Displays the Install Tool dialog box to select the application you want to install on your CLIÉ handheld the next time you perform a HotSync® operation.

4. **User name display**
   Displays the user name of the owner of the information being displayed.

5. **Record pane**
   Displays full details of the record that is selected in the List pane. The information displayed here is the same as that displayed on your CLIÉ handheld’s Details screen.
Advanced HotSync® operations

Setting the HotSync® setup options

You can change how to start the HotSync® Manager or make the local HotSync settings.

1. Click the HotSync icon in the Windows® task tray (bottom-right corner of the taskbar) and select Setup from the shortcut menu.

The Setup dialog box appears.

2. Click the General tab to select one of the following options.

If you are not sure which option to use, keep the default setting: (Always available)

- **Always available**: Adds the HotSync Manager to the Startup folder and starts the HotSync Manager to monitor the USB port as soon as Windows is started. This allows you to perform a HotSync operation even when the Palm Desktop for CLIÉ software is not running.

- **Available only when the Palm Desktop is running**: Starts the HotSync Manager when you start the Palm Desktop for CLIÉ software.

- **Manual**: Starts the HotSync Manager only when you select HotSync Manager from the Windows Start menu.
3 Click the Modem tab to display the modem settings and adjust the options as needed. See “Conducting a HotSync® operation via modem” on page 114 for more information.

4 If you are attached to a network, click the Network tab to display the network settings and adjust the options as needed. See “Conducting a HotSync® operation via a network” on page 120 for more information.

5 Click OK.
Customizing HotSync application settings (Conduit)

What is a “Conduit”?
For each application, you can define a set of options that determine how records are handled during synchronization. These options are called a “conduit.” By default, a HotSync® operation synchronizes all files between your CLIÉ handheld and the Palm Desktop for CLIÉ software.

In general, you should leave the settings as they are to synchronize all files. The only reason you might want to change these settings is to overwrite data on either your CLIÉ handheld or the Palm Desktop for CLIÉ software, or to avoid synchronizing a particular type of file because you do not use it. In addition to the conduits for Date Book, Address Book, To Do List, and Memo Pad, the Palm Desktop for CLIÉ software offers System and Install conduits. The System conduit backs up the system information stored on your CLIÉ handheld. The Install conduit installs add-on applications to your CLIÉ handheld.

1. Click the HotSync icon in the Windows task tray (bottom-right corner of the taskbar) and select Custom from the HotSync Manager menu.
Or, select Custom from the HotSync menu of the Palm Desktop for CLIÉ software.
The Custom dialog box appears.

2. Select the appropriate user name you are using on your CLIÉ handheld from the drop-down list.

3. Select an application in the Conduit list.
Advanced HotSync® operations

4 Click Change.
The Change HotSync Action dialog box appears.

5 Click the direction in which you want to write data, or click Do nothing.

6 Click OK.

7 Repeat steps 2 through 6 to change conduit settings for other applications (or users).

8 Click Done.

Notes

- Any change in the HotSync setting from the default affects only the next HotSync operation. Thereafter, the HotSync Actions revert to their default settings. To use a new setting on an ongoing basis, check the Set as default box.
- To restore the default settings, click Default in the Custom dialog box.
Advanced HotSync® operations

Conducting an IR HotSync operation

You can use the IR (infrared) port of your CLIÉ handheld to perform an IR HotSync® operation with a computer equipped with an IrDA (Infrared Data Association) IR port. An IR HotSync operation allows you to perform a HotSync operation without using the USB cable.

Before you start performing an IR HotSync operation

Check the following:

• Your computer is equipped with an infrared port supporting the IrDA standards.
• The infrared port of your computer is enabled for Windows use.

To enable the IR port with Windows, see the manual of the computer you are using or the Windows online help.

• Which port number is allocated to the infrared port.

Check the infrared port number in the Infrared Monitor in the Control Panel. For information on the Infrared Monitor, see the manual of the computer you are using or the Windows online help.

Preparing your computer

To perform an IR HotSync operation, you have to allocate a virtual port to an IR HotSync operation.

Windows 2000 Professional/Windows XP users:

1. Click the HotSync icon in the Windows task tray (bottom-right corner of the taskbar), and select IR from the shortcut menu.

Your computer is ready to perform an IR HotSync operation.

Windows 98/98 Second Edition/Me users:

1. Click the HotSync icon in the Windows task tray (bottom-right corner of the taskbar) and select Local Serial from the shortcut menu.

2. Click the HotSync icon in the Windows task tray again and select Setup from the shortcut menu.

The setup dialog box is displayed.

Continued on next page
Advanced HotSync® operations

3 Click the Local tab to change the setting for an IR HotSync operation as needed.
   • **Serial Port:** Specifies a virtual port for an infrared port. If you are not sure of the connection port, see the Infrared Monitor in the Windows Control Panel.
   • **Speed:** Determines the speed at which data is transferred. Try the “As Fast As Possible” rate first, and adjust downward if you experience problems.

4 Tap OK.
   Your computer is ready to perform an IR HotSync operation.

**Note**
When performing a local HotSync operation with the USB cable after you make the HotSync Setup settings for an IR HotSync operation, you should restore the local HotSync settings. For details, see “To restore the local HotSync settings” on page 113.

Performing an IR HotSync operation
After you prepare your computer and your CLIÉ handheld, and select your Conduit Setup options, you are ready to perform an IR HotSync operation.

1 Rotate the Jog Dial™ navigator to select HotSync and press the Jog Dial navigator. Or tap the HotSync icon on the Application Launcher screen.
   The HotSync dialog box appears.

2 Tap Local.

3 Tap the arrow ▼ beneath the icon and select IR to a PC/Handheld from the drop-down list.

4 Point the IR port of your CLIÉ handheld directly at the IR port of the receiving computer.

**Tip**
For best results, your computer and your CLIÉ handheld should be 4 to 8 inches (approximately 10 to 20 centimeters) apart, and the path between your CLIÉ handheld and the computer must be clear of obstacles.

Continued on next page
Advanced HotSync® operations

5 Tap the icon.
   The HotSync operation starts. Wait for the message showing that the HotSync operation is complete.

To restore the local HotSync settings
1 Connect the USB cable to your computer.

2 Click the HotSync icon in the Windows task tray and clear the check mark of Local Serial from the shortcut menu.

3 Click the HotSync icon in the Windows task tray again and select Setup from the shortcut menu.
The setup dialog box is displayed.

4 Click the Local tab to display the setting for a local HotSync operation as needed.

5 Click OK.
   Your computer is now ready to perform a local HotSync operation.
Advanced HotSync® operations

Conducting a HotSync operation via modem

You can use a modem to synchronize your CLIÉ handheld when you are away from your computer. A HotSync® operation via modem allows you to back up your CLIÉ data to your computer away from your computer.

![Diagram of a HotSync operation via modem]

**Notes**

- The first HotSync operation must be local, using the USB cable. After that, you can perform a modem HotSync operation.
- It may take many minutes to complete a HotSync operation via modem. To minimize the time required to synchronize data with a modem, define the files and/or applications you synchronize during a modem HotSync operation in advance. For details, see “To select the conduits for a modem HotSync operation” on page 118.

**Before you start performing a HotSync operation via modem**

Verify the following:

- A modem or terminal adapter is connected to your computer.
- The Palm Desktop for CLIÉ software is properly configured for use with the modem.
Advanced HotSync® operations

Preparing your computer

The following few steps must be performed to prepare your computer for a modem HotSync operation. Be sure to perform these steps before you leave your office or home so that your computer is ready to receive a call from your CLIÉ handheld.

1. Verify the following, to prepare your computer for a modem HotSync operation:
   • The computer modem is connected to your computer and both the modem and computer are turned on.
   • No communication applications, such as fax or telephony software, are running on the COM port.
   • The computer is disconnected from all online services. This helps to avoid conflicts with the COM port.

2. Click the HotSync icon in the Windows task tray (bottom-right corner of the taskbar) and select Modem from the shortcut menu.

3. Click the HotSync icon in the Windows task tray again and select Setup from the shortcut menu. The Setup dialog box is displayed.

4. Click the Modem tab.

[Diagram of Setup dialog box]

Continued on next page
Advanced HotSync® operations

5 Adjust the following options as needed.
   • **Serial Port**: Identifies the port for the modem. If you are unsure of the port assignment, look at the Modem Properties in the Windows Control Panel.
   • **Speed**: Determines the speed at which data is transferred. Try the “As Fast As Possible” rate first, and adjust downward if you experience problems. This setting allows the Palm Desktop for CLIÉ software and your CLIÉ handheld to find and use the fastest speed.
   • **Modem**: Identifies the modem type or manufacturer. Refer to your modem manual or face plate for its type or settings. If you are not sure of your modem type or your modem does not match any that appear in the list, select Hayes Basic.
   • **Setup String**: Identifies the setup string for your particular modem. Not all modems require a setup string. Refer to your modem manual and enter a setup string if recommended by the manufacturer.

6 Click OK.

Preparing your CLIÉ handheld
Follow the procedures below to prepare your CLIÉ handheld for a modem HotSync operation.

1 Rotate the Jog Dial navigator to select HotSync and press the Jog Dial navigator. Or tap the HotSync icon on the Application Launcher screen. The HotSync dialog box appears.

2 Tap Modem.
Advanced HotSync® operations

3 Tap the Enter phone # field.
The Phone Setup dialog box is displayed.

![Phone Setup]

4 Change the following settings if necessary:
① Enter the telephone number used to access the modem connected to your computer.
   If necessary, enter a dial prefix (such as “9”) to access an outside line, and tap the Dial prefix check box. You can enter a comma in the field to introduce a “pause” in the dialing sequence. Each comma equals a two second pause.
② If the phone line you are using for your CLIÉ handheld has Call Waiting, select the “Disable call waiting” check box to avoid an interruption during the modem HotSync operation.
③ If you want to use a calling card to place the call, select the “Use calling card” check box and enter the calling card number.

Note
If you plan to connect to your company’s dial-in server (network modem) instead of connecting to a computer modem, see “Conducting a HotSync operation via a network” on page 120.

5 Tap OK.
The HotSync screen is displayed again.

Continued on next page
Advanced HotSync® operations

To select the conduits for a modem HotSync operation
The Conduit Setup dialog box on your CLIÉ handheld enables you to define which files and/or applications synchronize during a modem HotSync operation. You can use these settings to minimize the time required to synchronize your data when using a modem.

To change the Conduit Setup for a modem HotSync operation:

1. Rotate the Jog Dial navigator to select HotSync and press the Jog Dial navigator. Or tap the HotSync icon on the Application Launcher screen.
   The HotSync screen appears.

2. Tap the Menu icon.

3. Tap Options, and tap Conduit Setup.
   The Conduit Setup screen is displayed.

4. Tap the check boxes to clear the selection of the files and applications that you do not want to synchronize during a modem HotSync operation.
   The default setting is to synchronize all files.

   Note
   Applications that do not have a database (such as games) do not synchronize, even if you select the item in the Conduit Setup dialog box.

5. Tap OK.
Performing a HotSync operation via modem

After you prepare your computer and your CLIÉ handheld, and select your Conduit Setup options, you are ready to perform a modem HotSync operation.

1. Rotate the Jog Dial navigator to select HotSync and press the Jog Dial navigator, or tap the HotSync icon on the Application Launcher screen.
   The HotSync screen appears.

2. Tap the icon.
   A HotSync operation starts. Wait for the message showing that the HotSync operation is complete.
Advanced HotSync® operations

Conducting a HotSync operation via a network

When you use the Network HotSync® application, you can take advantage of the LAN and WAN connectivity available in many office environments. The Network HotSync application enables you to perform a HotSync operation by dialing in to a network (Network Modem Sync) or by using a USB cable that is connected to any computer on your LAN or WAN (LAN Sync) (provided that the computer connected to the USB cable also has the Network HotSync application installed, your computer is on, and the HotSync Manager is running).

To connect to your company’s dial-in server
The Network HotSync application requires the following:

• Your computer has TCP/IP support installed.
• Both your company’s network system and its remote access server support TCP/IP.
• You have a remote access account.

Everything you need to connect to your company’s dial-in server (network modem) is included in the Palm Desktop for CLIÉ software and your CLIÉ handheld. You need to activate certain features, however, on both the Palm Desktop for CLIÉ software and your CLIÉ handheld.

Preparing your computer

1 Click the HotSync icon in the Windows task tray and select Network from the shortcut menu.
2 Click the HotSync icon in the Windows task tray again and select Setup from the shortcut menu.
   The Setup screen is displayed.
3 Click the Network tab and make sure your user name has a check mark next to it. If the check mark is not there, click the check box next to your user name.
4 Click OK.
Advanced HotSync® operations

5 Connect your CLIÉ handheld to the USB cable and perform a HotSync operation.
This HotSync operation records the network information about your computer onto your CLIÉ handheld.

6 Check if your computer’s network information (Primary PC name and Primary PC address) is entered in your CLIÉ handheld:

1. Rotate the Jog Dial navigator to select HotSync and press the Jog Dial navigator. Or tap the HotSync icon on the Application Launcher screen.
   The HotSync screen appears.
2. Tap the Menu icon.
3. Tap Primary PC Setup from the Options menu.
   The Primary PC Setup screen is displayed.
4. On your computer, click the HotSync icon in the Windows task tray and select Setup from the shortcut menu.
5. Click the Network tab, then click TCP/IP Settings to open the TCP/IP Settings screen.
6. Confirm that the Primary PC name and Primary PC address on both screens displayed in sub-steps 3 and 5 match. If they do not match, change the Primary PC name and Primary PC address entered in your CLIÉ handheld, then tap OK.
7. On your computer, click OK to close the TCP/IP Settings screen and the Setup screen.

Preparing your CLIÉ handheld and performing a network HotSync operation

When dialing into a network (Network Modem Sync)

1. Rotate the Jog Dial navigator to select HotSync and press the Jog Dial navigator. Or tap the HotSync icon on the Application Launcher screen.
   The HotSync screen appears.

2. Tap the Menu icon.
3 Tap Modem Sync Prefs from the Options menu. The Modem Sync Preferences screen is displayed.

4 Tap Network.

5 Tap OK. The HotSync screen appears again.

6 Tap Modem, and tap Select Service. The Preferences screen is displayed.

7 Tap the arrow ▼ next to Service and select a service from the drop-down list.

**Note**

See “Changing the Network preferences” on page 172 for information on creating a network connection.
Advanced HotSync® operations

8 Tap Done.
9 Tap the Menu icon.
10 Tap Conduit Setup from the Options menu.

   Follow the instructions in “To select the conduits for a modem HotSync operation” on page 118.

11 Perform a HotSync operation via modem.

   Follow the instructions in “Performing a HotSync operation via modem” on page 119.

When connecting to the network computer via cable (LANSync)

1 Rotate the Jog Dial navigator to select HotSync and press the Jog Dial navigator. Or tap the HotSync icon on the Application Launcher screen.

   The HotSync screen appears.

2 Tap the Menu icon.

3 Tap LANSync Prefs from the Options menu.

   The LANSync Preferences screen is displayed.

4 Tap LANSync.

5 Tap OK.

   The HotSync screen appears again.

6 Tap the Menu icon.
Advanced HotSync® operations

7 Tap Conduit Setup from the Options menu.
   Follow the instructions in “To select the conduits for a modem HotSync
   operation” on page 118.

8 Perform a local HotSync operation.
   Follow the instructions in “Performing a local HotSync® operation with
   the USB cable” on page 103.
Advanced HotSync® operations

Importing data from a Windows application

If you have data stored in Windows computer applications such as spreadsheets and databases, you can transfer that data to your CLIÉ handheld.

Importable file formats
Save data in one of the file formats listed below, import it into the Palm Desktop for CLIÉ software, and perform a HotSync® operation to transfer the data to your CLIÉ handheld.

The Palm Desktop for CLIÉ software can import data in the following file formats:

- Comma delimited (*.csv, *.txt): Address Book and Memo Pad only
- Tab separated values (*.tab, *.tsv, *.txt): Address Book and Memo Pad only
- vCard File (*.vcf): Address Book only
- CSV (Lotus Organizer 2.x/97 Mapping): Address Book only
- Text (*.txt): Memo Pad only
- Date Book archive (*.dba)
- vCal File (*.vcs): Date Book only
- Address Book archive (*.aba)
- To Do archive (*.tda)
- Memo Pad archive (*.mpa)

Archive formats can only be used with the Palm Desktop for CLIÉ software. Use the archive file formats to share information with other people who use a Palm OS® platform handheld or to create a copy of your Palm Desktop for CLIÉ software information.
Importing data

1. Start the Palm Desktop for CLIÉ software.
2. Click the application into which you want to import data.
3. If you are importing records that contain a field with category names, select All in the Category box.
   Be sure that the same categories that appear in the imported file also exist in the application. If the categories do not exist, create them now; otherwise, the records will be imported into the Unfiled category.
4. Click Import from the File menu.
   The Import dialog box is displayed.
5. Select the file you want to import.
6. Click Open.
7. To import data into the correct Palm Desktop for CLIÉ fields, drag the fields in the left-hand column so that they parallel to the corresponding imported fields on the right.
8. Clear the check box for the field that you do not want to import.
9. Click OK.
   The imported data is highlighted in the application.
10. To add the imported data to your CLIÉ handheld, perform a HotSync operation.

See the Palm Desktop for CLIÉ online Help for more information on importing and exporting data.
Synchronizing with external data (File Link)

The File Link feature allows you to import Address Book and Memo Pad information onto your CLIÉ handheld from a separate external file such as a company phone list. HotSync® Manager stores the data in a separate category on your Palm Desktop for CLIÉ software and your CLIÉ handheld. You can set the File Link feature to check for changes to the external file when you perform a HotSync operation.

With File Link, you can import data stored in any of the following file formats:

- Comma-delimited (*.csv)
- Palm Desktop for CLIÉ software’s Memo Pad archive (*.mpa)
- Palm Desktop for CLIÉ software’s Address Book archive (*.aba)
- Text (*.txt)

For information on how to set up File Link, see the Desktop for CLIÉ online help.
Chapter 4

Communicating using your Sony CLIÉ Handheld

This chapter describes how to communicate with another Palm OS® PDA device via the infrared communications port or Memory Stick® media, how to handle Memory Stick media, and how to use the Memory Stick Gate application for managing the data in Memory Stick media.

Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beaming between your Sony CLIÉ Handheld and another Palm OS® PDA</td>
<td></td>
</tr>
<tr>
<td>What you can do with beaming</td>
<td>129</td>
</tr>
<tr>
<td>Beaming information</td>
<td>130</td>
</tr>
<tr>
<td>Receiving beamed information</td>
<td>131</td>
</tr>
<tr>
<td>Tips on beaming information</td>
<td>131</td>
</tr>
<tr>
<td>Using Memory Stick® media</td>
<td></td>
</tr>
<tr>
<td>What is Memory Stick® media?</td>
<td>132</td>
</tr>
<tr>
<td>Inserting and removing Memory Stick media</td>
<td>133</td>
</tr>
<tr>
<td>Protecting the data in Memory Stick media</td>
<td>135</td>
</tr>
<tr>
<td>Starting an application in Memory Stick media</td>
<td>136</td>
</tr>
<tr>
<td>Starting an application automatically when Memory Stick media is inserted</td>
<td>136</td>
</tr>
<tr>
<td>Viewing information of the inserted Memory Stick media (Card Info)</td>
<td>137</td>
</tr>
<tr>
<td>Formatting Memory Stick media</td>
<td>138</td>
</tr>
<tr>
<td>Exchanging data via Memory Stick® media</td>
<td>140</td>
</tr>
<tr>
<td>Starting the Memory Stick® Gate (MS Gate) application</td>
<td>140</td>
</tr>
<tr>
<td>Copying your CLIÉ handheld data to Memory Stick media</td>
<td>143</td>
</tr>
<tr>
<td>Copying data in Memory Stick media to your CLIÉ handheld</td>
<td>145</td>
</tr>
<tr>
<td>Deleting data in Memory Stick media</td>
<td>148</td>
</tr>
<tr>
<td>Using the Memory Stick Gate menus</td>
<td>150</td>
</tr>
<tr>
<td>Installing applications to/from Memory Stick media without using the Memory Stick Gate application</td>
<td>151</td>
</tr>
</tbody>
</table>
Beaming between your Sony CLIÉ Handheld and another Palm OS® PDA

What you can do with beaming

Your CLIÉ handheld is equipped with an IR (infrared) port that you can use to beam information to another Palm OS® PDA device that is close by and also has an IR port. The IR port is located at the top of your CLIÉ handheld, behind the small dark shield.

You can beam the following information between your CLIÉ handheld and another Palm OS PDA:

- The record currently displayed in Address Book, Date Book, To Do List, or Memo Pad.
- All records of the category currently displayed in Address Book, Date Book, To Do List, or Memo Pad.
- A special Address Book entry that you designate as your business card.
- An application installed in RAM memory.

Note

Some applications are protected and cannot be beamed, as indicated by a lock icon to the side of applications.
Beaming between your Sony CLIÉ Handheld and another Palm OS® PDA

Beaming information

You can beam a record, business card, or category of records between your CLIÉ handheld and another Palm OS PDA.

1. Locate the record, business card, or category you want to beam.

2. Tap the Menu icon.

3. Tap one of the following from the Record menu:
   - The Beam command for an individual record
   - In Address Book only: Beam Business Card
   - Beam Category

4. When the Beam dialog box appears, point the IR port directly at the IR port of the receiving handheld.

   ![Beam Image]

   **Tip**

   For best results, your CLIÉ handheld and another Palm OS PDA should be 4 to 8 inches (approximately 10 to 20 centimeters) apart. The path between the two handhelds must be clear of obstacles and shielded from fluorescent lighting. Beaming distance to other Palm OS PDA handhelds may be different.

5. Wait for the Beam dialog box to indicate that the transfer is complete before you continue working on your CLIÉ handheld.
Beaming between your Sony CLIÉ Handheld and another Palm OS® PDA

Receiving beamed information

1. Turn on your CLIÉ handheld.
2. Point the IR port directly at the IR port of the other Palm OS PDA handheld transmitting the data.
   The Beam dialog box is displayed. Beaming data starts.
   You can select the category in which you save the data in a dialog box.
3. Tap Yes.
   The data is saved to the unfiled category.

Note
If Beam Receive in the Preferences menu is set to Off, you cannot receive data using the beaming feature. Before beaming data, make sure to set Beam Receive to On.

Tips on beaming information

- Incoming data or application should be placed in the Unfiled category.
- You can press the Address Book button for about two seconds to beam your business card.
- You can use Graffiti® writing to beam the current entry ( then B, or and then tap ).
Using Memory Stick® media

What is Memory Stick® media?

Memory Stick® media is a new compact, portable and versatile Integrated Circuit recording medium with a data capacity that exceeds a floppy disk. Memory Stick media is specially designed for exchanging and sharing digital data among Memory Stick media compatible products such as a digital video camera. Because it is removable, Memory Stick media can also be used for external data storage.

Memory Stick media allows you to exchange data between your CLIÉ handheld and your computer or a digital camera that supports Memory Stick media. To exchange data via Memory Stick media, your CLIÉ handheld uses the supplied Memory Stick Gate (MS Gate) application.

Types of Memory Stick media

There are two types of Memory Stick media:

• MagicGate Memory Stick media, which is equipped with “MagicGate” copyright protection technology.
• Memory Stick media, which is not equipped with “MagicGate” copyright protection technology.

You can use both types of Memory Stick media with your CLIÉ handheld (PEG-SL10, PEG-SJ20, or PEG-SJ30). Note, however, that your CLIÉ handheld does not support the “MagicGate” copyright protection technology. You can use MagicGate Memory Stick media with your CLIÉ handheld only as standard Memory Stick media.

Note on using MagicGate Memory Stick media

If you use the Memory Stick Gate application or Windows® Explorer to handle a protected file, such as copying it from a MagicGate Memory Stick media to your computer, the file may be disabled. To handle copyright-protected files, use a “MagicGate” compliant application such as the SonicStage LE software.
Using Memory Stick® media

Inserting and removing Memory Stick media

Insert Memory Stick media into the Memory Stick slot as illustrated below. The contents of the Memory Stick media is displayed automatically.

![Inserting Memory Stick media](image)

The Memory Stick indicator lights in orange while your CLIÉ handheld is accessing Memory Stick media.

**Note**

Insert Memory Stick media in the right direction. If Memory Stick media is forced in the wrong way, it may be damaged.

**To remove Memory Stick media**

Make sure that your CLIÉ handheld is not writing to or reading data from Memory Stick media.

Push Memory Stick media gently into the slot and then release it so that Memory Stick media pops out. Then pull it out from your CLIÉ handheld.

![Removing Memory Stick media](image)

Push Memory Stick media in. Pull Memory Stick media out.

Continued on next page
Using Memory Stick® media

Notes on using Memory Stick media
When you use Memory Stick media, follow these precautions:

• Avoid touching the terminal of Memory Stick media or contacting it with a metal object.
• Do not drop, bend, or submit Memory Stick media to external shock.
• Do not disassemble or modify Memory Stick media.
• Avoid getting liquids on Memory Stick media.
• Avoid using or storing Memory Stick media in a location subject to:
  – extremely high temperature such as the hot inside of a car, the outdoors exposed to direct sunlight, or near a heater.
  – direct sunlight – high humidity
  – corrosive substances – excessive dust
  – magnetic fields
• When storing and carrying Memory Stick media, keep it in its original case to ensure protection of important data.
• Save a backup for important data.
• Avoid removing Memory Stick media from the insertion slot while data is being written or read.
• To avoid damaging or erasing data, do not
  – release Memory Stick media or unplug the AC power adapter while formatting, or reading or writing data.
  – use Memory Stick media in a location subject to static electricity or electric noise.
• If the battery of your CLIÉ handheld is running out, an error message is displayed and you cannot exchange data with Memory Stick media.
  If this occurs;
  - for PEG-SL10, replace the batteries with new ones.
  - for PEG-SJ20/PEG-SJ30, connect the AC power adapter or fully charge your CLIÉ handheld.
• Use the Memory Stick Gate application to format Memory Stick media you use in your CLIÉ handheld. If you format it using another application, further operation with your CLIÉ handheld is not guaranteed.

Continued on next page
Using Memory Stick® media

- If you insert Memory Stick media that has been formatted by another application, a message prompting you to format it is displayed. To use Memory Stick media in your CLIÉ handheld, follow the instructions to format it. Note, however, that all stored data will be erased.

Protecting the data in Memory Stick media

To prevent accidental erasure of important data, you can use the write protect tab of Memory Stick media. Slide the tab to the left or right to enable or disable writing to Memory Stick media.

**Write enable position**
Slide the tab to the left to select the write enable position. You can read and write data in the Memory Stick media.

**Write protect position (LOCK)**
Slide the tab to the right. You can only read the data in the Memory Stick media. Select the write protect position when you do not want to overwrite or delete the data in the inserted Memory Stick media.
Using Memory Stick® media

Starting an application in Memory Stick media

To open an application in the Memory Stick media from the Application Launcher screen, tap the arrow ▼ in the upper-right corner of the Application Launcher screen and select Card (or a category with the Card icon). Then, tap the icon of the application you want to open.

![Application Launcher screen](image)

**Note**

If the application you are about to open had been installed to the Memory Stick media through a HotSync® operation, some Sony application may not start. For details, see page 152.

Starting an application automatically when Memory Stick media is inserted

The Memory Stick Autorun (MS Autorun) allows you to start a specified application automatically when Memory Stick media is inserted into your CLIÉ handheld. You can select your favorite application as the auto-run application. For example, if you like watching still images, set PictureGear™ Pocket to start automatically.

See the supplied “Add-on Application Guide” for details.
Using Memory Stick® media

Viewing information of the inserted Memory Stick media (Card Info)

The Card Info gives you the outline (such as the remaining memory space) of the Memory Stick media inserted into your CLIÉ handheld. You can also give a name to each Memory Stick media, which comes in handy when you have more than one Memory Stick media.

1. Rotate the Jog Dial™ navigator to select Card Info and press the Jog Dial navigator. Or tap the Card Info icon on the Application Launcher screen.

   The Card Info screen appears.

<table>
<thead>
<tr>
<th>Card Info</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Card:</strong></td>
</tr>
<tr>
<td><strong>Type:</strong></td>
</tr>
<tr>
<td><strong>Size:</strong></td>
</tr>
<tr>
<td><strong>56.0 KB Used</strong></td>
</tr>
<tr>
<td><strong>7.6 MB Free of 7.6 MB</strong></td>
</tr>
<tr>
<td>Memory Stick</td>
</tr>
<tr>
<td>Device 1ct</td>
</tr>
</tbody>
</table>

Attaching a name to a Memory Stick media

1. Rotate the Jog Dial™ navigator to select Card Info and press the Jog Dial navigator. Or tap the Card Info icon on the Application Launcher screen.

   The Card Info screen appears.

2. Tap the Menu icon.

3. Tap Rename Card.

   The Rename Card dialog box appears.

<table>
<thead>
<tr>
<th>Rename Card</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Card Name:</strong></td>
</tr>
<tr>
<td>MS</td>
</tr>
<tr>
<td>[Rename] [Cancel]</td>
</tr>
</tbody>
</table>

Continued on next page
Using Memory Stick® media

4 Enter a new name for the inserted Memory Stick media.

5 Tap Rename.

Formatting Memory Stick media

Commercially available Memory Stick media is already formatted and you can use it as soon as you buy it. Follow the procedures below if you need to format your Memory Stick media again:

1 Rotate the Jog Dial™ navigator to select MS Gate and press the Jog Dial navigator. Or tap the icon on the Application Launcher screen.

The Memory Stick Gate application starts up.

2 Tap the Menu icon.

The Menu screen appears.

3 Tap Options, and tap Format.

The confirmation message appears.

4 Tap OK.

Formatting starts.

Continued on next page
Using Memory Stick® media

To cancel formatting
Tap Cancel in step 3.

To format a Memory Stick media in the Card Info screen
You can also format a Memory Stick media by tapping the Menu icon on the Card Info screen, and selecting Format Card from the Card menu.

What is formatting?
Formatting defines the recording format for your Memory Stick media so that you can access data with your CLIÉ handheld.

Notes
• If formatted, all the data previously recorded in Memory Stick media will be erased. Make sure to check the data before formatting so that you do not delete important data.
• To use Memory Stick media on your CLIÉ handheld, format it in your CLIÉ handheld. You may not be able to write or read properly on Memory Stick media formatted by the computer.
• If you remove or insert Memory Stick media during initialization, your Memory Stick media is not recognized by your computer. In this case, remove Memory Stick media, reinsert it, and start formatting again.
Exchanging data via Memory Stick® media

Starting the Memory Stick® Gate (MS Gate) application

The Memory Stick Gate application allows you to copy, move, or delete data in Memory Stick® media and in your CLIÉ handheld.

Rotate the Jog Dial™ navigator to select MS Gate and press the Jog Dial navigator. Or tap the MS Gate icon on the Application Launcher screen.

The Memory Stick Gate application starts up and data lists appear on your CLIÉ handheld screen.

Tip

When the Memory Stick Gate application first recognizes the insertion of Memory Stick media, it automatically creates a default folder in the Memory Stick media. The “default folder” stands for the standard working folder where the Memory Stick Gate application reads and writes data. A folder named “PALM/PROGRAMS/MSFILES” is created in the inserted Memory Stick media.

When displaying the contents of your CLIÉ handheld

The currently opened folder on the Memory Stick media card.

Tap this icon to switch the view between your CLIÉ handheld and Memory Stick media.

Lock icon.

Tap here to switch the view.

size : File size
creator : Creator ID of the file
type : File type
version : Version of the file
none : no items displayed

Tap this icon to display or hide the contents.

Displays the files which belong to the same creator (ID) as one grouped item.

Tap this icon to sort in ascending or descending order.

Continued on next page
Exchanging data via Memory Stick® media

When displaying the contents of Memory Stick media
The following icons with explanations are displayed only when you view the contents of Memory Stick media. For the other icons, see “When displaying the contents of your CLIÉ handheld” (page 140).

- Tap this icon to display upper the folder.

- Tap this icon to display the contents of the folder.

Tap here to display “file name” to show the file name with PC file extensions.

Continued on next page
Exchanging data via Memory Stick® media

Notes on moving or copying data using the Memory Stick Gate application

In some cases when you move or copy a specific file using the Memory Stick Gate application, a CLIÉ application may not function properly. Sony is not liable for any trouble with applications or data that arises out of your deletion or moving of a file.

Do not move or delete the following files:

- Saved Preference: Saves the final operation status or settings for various applications.
- Unsaved Preference: Saves the settings of various applications or user information of your CLIÉ handheld. If this file is deleted, you may not be able to synchronize correct information.
- NetworkDB: Saves network settings. If this file is deleted, network connection is disabled.
- AddressDB: Saves the database for Address Book.*
- DatebookDB: Saves the database for Date Book.*
- MemoDB: Saves the database for Memo Pad.*
- MailDB: Saves the database for Mail.*
- ToDoDB: Saves the database for To Do List.*

*) These database files can be copied to Memory Stick media for back-up. If you copy them back to your CLIÉ handheld, the identical files in your CLIÉ handheld will be overwritten with the information at the time of back-up. Note that any added or edited data in your CLIÉ handheld after the back-up will be erased.
Exchanging data via Memory Stick® media

Copying your CLIÉ handheld data to Memory Stick media

The Memory Stick Gate application allows you to save data inside your CLIÉ handheld to Memory Stick media.

**Notes**

- Since data copying consumes a lot of power, you cannot use Memory Stick media when your CLIÉ handheld is short of battery power. Connect the AC adapter.
- If you receive infrared communication while copying data, the copying will be terminated. Do not allow infrared communication while copying data.

1. **Insert Memory Stick media into your CLIÉ handheld.**
   - The contents of the Memory Stick media are displayed.

2. **Tap the Home icon.**

3. **Rotate the Jog Dial navigator to select MS Gate and press the Jog Dial navigator.**
   - Or tap the MS Gate icon on the Application Launcher screen.
   - The Memory Stick Gate application starts. The data in your CLIÉ handheld is listed.

4. **Tap to select the data you want to copy to Memory Stick media.**
   - **Tip**
     - You can select multiple files.
   - **Note**
     - You cannot copy data marked with a lock icon.

Continued on next page
Exchanging data via Memory Stick® media

5  Tap COPY.
   The Copy File dialog box is displayed.

6  Tap OK.
   The data selected in step 4 is copied to the default folder ("/PALM/PROGRAMS/MSFILES") in Memory Stick media.

To copy all the data at once
Tap Select All in step 4.

To cancel the selection
• To cancel all the selections, tap Clear All.
• To clear only specific items, tap one selected item at a time.

To change the destination folder
Tap the arrow ▼ in the upper right corner to select MS from the drop-down list. The contents of Memory Stick media are listed.
Tap ◀ or ▶ to select the destination folder. The folder display changes and you can specify the destination folder.
You can only select a folder under the "PALM/PROGRAMS" or "PALM/Launcher" folder. The other folders cannot be selected as destination.

Moving your CLIÉ handheld data to Memory Stick media
If your CLIÉ handheld is running out of memory space, move the data from your CLIÉ handheld to Memory Stick media.

In step 5, tap Move.
The data on your CLIÉ handheld is deleted after being saved on Memory Stick media.

Note
When a low battery error message is displayed while you are copying or moving data from your CLIÉ handheld to Memory Stick media, data copying or moving may fail, leaving invalid files in the Memory Stick media. If this occurs, replace the batteries with new ones (PEG-SL10) or charge your CLIÉ handheld (PEG-SJ20/PEG-SJ30). Then try copying or moving again. If an overwrite confirm message appears, tap Yes or Yes to all.
Exchanging data via Memory Stick® media

Copying data in Memory Stick media to your CLIÉ handheld

**Note**
Make sure your CLIÉ handheld has enough space before copying.

1. **Insert Memory Stick media into your CLIÉ handheld.**
   The contents of the Memory Stick media are displayed.

2. **Tap the Home icon.**

3. **Rotate the Jog Dial navigator to select MS Gate and press the Jog Dial navigator.** Or tap the MS Gate icon on the Application Launcher screen.
   The Memory Stick Gate application starts. The data in your CLIÉ handheld is listed.

4. **Press the Jog Dial navigator to select MS.**
   You can also tap the arrow in the upper right corner to select MS from the drop-down list.

You can also select MS by tapping.

The data in the default folder (“/PALM/PROGRAMS/MSFILES”) in Memory Stick media is listed.

Continued on next page
Exchanging data via Memory Stick® media

5 Tap to select the data you want to copy to your CLIÉ handheld.
6 Tap COPY.
   The Copy File dialog box is displayed.
7 Tap OK.
   The data selected in step 5 is copied to your CLIÉ handheld.

To copy all the data at once
Tap Select All in step 5.

To cancel the selection
• To cancel all the selections, tap Clear All.
• To clear only specific items, tap one selected item at a time.

To change the folder to be copied
Tap or to select the folder that you want to copy. The folder display changes and you can specify a folder to be copied.
You can only select a folder under the “PALM/PROGRAMS” or “PALM/Launcher” folder. The other folders cannot be selected.

To rename the file or folder name
Select the file or folder that you want to rename, and tap the Menu icon.
Tap Rename in the Tools menu. Rename the file or folder in the following dialog box.

<table>
<thead>
<tr>
<th>Rename file</th>
</tr>
</thead>
<tbody>
<tr>
<td>AddressCompaniesDBPDB __________</td>
</tr>
<tr>
<td>OK</td>
</tr>
</tbody>
</table>

Note
You cannot rename a read-only file.
Exchanging data via Memory Stick® media

Moving data in Memory Stick media to your CLIÉ handheld
You can also move data from Memory Stick media to your CLIÉ handheld.

Tap MOVE in step 6.
The data in Memory Stick media is deleted after being saved in your CLIÉ handheld.

Notes
- Some data such as those copied from Memory Stick media to your CLIÉ handheld will not be backed up during the next HotSync® operation.
- A read-only file cannot be deleted. If you attempt to move a read-only file, it will be copied onto your CLIÉ handheld instead.
Exchanging data via Memory Stick® media

Deleting data in Memory Stick media

The Memory Stick Gate application allows you do delete unnecessary data from Memory Stick media.

1. Insert Memory Stick media in your CLIÉ handheld.  
The contents of the Memory Stick media are displayed.

2. Tap the Home icon.

3. Rotate the Jog Dial navigator to select MS Gate and press the Jog Dial navigator. Or tap the MS Gate icon on the Application Launcher screen.  
The Memory Stick Gate application starts. The data in your CLIÉ handheld is listed.

4. Press the Jog Dial navigator to select MS.  
You can also tap the arrow in the upper right corner to select MS from the drop-down list.

   ![Image showing Memory Stick Gate application]

   You can also select MS by tapping ▼.

The data in the “/PALM/PROGRAMS/MSFILES” folder of Memory Stick media is listed.

5. Tap to select the data that you want to delete.

6. Tap DELETE.  
The Delete File dialog box is displayed.

   ![Image showing Delete File dialog box]

   About to delete the selected file(s) from Memory Stick media.

   OK Cancel

   Continued on next page
Exchanging data via Memory Stick® media

7 Tap OK.
   The data selected in step 5 is deleted from Memory Stick media.

To delete all data at once
Tap Select All in step 5.

To cancel the selection
• To cancel all the selections, tap Clear All.
• To clear only specific items, tap one selected item at a time.

To change the folder to be deleted
Tap  or  to select the folder that you want to delete. The folder display changes and you can specify a folder to be deleted.
You can only select a folder under the “PALM/PROGRAMS” or “PALM/ Launcher” folder. The other folders cannot be selected.

Note
You cannot delete a read-only file.
Exchanging data via Memory Stick® media

Using the Memory Stick Gate menus

Memory Stick Gate menu commands allow you to exchange data between your CLIÉ handheld and Memory Stick media.

Tools menus
The menu items differ depending on the screen being displayed.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select All</td>
<td>Selects all the data displayed in the selected tab.</td>
</tr>
<tr>
<td>Clear All</td>
<td>Cancels the selection of the data.</td>
</tr>
<tr>
<td>Move</td>
<td>Moves the selected data to your CLIÉ handheld or Memory Stick media. The Move File screen appears.</td>
</tr>
<tr>
<td>Copy</td>
<td>Copies the selected data to your CLIÉ handheld or Memory Stick media. The Copy File screen appears.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected data from your CLIÉ handheld or Memory Stick media. The Delete File screen appears.</td>
</tr>
<tr>
<td>Rename</td>
<td>Changes the name of the selected file or folder of Memory Stick media.</td>
</tr>
<tr>
<td>Create Folder</td>
<td>Creates a folder in the current folder.</td>
</tr>
<tr>
<td>Create Default Folder</td>
<td>Creates the default folder (“/PALM/PROGRAMS/ MSFILES“) in Memory Stick media.</td>
</tr>
<tr>
<td>Change to Default Folder</td>
<td>Changes the current folder to default folder.</td>
</tr>
</tbody>
</table>

Options menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td>Formats Memory Stick media inserted in your CLIÉ handheld.</td>
</tr>
<tr>
<td>Media Information</td>
<td>Displays the memory information of Memory Stick media.</td>
</tr>
<tr>
<td>About MS Gate</td>
<td>Shows the version information for Memory Stick Gate.</td>
</tr>
</tbody>
</table>
You can copy and install applications to/from a Memory Stick media from/to your CLIÉ handheld from the Application Launcher screen. However, observe the following as malfunction may occur depending on the application.

- You can only copy application files (files with extensions such as .prc, .pdb) using the following procedure. Related files will not be copied together at the same time.
- Data stored in the Memory Stick media (such as image files) will not be displayed.

1. Insert the Memory Stick media into the Memory Stick slot of your CLIÉ handheld.
   The contents of Memory Stick media are displayed.

2. Tap the Menu icon on your CLIÉ handheld.

3. Tap Copy from the drop-down list.
   The Copy dialog box appears.

4. Tap the arrow next to Copy To, and select Handheld or Card.

5. Tap the arrow next to From, and select Card or Handheld.

6. Tap the application you want to install.

7. Tap Copy.
   The selected application is installed on your CLIÉ handheld or Memory Stick media.

**Tip**
You do not have to install add-on applications on your CLIÉ handheld in order to use them. If you want to save the CLIÉ handheld’s memory space, you can simply select the card category in the Application Launcher screen and tap on the application icon. (Note, that such applications can only be used while the Memory Stick media containing the application is inserted in the CLIÉ handheld).
Exchanging data via Memory Stick® media

Notes on starting applications installed to/from the Memory Stick media (without using the Memory Stick Gate application)

Observe the following when starting applications that were installed to/from a Memory Stick media not by using the Memory Stick Gate application, but by using a HotSync operation or by copying the applications from the Application Launcher screen.

• You can only start application files (files with extensions such as .prc, .pdb). Image files and movie files that come with the application cannot be started (played).

If you cannot start the installed file data, move the file data to the CLIÉ handheld using the Memory Stick Gate application, or delete the files. If you do not use the Memory Stick Gate application when installing, applications and data files are stored in the “PALM/Launcher” folder.
Chapter 5

Customizing your Sony CLIÉ Handheld (Preferences)

This chapter describes how to customize your CLIÉ handheld by changing the Preferences settings.

Contents

- What you can do with Preferences ........................................ 154
- Changing the Buttons preferences ........................................ 156
  - Assigning applications to buttons .................................... 156
  - Changing the full-screen pen stroke activities .................... 157
  - Assigning applications to HotSync® buttons ....................... 158
- Changing the Jog Dial™ navigator preferences ....................... 159
- Setting the display format of the time, date, and numbers (Formats) ........................................ 160
  - Selecting a region default .............................................. 160
  - Selecting the time, date, and numbers formats .................. 161
- Setting the Date & Time preferences ................................... 162
  - Setting the date .......................................................... 162
  - Setting the time .......................................................... 163
  - Setting the time zone and daylight saving time ................. 164
- Setting the General preferences ...................................... 165
  - Setting the automatic shut-off time .................................. 165
  - Setting sounds ............................................................ 166
  - Turning the Alarm LED on or off (PEG-SJ20/PEG-SJ30) ....... 167
  - Turning the Beam Receive feature on or off ....................... 168
- Entering owner information ................................................ 169
- Creating Graffiti® ShortCuts ............................................. 170
- Changing the Network preferences ................................... 172
  - Selecting a service ....................................................... 172
  - Entering a user name .................................................... 173
  - Entering a password ..................................................... 173
  - Selecting a connection ................................................. 174
  - Adding telephone settings ............................................ 174
  - Creating additional service templates ................................ 175
  - Adding detailed information to a service template ............ 177
  - Creating log in scripts ................................................. 178
  - Using the Network preferences menus ............................ 181
- Setting the High Resolution Assist function ......................... 182
What you can do with Preferences

The Preferences screen enables you to customize the configuration options on your CLIÉ handheld.

• **Buttons**
  Assign different applications to the buttons on the front panel of your CLIÉ handheld and the HotSync® button on the cradle (not supplied), and reassign the full-screen pen stroke command.

• **Connection**
  Configure serial, modem, and infrared communication settings.

• **Date & Time**
  Set the current date and time, the time zone of your present area, and turn on/off the daylight saving.

• **Digitizer**
  Calibrate the screen on your CLIÉ handheld. The same digitizer calibration screen is displayed when you start your CLIÉ handheld for the first time. You can recalibrate your screen after a hard reset or if you find that “tapping” does not work as expected. For details, see “Step 2: Turning on your Sony CLIÉ Handheld for the first time” in the Read This First manual.

• **Formats**
  Set the region default and the formats for dates, times, calendar, and numbers.

• **General**
  Set the auto shut-off interval, system sound, alarm sound, alarm LED feature (PEG-SJ20/PEG-SJ30 only), game sound, and the Beam Receive feature.

• **HiRes**
  Set the High Resolution Assist feature.

• **Jog**
  Enable or disable the JogAssist feature.

• **Network**
  Configure your CLIÉ handheld for use with a network.

• **Owner**
  Assign your name, phone number, and other owner information.

• **ShortCuts**
  Define a list of Graffiti® abbreviations.

• **Web Clipping**
  Configure Internet connection and proxy server settings.
What you can do with Preferences

Viewing Preference

1. Rotate the Jog Dial™ navigator to select Prefs and press the Jog Dial navigator. Or tap the Prefs icon on the Application Launcher screen.

The Preferences screen appears.

2. Tap the arrow ▼ in the upper right corner of the screen and select the Preferences screen you want to view from the drop-down list.
Assigning applications to buttons

The Buttons Preferences screen enables you to assign different applications to the buttons on the front panel of your CLIÉ handheld. For example, you can assign the To Do List button to start Date Book.

1. Tap Buttons from the drop-down list on the Preferences screen. The Buttons Preferences screen is displayed.

2. Tap the arrow ▼ next to a button and tap the application that you want to assign to the button.

To launch the original applications
When you have assigned another application to the button, you can start the original application using the Application Launcher.

To reset to the default settings
Tap Default in step 2. All application buttons are reset to their factory settings.
Changing the Buttons preferences

Changing the full-screen pen stroke activities

The Buttons Preferences screen enables you to change the assignment of the full-screen pen stroke. By default, the full-screen pen stroke activates the Graffiti® Help.

1. Tap Buttons from the drop-down list on the Preferences screen. The Buttons Preferences screen is displayed.

2. Tap Pen.

3. Tap the arrow ▼ and select one of the following settings for the full-screen pen stroke.

   - **Backlight**: Turns on the backlight of your CLIÉ handheld without using the POWER button.
   - **Brightness (PEG-SJ30 only)**: Opens the brightness adjustment screen.
   - **Keyboard**: Opens the onscreen keyboard for entering text.
   - **Graffiti Help**: Opens a series of screens that show the complete Graffiti character set.
   - **Turn Off & Lock**: Turns off and locks your CLIÉ handheld. To lock your CLIÉ handheld, assign a password. When locked, you need to enter the password to use your CLIÉ handheld.
   - **Beam Data**: Beams the current record to another Palm OS® PDA.

4. Tap OK.

Drag the stylus from the bottom of the writing area to the top on the screen.
Assigning applications to HotSync® buttons

The Buttons Preferences screen also enables you to assign different applications to the HotSync® buttons on the cradle (not supplied) and the modem (if a HotSync button is equipped).

1. Tap Buttons from the drop-down list on the Preferences screen.
   The Buttons Preferences screen is displayed.

2. Tap HotSync.
   The HotSync Buttons dialog box appears.

3. Tap the arrow ▼ next to each button and select the application you want to assign to the button.
   The HotSync button assignment is changed.

4. Tap OK.
   Any changes that you make in the HotSync Buttons screen become effective immediately. You can activate the selected application by pressing the HotSync button.
Changing the Jog Dial™ navigator preferences

The Jog Preferences screen enables you to change the default Jog Dial™ navigator and BACK button functions, which are:

- Scroll the screen with the Jog Dial navigator.
- Select an item from a pop-up list with the Jog Dial navigator.
- Move back and forth between screens with the BACK button.

You can set the Jog Dial navigator to operate a third-party application that is not designed to use Jog Dial navigator operations (JogAssist feature). You can also change the BACK button function so your CLIÉ handheld turns on or off when the BACK button is pressed/kept pressed.

**Notes**

- The functions activated by the JogAssist feature differ depending on the application you use.
- In some applications with the Jog Dial navigator mark, part of functions may change when the JogAssist feature is activated.

1. Tap Jog from the drop-down list on the Preferences screen. The Jog Preferences screen is displayed.

2. To enable the JogAssist function, select Use JogAssist. The Jog Dial navigator functions change.

3. In order to set to turn on the power by pressing the BACK button, select Power On with BACK button. You need to keep the BACK button pressed for a several seconds to turn on the power.

4. To set to turn off the power by keeping the BACK button pressed, select Power Off. Display Cursor/Menu is selected by default (✓). You can display the cursor or menu by keeping the BACK button pressed.
Setting the display format of the time, date, and numbers (Formats)

The Formats Preferences screen enables you to set the region default, and the display format of dates, times, and numbers on your CLIÉ handheld.

Selecting a region default

When you select the region where you use your CLIÉ handheld, the display format of the time, date, the week start day, and numbers is adjusted. For example, in England, time is expressed using a 24-hour clock; in the United States, time is expressed using a 12-hour clock with an AM or PM suffix. All your CLIÉ applications use the region default settings. However, you can customize your own settings for time, date, week start day, or numbers.

1. Tap Formats from the drop-down list on the Preferences screen.

The Formats Preferences screen is displayed.

2. Tap the arrow ▼ next to “Preset to” and select a region name.

3. Tap OK.
Setting the display format of the time, date, and numbers (Formats)

Selecting the time, date, and numbers formats

You can select the desired formats for the time, date, week start day, and numbers. The selected formats apply to all your CLIÉ applications.

1. On the Formats Preferences screen, tap the arrow ▼ next to Time and select the desired format from the drop-down list.

2. Tap the arrow ▼ next to Date and select the desired format from the drop-down list.

3. Tap the arrow ▼ next to “Week starts” and select whether you want the first day of the week to be Sunday or Monday. This setting controls the Day, Week, Month, and Agenda views in Date Book and all other aspects of your CLIÉ handheld that display a calendar.

4. Tap the arrow ▼ next to Numbers and select formats for the decimal point and thousands separator.
Setting the Date & Time preferences

The Date & Time Preferences screen enables you to set the date, time, time zone, and the on/off of daylight savings for your CLIÉ handheld. After you set the local date and time of your home base, you can change the displayed time (for example, during business trips) by simply switching the time zones.

Setting the Date

1. Tap Date & Time from the drop-down list on the Preferences screen.
   The Date & Time Preferences screen is displayed.

   ![Preferences Screen]

2. Tap Set Date.
   The Set Date screen appears.

   ![Set Date Screen]

3. Tap the arrow ◀ or ▶ beside the year at the top of the screen to set the year.
4. Tap the current month.
5. Tap the current date.
Setting the Date & Time preferences

Setting the time

1. Tap Date & Time from the drop-down list on the Preferences screen.
   The Date & Time Preferences screen is displayed.

2. Tap Set Time.
   The Set Time screen appears.

3. Tap the arrow ▼ or ▲ to set the hour.

4. Tap the minute box and tap the arrow ▼ or ▲ to set the minute.

5. Tap AM or PM.

6. Tap OK.
Setting the Date & Time preferences

Setting the time zone and daylight saving time

Setting the time zone

1. Tap Date & Time from the drop-down list on the Preferences screen.
   The Date & Time Preferences screen is displayed.
2. Tap the Set Time Zone field.
   The Set Time Zone screen appears.
3. Select the time zone that corresponds to where you are.
4. Tap OK.

Setting the daylight saving time

1. Tap Date & Time from the drop-down list on the Preferences screen.
   The Date & Time Preferences screen is displayed.
2. Tap the arrow ▼ next to Daylight saving.
3. Tap and select On or Off.
Setting the General preferences

The General Preferences screen enables you to set the auto shut-off interval, alarm options and sounds for your CLIÉ handheld.

Setting the automatic shut-off time

Your CLIÉ handheld has an automatic shut-off feature that turns off the power after a period of inactivity. This feature helps conserve battery power in case you forget to turn off your CLIÉ handheld. If you find that your CLIÉ handheld shuts itself off too early or too late, you can increase or decrease the time setting for the automatic shut-off feature.

By default, your CLIÉ handheld will turn off after two minutes of inactivity.

1. Tap General from the drop-down list on the Preferences screen.
   The General Preferences screen is displayed.

2. Tap the arrow ▼ next to Auto-off After and select the desired time setting for the automatic shut-off feature.
   You can select 30 seconds, 1 minute, 2 minutes, or 3 minutes.

If you want your CLIÉ handheld to stay ON while it is connected to the cradle (not supplied) or the plug adapter (PEG-SJ20/PEG-SJ30 only)

Make sure that the check box next to “Stay on in Cradle” is selected. To have it turn off automatically, clear the check box.
Setting the General preferences

Setting sounds

Your CLIÉ handheld uses a variety of sounds. The System, Alarm, and Game Sound settings enable you to turn the sounds on or off, and to adjust the volume level.

1. Tap General from the drop-down list on the Preferences screen.
   The General Preferences screen is displayed.

2. Tap the arrow ▼ next to System Sound and select the desired sound level or Off from the drop-down list.
   When you turn the System Sound off, you also turn off the “chime” tones associated with the HotSync® operation.

3. Tap the arrow ▼ next to Alarm Sound and select the desired sound level from the drop-down list.

4. Tap the arrow ▼ next to Game Sound and select the desired sound level or Off from the drop-down list.
   The Game Sound setting works only with the games that are programmed to respond to this setting.
Setting the General preferences

Turning the Alarm LED on or off (PEG-SJ20/PEG-SJ30)

You can set the CLIÉ handheld to flash its LED at the set time. If you turn the Alarm Sound off and turn on the Alarm LED, you can make use of the CLIÉ handheld’s alarm feature without disturbing other people around you.

1. Tap General from the drop-down list on the Preferences screen.
   The General Preferences screen is displayed.

2. Tap the arrow ▼ next to Alarm LED and select On or Off from the drop-down list.

   ![Preferences Screen]

   - **On**: Enables the Alarm LED feature
   - **Off**: Disables the Alarm LED feature
Setting the General preferences

Turning the Beam Receive feature on or off

The Beam Receive is set to On, by default. You can turn off the Beam Receive feature to prohibit anyone from beaming information to your CLIÉ handheld, and to slightly save in battery power.

1. Tap General from the drop-down list on the Preferences screen.
   The General Preferences screen is displayed.

2. Tap the arrow ▼ next to Beam Receive and select On or Off from the drop-down list.

   • **On**: Enables the Beam Receive feature.
   • **Off**: Disables the Beam Receive feature.
Entering owner information

The Owner Preferences screen enables you to record a name, company name, phone number, or any other information that you want to associate with your CLIÉ handheld.

If you use the Security application to lock your CLIÉ handheld with a password, the information that you enter in the Owner Preferences screen appears the next time you turn on your CLIÉ handheld.

1. Tap Owner from the drop-down list on the Preferences screen.
   The Owner Preferences screen is displayed.

2. Enter your owner information.
   If you enter more text than can fit on one screen, a scroll bar appears at the right side of the screen.

To unlock the Owner Preferences screen

If you assigned a password in the Security application, the information in the Owner Preferences screen cannot be changed. In this case, an Unlock button is displayed at the bottom of the screen.

1. Tap Unlock.
   The Unlock Message dialog box appears.

2. Enter your current password (the one you entered in the Security application) and tap OK.
Creating Graffiti® ShortCuts

The ShortCuts Preferences screen enables you to define abbreviations (ShortCuts) for entering text with Graffiti® strokes. You can create a ShortCut for any words, letters, or numbers. All ShortCuts you create appear on the list in the ShortCut Preferences screen. All the ShortCuts are available in any of your CLIÉ applications and are backed up on your computer when you perform a HotSync® operation. See “Using Graffiti® writing to enter data” on page 12 for more information on the use of ShortCuts.

1. Tap ShortCut from the drop-down list on the Preferences screen.

   The ShortCut Preferences screen is displayed.

2. Tap New.

   The ShortCut Entry screen is displayed.

3. On the ShortCut Name line, enter the letters you want to use to activate the ShortCut.

4. Tap the ShortCut Text area and enter the text that you want to appear when you write the ShortCut characters.

5. Tap OK.

   Continued on next page
Creating Graffiti® ShortCuts

**To Edit a ShortCut**

1. Tap the ShortCut you want to edit in the ShortCuts list and tap Edit.

2. Make the changes you want and tap OK.

**To Delete a ShortCut**

If you no longer need a ShortCut, you can delete it from the list of ShortCuts.

1. Tap the ShortCut you want to delete in the ShortCuts list and tap Delete.
   
   The confirmation dialog box is displayed.

2. Tap Yes.
In order to use your CLIÉ handheld with a network (such as using the Web Clipping application or performing a network HotSync® operation), you must set the Network Preferences settings.

**Note**

The Network preferences settings provides the ability to connect to your ISP (Internet Service Provider) or dial-in (remote access) server with applications (e.g. Web Clipping) that allow you to view the transmitted data.

---

## Selecting a service

Use the Service setting to select the service template for your Internet Service Provider or a dial-in server. Service templates are a set of ISP and dial-in server configuration settings that you can create, save, and reuse.

1. Tap Network from the drop-down list on the Preferences screen.
   The Network Preferences screen is displayed.

   ![Network Preferences Screen](image)

   - **Service**: AT&T WorldNet
   - **User Name**: username@world
   - **Password**: --Prompt--
   - **Connection**: Standard/Modern
   - **Phone**: Tap to enter phone

2. Tap the arrow ▼ next to Service and select the predefined service template you want to use.
Changing the Network preferences

Entering a user name

The User Name setting identifies the name you use when you log into your Internet Service Provider or your dial-in server.

1. On the Network Preferences screen, tap User Name field.
2. Enter your user name.

Notes
• Although this field can contain multiple lines of text, only two lines appear onscreen.
• Most dial-in servers do not accept spaces in the user name.

Entering a password

The Password box identifies the password you use to log into your server or ISP. Your entry in this field determines whether your CLIÉ handheld prompts you to enter a password each time you log into your network:

• If you do not enter a password, your CLIÉ handheld displays the word “-Prompt-” in this field and asks you to enter a password during the log in procedure.
• If you enter a password, your CLIÉ handheld displays the word “-Assigned-” in this field and does not prompt you to enter a password during the login procedure.

Note
If you are concerned about security, select the Prompt option and do not enter a password.

1. On the Network Preferences screen, tap the Password field.
2. Enter the password you use to log into your server.
3. Tap OK.
   The Password field updates to display the word “-Assigned-.”
Changing the Network preferences

Selecting a connection

Use the Connection setting to select the method you want to use to connect to your Internet Service Provider or a dial-in server.

On the Network Preferences screen, tap the arrow ▼ next to Connection and select Standard Modem.

Adding telephone settings

When you select the Phone field, your CLIÉ handheld opens a dialog box in which you define the telephone number you use to connect with your ISP or dial-in server. In addition, you can also define a prefix, disable Call Waiting, and give special instructions for using a calling card.

Note
The Phone Setup dialog box works correctly for AT&T and Sprint long-distance services. However, because MCI works differently, MCI customers need to put the calling card number in the Phone # field and the phone number in the Use calling card field.

1. On the Network Preferences screen, tap the Phone field.
   The Phone Setup screen appears.
2. Enter the phone number for your ISP or dial-in server in the Phone# field.
3. Change the following settings if necessary:
   ① Enter the telephone number used to access the modem.
      If necessary, enter a dial prefix (such as “9”) to access an outside line, and tap the Dial prefix check box. You can enter a comma in the field to introduce a “pause” in the dialing sequence. Each comma equals a two second pause.

Continued on next page
Changing the Network preferences

2 If the phone line you are using for your CLIÉ handheld has Call Waiting, select the “Disable call waiting” check box to avoid an interruption during a modem HotSync® operation or accessing a Web Clipping site.

**Note**
Each telephone company assigns a code to disable Call Waiting. Contact your local telephone company for the code that is appropriate for you.

3 If you want to use a calling card to place the call, select the “Use calling card” check box and enter the calling card number.

**Tip**
There is usually a delay before you enter your calling card number. Consequently, add at least three commas before your calling card number to compensate for the cue delay.

4 Tap OK.

Creating additional service templates

You can create additional service templates from scratch or by duplicating existing templates and editing the information. After you create a new or duplicate template, you can add and edit settings.

**To add a new service template**

1 On the Network Preferences screen, tap the Menu icon.

2 Tap New from the Service menu.
   An Untitled service template is added to the drop-down list for the Service field.
Changing the Network preferences

To duplicate an existing service template

1. On the Network Preferences screen, tap the arrow ▼ next to Service and select the predefined service template you want to duplicate.

2. Tap the Menu icon.

3. Tap Duplicate from the Service menu.
   A copy of the service template is added to the drop-down list for the Service field.

To delete a service template

1. On the Network Preferences screen, tap the arrow ▼ next to Service and select the predefined service template you want to delete.

2. Tap the Menu icon.

3. Tap Delete from the Service menu.
   The Delete Service dialog box is displayed.

4. Tap OK.
   The selected service template is deleted.
Adding detailed information to a service template

If you are using one of the predefined service templates, you probably only need to enter your user name and telephone number. If you are creating a new service template, you may need to provide additional information to your ISP or dial-in server. You use the Details dialog box to add additional information to a selected service template.

To select a connection type

1. On the Network Preferences screen, tap the service field.
2. Tap Details.
   The Details screen is displayed.
3. Tap the arrow ▼ next to Connection type and select one of the following connection types.
   • **PPP**: Point-to-Point protocol
   • **SLIP**: Serial Line Internet Protocol
   • **CSLIP**: Compressed Serial Line Internet Protocol

   **Tip**
   If you are not sure, try PPP; if that doesn’t work, ask your Internet Service Provider or your System Administrator for the correct connection type.

4. Tap the arrow ▼ next to Idle timeout and select one of the following options.
   • **1 minute**: Waits one minute for you to open another application before it drops the connection.
   • **2 minutes**: Waits two minutes.
   • **3 minutes**: Waits three minutes.
   • **Never**: Keeps your PPP or SLIP connection until you turn off your CLIÉ handheld (or until it times out). Note that this option will be more costly than others.

5. Tap the Query DNS check box to deselect it.
Changing the Network preferences

6 Enter the IP address for the Primary and Secondary DNS (Domain Naming System).
Ask your Internet Service Provider or System Administrator for the correct Primary or Secondary DNS IP numbers.

7 If you need to enter the CLIÉ handheld’s IP Address, tap the IP Address check box to deselect it and display a permanent IP address field below the check box.
Normally, you do not have to enter this IP address. If you are not sure, select Automatic and go to step 9.

8 Enter the CLIÉ handheld’s IP Address.
9 Tap OK.

Creating log in scripts

A log in script is a series of commands that automates logging in to a network server, such as your corporate network or your Internet Service Provider (ISP). A log in script is something that you are likely to receive from your IS System Administrator, if your company has a system in which you log in to the corporate servers from your CLIÉ handheld using a modem or network connection.

Note
You can also use non-ASCII and literal characters in your log in script. For more information, see page 180.

1 On the Network Preferences screen, tap the service field.
2 Tap Details.
The Details screen is displayed.
3 Tap Script.
The Log in Script screen is displayed.
Changing the Network preferences

4 Tap the arrow ▼ next to End and select one of the following commands. If the command requires additional information, a field appears to the right of it for you to enter the information.

- **Wait For**: Tells your CLIÉ handheld to wait for specific characters from the TCP/IP server before executing the next command.
- **Wait For Prompt**: Detects a challenge-response prompt coming from the server and displays the dynamically generated challenge value. You then enter the challenge value into your token card, which in turn generates a response value for you to enter on your CLIÉ handheld. This command takes two arguments, separated by a vertical bar (|) on the input line.
- **Send**: Transmits specific characters to the TCP/IP server to which you are connecting.
- **Send CR**: Transmits a carriage return or LF character to the TCP/IP server to which you are connecting.
- **Send User ID**: Transmits the User ID information entered in the User ID field of the Network Preferences screen.
- **Send Password**: Transmits the password entered in the Password field of the Network Preferences screen. If you did not enter a password, this command prompts you to enter one. The Password command is usually followed by a Send CR command.
- **Delay**: Tells your CLIÉ handheld to wait a specific number of seconds before executing the next command in the login script.
- **Get IP**: Reads an IP address and uses it as the IP address for your CLIÉ handheld. This command is used with SLIP connections.
- **Prompt**: Opens a dialog box and prompts you to enter text of some kind (for example, a password or a security code).
- **End**: Identifies the last line in the log in script.

5 Repeat step 4 until the log in script is complete.

6 Tap OK.

7 Tap OK.
Non-ASCII Characters for Log in Scripts

The following information enables you to create custom log in scripts that require non-ASCII characters. It is provided for advanced users who understand the use and requirements of such characters in a custom log in script.

Use of ^char

You may use the caret ( ^ ) to transmit ASCII command characters. If you send ^char, and the ASCII value of char is between @ and _, then the character is automatically translated to a single-byte value between 0 and 31. For example, ^M is converted to a carriage return.

If char is a value between a and z, then the character sequence is translated to a single-byte value between 1 and 26. If char is any other value, then the character sequence is not subject to any special processing. For example, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage return and line feed

You may include carriage return and line feed commands as part of the log in script, when entered in the following format.

• <cr>: Sends or receives a carriage return
• <lf>: Sends or receives a line feed

For example, the string “waitfor Joe<cr><lf>” waits to receive Joe followed by a carriage return and line feed from the remote computer before executing the next command in the script.

Literal characters

The backslash ( \ ) character defines that the next character is transmitted as a literal character, and is not subject to any special processing ordinarily associated with that character.

Examples:
• \^: Includes a caret as part of the string
• \<: Includes a < as part of the string
• \\: Includes a backslash as part of the string

Changing the Network preferences
Changing the Network preferences

Using the Network preferences menus

This section describes the menu commands specific to network preferences. For the Edit menu, see “Using the Edit menu” on page 99.

Service menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Creates a new service template.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the current service template. The Delete Service dialog box appears.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Duplicates the current service template.</td>
</tr>
</tbody>
</table>

Options menus

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Log</td>
<td>Displays the Network Log. The Network Log lists all of the communication that occurs between your modem and your dial-in server during the log in procedure. The information in the Network Log can help your ISP or your System Administrator pinpoint where the log in procedure communication fails and why.</td>
</tr>
</tbody>
</table>
Setting the High Resolution Assist function

The High Resolution Assist function enables the high resolution display of an application that does not support the high resolution mode.

1. Tap HiRes from the drop-down list on the Preferences screen. The HiRes Preferences screen is displayed.

2. To enable the High Resolution Assist function, select Enable High Resolution Assist. The confirmation dialog box is displayed.

3. Tap OK.

4. Select the application(s) that you do not want to display in high resolution mode in the list box.

Note

In step 4, check an application when the following occurs in the high resolution mode:
- Performances are largely deteriorated (e.g. game).
- Display is divided into two, characters are distorted, or other operational irregularities occur.
Chapter 6

Additional information

This chapter covers the following topics: backing up data of your CLIÉ handheld, transferring data from one CLIÉ handheld to another, precautions taken when using your CLIÉ handheld, troubleshooting your CLIÉ handheld, and other technical information about your CLIÉ handheld.

Contents

Backing up data of your Sony CLIÉ Handheld ......................... 184
   Backing up data to your computer through
      a HotSync® operation ....................................................... 184
   Backing up all CLIÉ data to a Memory Stick® media
      (using the Memory Stick Backup application) ..................... 185
   Backing up CLIÉ handheld data to a Memory Stick media
      using the Memory Stick Gate application ........................... 187

Using data of another Sony CLIÉ Handheld ............................. 189
   Using the Palm™ Desktop for CLIÉ software
      to transfer data .................................................................. 189
   Using Memory Stick® media to transfer data ..................... 191
   Performing a HotSync® operation between
      your old CLIÉ handheld and the new
      Palm Desktop for CLIÉ software ...................................... 193

Precautions ............................................................................. 194
   Notes on use ..................................................................... 194
   Battery considerations (PEG-SL10) ..................................... 195
   Battery considerations (PEG-SJ20/PEG-SJ30) ...................... 198

Troubleshooting – Frequently Asked Questions ...................... 200
   If you still cannot perform a HotSync® operation .............. 213

Getting Help ............................................................................ 214

Specifications .......................................................................... 215

Index ....................................................................................... 217
Backing up data of your Sony CLIÉ Handheld

You can save a back-up copy of your CLIÉ handheld by performing either of the following three methods:
• Backing up data to your computer through HotSync® operation
• Backing up all data to a Memory Stick® media using the Memory Stick Backup application
• Backing up data to a Memory Stick® media using the Memory Stick Gate application

Backing up data to your computer through a HotSync® operation

By default, you can back-up the following data in your computer with a HotSync operation:
• Memo Pad data files
• Address Book data files
• To Do List data files
• Date Book data files
• Preferences data files
• Network Setup information
• Applications files that have been installed using a HotSync operation
• User information files when you perform a HotSync operation

During the next HotSync operation, the back-up data is compared with the data in your computer, and the newer one becomes effective. If you perform a hard reset, all records and entries stored in your CLIÉ handheld are erased and reset to the initial status. If you save a back-up of your CLIÉ handheld data, you can restore any data previously synchronized with your computer during the next HotSync operation.

Notes
• Some applications are not designed to be backed up. Therefore, you may not be able to restore some applications and data. It is recommended that you re-install those applications.
• If you change settings in the Change HotSync Action dialog box, you may not be able to save a back-up. You cannot back-up an application or restore its data if you select an option other than “Synchronize the files.” For details, see “Customizing HotSync application settings (Conduit)” on page 109.
Backing up data of your Sony CLIÉ Handheld

Backing up all CLIÉ data to a Memory Stick® media (using the Memory Stick Backup application)

With the Memory Stick Backup application, you can back-up all the following CLIÉ handheld application and data to a Memory Stick media with a single tap.

To separately back-up applications and data to the Memory Stick media, use the Memory Stick Gate application (see page 187).

• Memo Pad data files
• Address Book data files
• To Do List data files
• Date Book data files
• Preferences data files
• Network Setup information
• Applications files that have been installed using a HotSync operation
• User information files when you perform a HotSync operation

Backing up data with the Memory Stick Backup application

Note

When you back-up your CLIÉ data on a Memory Stick media, the data size of the back-up may become larger than the total data size displayed in the Memory Stick Gate application. This is not a malfunction. Make sure you have more space free on the Memory Stick media than the displayed CLIÉ handheld data size before performing a back-up.

Do not perform a backup when available memory of your CLIÉ handheld is low. If you do, you will not be able to restore the back-up data to your CLIÉ handheld.

1 Insert a Memory Stick media into the Memory Stick slot.
2 Tap the Home icon.
3 Rotate the Jog Dial navigator to select MS Backup and press the Jog Dial navigator. Or tap the MS Backup icon on the Application Launcher screen.

The Memory Stick Backup application starts up and the back-up list appears.
Backing up data of your Sony CLIÉ Handheld

4 Tap  (Backup).
   
The Backup All Files dialog box appears.

5 Tap OK.
   
The Backup Progress screen appears, and general information of the back-up (its date, size, and number of contents) appears in the list.

Note
Do not make any changes to the directory tree on the Memory Stick after performing a back-up. If you do, you will not be able to restore the back-up data to your CLIÉ handheld.

Tips
• In most cases, the back-up will be finished within approximately a minute.
• In step 4, you can also select an existing file from the back-up list, then tap Backup to overwrite it.

To delete back-up files from the Memory Stick media
Tap to select the back-up in the Backup list, and tap Delete. The selected file is deleted from the Memory Stick media.

Restoring back-up data and applications to your CLIÉ handheld

Notes
• When you restore back-up data and applications to your CLIÉ handheld, the data currently saved in your CLIÉ handheld will be overwritten with the back-up data. Any data created or edited after you saved the back-up will be erased.
• You can only restore data to the CLIÉ handheld from which you took that back-up.

1 Perform a hard reset on your CLIÉ handheld.
   
   For details, refer to “Performing a hard reset” on page 26.

2 Insert the Memory Stick media with the back-up files into the Memory Stick slot.

3 Tap the Home  icon.

4 Rotate the Jog Dial navigator to select MS Backup and press the Jog Dial navigator. Or tap the MS Backup  icon on the Application Launcher screen.
   
The Memory Stick Backup application starts up and the back-up list appears.
Backing up data of your Sony CLIÉ Handheld

5 In the Memory Stick Backup screen, tap to select the back-up data that you want to restore from the list.

6 Tap (Restore).

The Restore Confirm dialog box appears.

7 Tap OK.

After the back-up data is restored, the CLIÉ handheld automatically shuts itself down and restarts.

Backing up CLIÉ handheld data to a Memory Stick media using the Memory Stick Gate application

The Memory Stick Gate application allows you to save a back-up of the following data of your CLIÉ handheld to Memory Stick media. (The file name after the colon is the name displayed in the Memory Stick Gate application.)

- Address Book data files: AddressDB/Image Viewer Address Link
- Date Book data files: DatebookDB
- Memo Pad data files: MemoDB
- To Do List data files: ToDoDB
- Network setup information: NetworkDB
- Other application setting data files: SavedPreferences
- User information and other preferences data files: UnsavedPreferences

For details on how to use the Memory Stick Gate application, see “Copying your CLIÉ handheld data to Memory Stick media” on page 143.

Notes
- Applications may not function properly if the necessary files are not backed up.
- Do not select Graffiti® ShortCuts, Net Prefs, and files, since they cannot be copied.
- You cannot copy data marked with a lock icon.
- You may not be able to back up full information since some data is locked or shared.
Backing up data of your Sony CLIÉ Handheld

Restoring back-up data and applications to your CLIÉ handheld

**Note**

When you restore (copy) back-up data and applications to your CLIÉ handheld, the data currently saved in your CLIÉ handheld will be overwritten with the back-up data. Any data created or edited after you saved the back-up will be erased.

Insert Memory Stick media storing the back-up data into your CLIÉ handheld and use the Memory Stick Gate application to copy the data to your CLIÉ handheld. For details, see “Copying data in Memory Stick media to your CLIÉ handheld” on page 145.

If an overwrite confirm message is displayed, tap Yes to all.

**Notes**

- If a delete or access error message is displayed while copying files, tap OK to proceed to the next step in copying. Those files, however, will not be copied.
- Depending on the application configurations or file protection status, some necessary files may not be copied. In such a case, an application may not function properly.
- Some applications are not designed to be backed up. Therefore, you may not be able to restore some applications and data. It is recommended that you re-install those applications.
Using data of another Sony CLIÉ Handheld

If you already own a Sony CLIÉ Handheld, you can use data of your old CLIÉ handheld with your new CLIÉ handheld. You can transfer data from your old CLIÉ handheld to your new CLIÉ handheld with either of the following methods:

• **Using Palm™ Desktop for CLIÉ to copy data:** You can transfer data of the Palm OS basic applications easily.

• **Using Memory Stick® media to copy data:** You can transfer all the necessary data and settings information more securely than using the Palm Desktop for CLIÉ software.

**Note on add-on applications that you have installed**
Install add-on applications using the same procedures as the previous CLIÉ handheld. Some third-party applications may operate only on your old CLIÉ handheld.

**Using the Palm™ Desktop for CLIÉ software to transfer data**

For the Palm OS® basic applications data such as Address Book, Memo Pad, To Do List, Date Book, you can use the Palm Desktop for CLIÉ software to transfer data from your old CLIÉ handheld to your new CLIÉ handheld by exporting and importing data.

Before you start, perform a HotSync® operation to the Palm Desktop for CLIÉ software using your new CLIÉ handheld with a different user name from that you have used with the old CLIÉ handheld.

1. Start the Palm Desktop for CLIÉ software.

2. Click the user name of your previous CLIÉ handheld from the User name list in the upper right of the screen.

3. Click the icon of the application whose data you want to copy in the left panel of the screen.

4. Click Export from the File menu.

5. Enter the file names and click Export.
   The data of your old CLIÉ handheld is exported. Change the destination folder if necessary.
Using data of another Sony CLIÉ Handheld

6 Repeat steps 3 through 5 to export data of other applications.

7 Click the user name of your new CLIÉ handheld from the User name list in the upper right of the screen.
   If you have never performed a HotSync operation with your new CLIÉ handheld, select Users from the Tools menu. Click New in the Users screen and enter a new user name. Then select that new user name.

8 Click Import from the File menu.

9 Select the files you have exported in steps 3 through 6 and click Open.

10 Connect your new CLIÉ handheld to the USB cable and perform a HotSync operation.
   The data exported from your old CLIÉ handheld is copied onto your new CLIÉ handheld.

Notes on a HotSync operation
- Do not attempt to transfer data from your old CLIÉ handheld to your new CLIÉ handheld by performing HotSync operations with the identical user name. Doing so may cause a malfunction.
- When you perform a HotSync operation with your new CLIÉ handheld and the New User dialog box is displayed, enter a different user name from that of your old CLIÉ handheld. If you enter the identical user name, the Palm Desktop for CLIÉ software may not be able to recognize the difference between your CLIÉ handhelds and the data of both handhelds may be mixed up or deleted.
- If you copy UnsavedPreference, the user name is also copied. This prevents you from managing the two CLIÉ handhelds with different user names.
Using data of another Sony CLIÉ Handheld

Using Memory Stick® media to transfer data

You can use Memory Stick media to transfer data of your old CLIÉ handheld to your new CLIÉ handheld.

**Notes**
- Use Memory Stick media that has sufficient free memory space.
- Make sure that the write protect tab on the Memory Stick media is not set to LOCK.

1. Insert Memory Stick media into your other CLIÉ handheld.

2. Rotate the Jog Dial™ navigator to select MS Gate and press the Jog Dial navigator. Or tap the MS Gate icon on the Application Launcher screen.

The Memory Stick Gate application starts up. The data in your CLIÉ handheld is listed.

3. Tap to select the data of the application whose settings and information you want to use with your new CLIÉ handheld. You can select multiple files.
   - Address Book: AddressDB
   - Date Book: DatebookDB
   - Memo Pad: MemoDB
   - Mail: MailDB
   - To Do List: ToDoDB
   - Network setup information: NetworkDB

**Notes**
- You cannot copy data marked with the lock icon.
- You cannot copy Graffiti® ShortCuts and Net Prefs.
- Do not select UnSavedPreference. Your computer may not be able to distinguish your new CLIÉ handheld from your old CLIÉ handheld.

4. Tap COPY.

The File Overwrite confirmation message is displayed.
**Using data of another Sony CLIÉ Handheld**

5  Tap OK.
   The data selected in step 3 is copied onto Memory Stick media.

6  Remove the Memory Stick media from your other CLIÉ handheld and insert it into your new CLIÉ handheld.

7  Rotate the Jog Dial navigator to select MS Gate and press the Jog Dial navigator. Or tap the MS Gate icon on the Application Launcher screen.
   The Memory Stick Gate application starts. The data in your CLIÉ handheld is listed.

8  Press the Jog Dial navigator to select MS.
   You can also tap the arrow in the upper right corner to select MS from the drop-down list.

9  Tap to select the applications and data you have previously copied from the older device.

10 Tap COPY.
    The File Overwrite confirmation message is displayed.

11 Tap OK.

12 If the file overwrite confirmation message is displayed, tap Yes to All.
   The data of your old CLIÉ handheld is copied onto your new CLIÉ handheld.

**Note**

If a file-locked, access, or delete error message is displayed while copying files, tap OK to proceed to the next step in copying. Those files, however, will not be copied.
Performing a HotSync® operation between your old CLIÉ handheld and the new Palm Desktop for CLIÉ software

If you already own a CLIÉ handheld before PEG-SL10/PEG-SJ20/PEG-SJ30, you can perform a HotSync operation between that CLIÉ handheld and the Palm Desktop for CLIÉ software supplied with the PEG-SL10/PEG-SJ20/PEG-SJ30.

After setting up your CLIÉ handheld as indicated in the Read This First manual, perform the HotSync operation as indicated on page 103.

If you have any trouble with the HotSync operation, perform the following.

• Check the Windows task tray to make sure that Local USB is selected.
• Check the Windows task tray to make sure that the USB Switcher is running (PEG-S300, PEG-N710C only).

**Note**

The Palm Desktop for CLIÉ software supplied with the PEG-SL10/PEG-SJ20/PEG-SJ30 does not support “Expense.”
Precautions

Notes on use

• Be sure not to scratch or damage your CLIÉ handheld’s screen or the Graffitti® writing area. Always use the supplied stylus or a plastic-tipped pointer to tap on the screen. Do not use a real pen, pencil, or other sharp object on the screen.
• Do not expose your CLIÉ handheld to rain or moisture. Should water enter the circuitry through the crevice around the front buttons, your CLIÉ handheld may be damaged.
• Your CLIÉ handheld screen is made of glass. Do not drop or submit your CLIÉ handheld to external shock. Do not carry your CLIÉ handheld in your back pocket. If you sit down with your CLIÉ handheld in the back pocket, the CLIÉ handheld may break.
• Avoid using or storing your CLIÉ handheld in locations subject to:
  – extremely high temperature, such as inside a car left exposed to the sun, or near a heater.
  – direct sunlight
  – high humidity
  – excessive dust
• During a thunderstorm, do not touch the connection cord or AC adapter. Touching them may cause an electric shock. (PEG-SJ20/PEG-SJ30 only)
• To prevent fire or shock hazard, do not expose the AC adapter to water or moisture. (PEG-SJ20/PEG-SJ30 only)

Cleaning your CLIÉ handheld
Clean your CLIÉ handheld with a soft, dry cloth.

Cleaning the stylus
Using a stylus that is covered with dust can damage the screen. Clean the stylus by wiping it with a soft cloth.
Precautions

Battery considerations (PEG-SL10)

Follow these precautions when you install or replace the batteries.

When replacing the batteries

• INSERT THE NEW BATTERIES WITHIN 1 MINUTE AFTER REMOVING THE EXHAUSTED ONES. IF THE BATTERY IN YOUR CLIÉ HANDHELD IS FULLY DISCHARGED OR REMOVED, ALL DATA STORED ON THE SDRAM (MEMORY) IS LOST. IN SUCH A CASE, PERFORMING A HOTSYNC® OPERATION ONCE THE BATTERIES ARE REPLACED CAN RESTORE BACKED UP INFORMATION SAVED ON YOUR COMPUTER (FROM THE LAST HOTSYNC OPERATION) TO YOUR CLIÉ HANDHELD. FOR DETAILS, SEE “BACKING UP DATA TO YOUR COMPUTER THROUGH A HOTSYNC® OPERATION” ON PAGE 184.

• Be sure to turn your CLIÉ handheld off, before removing/inserting batteries.

• Be sure to replace both batteries with new ones.

General battery tips

• To avoid possible damage from battery leakage or corrosion, observe the following:
  - Be sure to insert the batteries with the +/− polarities matched to the +/− marks.
  - Do not charge dry batteries.
  - Do not use a combination of new and old batteries.
  - Do not use batteries other than the types specified.
  - Do not use a combination of different types of batteries.
  - Do not use leaking batteries.

• Batteries left in your CLIÉ handheld for an extended period of time will run down, even if your CLIÉ handheld is not used.

• Do not use manganese batteries in your CLIÉ handheld.

• When you are not going to use your CLIÉ handheld for a long time, remove the batteries to prevent damage from battery leakage and corrosion.
Charging the internal power source
To avoid losing data stored on your CLIÉ handheld, do not remove new batteries during the first 1 hour after inserting them.
Your CLIÉ handheld has a small internal power source to maintain your data while you switch batteries. This internal power source is charged from the batteries when you first insert batteries into your CLIÉ handheld or when you insert new batteries after a long period of not using your CLIÉ handheld. Charging the internal power source takes about 1 hour. If you remove the batteries before the internal power source is charged, your CLIÉ handheld’s memory will revert to the factory settings and any data you have entered will be lost.

If batteries are leaking
• Carefully wipe off any liquid in the battery compartment before inserting new batteries.
• If battery leakage comes in contact with your skin, wash it off immediately.
• If battery leakage comes in contact with your eyes, immediately rinse your eyes thoroughly with water and promptly seek medical attention.

Battery life
• With new alkaline batteries, you can use your CLIÉ handheld for approximately 20 days*.
  * Based on an average of 30 minutes use of PIMs per day, with the backlight off.
• Battery life varies depending on the conditions and environment where you use your CLIÉ handheld.

• IF THE BATTERY IN YOUR CLIÉ HANDHELD IS FULLY DISCHARGED OR REMOVED, ALL DATA STORED ON THE SDRAM (MEMORY) IS LOST. IN SUCH A CASE, PERFORMING A HOTSYNC® OPERATION ONCE THE BATTERIES ARE REPLACED CAN RESTORE BACKED UP INFORMATION SAVED ON YOUR COMPUTER (FROM THE LAST HOTSYNC OPERATION) TO YOUR CLIÉ HANDHELD. FOR DETAILS, SEE “BACKING UP DATA TO YOUR COMPUTER THROUGH A HOTSYNC® OPERATION” ON PAGE 184.
Precautions

Tips on conserving the battery
- Turn off the backlight under good lighting conditions. For turning off the backlight, see “Adjusting the screen” on page 24.
- Change the automatic shut-off time setting so that your CLIÉ handheld will automatically turn off after a short period of inactivity. For details, see “Setting the automatic shut-off time” on page 165.

When your batteries become weak
- When the batteries become weak, a caution message appears on the screen. If this occurs, perform a HotSync® operation to back-up all the data of your CLIÉ handheld to your computer. Then replace the batteries with new ones. This helps prevent accidental data loss.
- If your CLIÉ handheld does not turn on when you press the POWER button, replace the batteries with new ones immediately.
- The remaining battery indicator does not always reflect the actual battery amount. The battery is designed to provide years of service under normal use. To prevent accidental data loss, replace the batteries with new ones immediately.

When using peripheral devices
If a message appears that your CLIÉ handheld is low on batteries, promptly discontinue the use of your CLIÉ handheld and replace the batteries with new ones.
If you continue to use the CLIÉ handheld without replacing the batteries, data stored on your CLIÉ handheld may be lost.

When the remaining battery indicator reads zero
If your battery drains and you leave your CLIÉ handheld without replacing the batteries for an extended period of time, all of the stored data will be erased. Sony suggests you replace the batteries with new ones immediately.
Follow these precautions when you charge your CLIÉ handheld.

**Battery safety**
To prevent a battery from leaking, heating up, catching fire, bursting, etc., be sure to follow the cautions below:
- Do not charge the battery in any other way than specified in this manual.
- Do not throw the battery into fire, short-circuit it, take it apart, or heat it in an oven such as a microwave.
- Do not charge the battery near fire or in direct, bright sunlight, or do not leave it in a car.
- Do not subject the unit to excessive shock.
  Take care not to drop it, give pressure to it, or place any heavy objects on it to prevent a malfunction.
- If you touch an electric leakage or have it in your eyes, bathe with clean water immediately, and consult your doctor.

**Charging your CLIÉ handheld**
- It takes approximately four hours to charge your CLIÉ handheld when the battery is empty.
- If you charge your CLIÉ handheld every day, it takes only a few minutes to charge the battery.
- You can operate your CLIÉ handheld while it is being charged.

**IF THE BATTERY IN YOUR CLIÉ HANDHELD IS FULLY DISCHARGED, ALL DATA STORED ON THE SDRAM (MEMORY) IS LOST. IN SUCH A CASE, PERFORMING A HOTSYNC® OPERATION ONCE THE BATTERY IS RECHARGED CAN RESTORE BACKED UP INFORMATION SAVED ON YOUR COMPUTER (FROM THE LAST HOTSYNC OPERATION) TO YOUR CLIÉ HANDHELD. FOR DETAILS, SEE “BACKING UP DATA TO YOUR COMPUTER THROUGH A HOTSYNC® OPERATION” ON PAGE 184.**
Precautions

Battery life
- With a fully-charged battery, you can use your PEG-SJ20 CLIÉ handheld for approximately 15 days* or your PEG-SJ30 CLIÉ handheld for approximately 12 days*.
  * Based on an average of 30 minutes use of PIMs per day, with the backlight off.
- Battery life varies depending on the conditions and environment where you use your CLIÉ handheld.

Tips on conserving the battery
- Turn off the backlight under good lighting conditions. For turning off the backlight, see “Adjusting the screen” on page 24.
- Change the automatic shut-off time setting so that your CLIÉ handheld will automatically turn off after a short period of inactivity. For details, see “Setting the automatic shut-off time” on page 165.

When your battery becomes weak
- When the battery becomes weak, a caution message appears on the screen. If this occurs, perform a HotSync® operation to back-up all the data of your CLIÉ handheld to your computer. Then charge your CLIÉ handheld. This helps prevent accidental data loss.
- If your CLIÉ handheld does not turn on when you press the POWER button, charge your CLIÉ handheld immediately.
- The remaining battery indicator does not always reflect the actual battery amount. The battery is designed to provide years of service under normal use. To prolong the battery’s life, charge it frequently even when it is not fully discharged.
- You do not have to replace batteries. When the remaining battery indicator reads zero, charge your CLIÉ handheld immediately. Never disassemble your CLIÉ handheld to take out the battery.

When using peripheral devices
If a message appears that your CLIÉ handheld is low on battery, promptly discontinue the use of your CLIÉ handheld and charge it.
If you continue to use the CLIÉ handheld without charging it, data stored on your CLIÉ handheld may be lost.

When the remaining battery indicator reads zero
If your battery drains and you leave your CLIÉ handheld in an uncharged state for an extended period of time, all of the stored data will be erased. Sony suggests you charge your CLIÉ handheld frequently.
Troubleshooting – Frequently Asked Questions

This section describes how to solve common problems you may encounter when using your CLIÉ handheld. If a problem arises, replace the batteries with new ones (PEG-SL10) or charge your CLIÉ handheld (PEG-SJ20/PEG-SJ30). If the problem persists, review the following list of frequently asked questions for possible solutions, before contacting Sony Customer Information Service Center.

**Note**

Thousands of third-party add-on applications are available for the Palm OS® platform. Sony does not support third-party applications. If you have a problem with a third-party application, contact the developer or publisher of that software.

Operating problems

I do not see anything on my CLIÉ handheld’s screen.

⇒ Replace the batteries with new ones (PEG-SL10) or recharge your CLIÉ handheld (PEG-SJ20/PEG-SJ30). If your CLIÉ handheld still does not operate, try a soft reset. See “Resetting your Sony CLIÉ Handheld” (page 25).

I get a warning message telling me my CLIÉ handheld’s memory is full.

⇒ Purge records from Date Book and To Do List. This deletes To Do List items and past Date Book events from the memory of your CLIÉ handheld.

⇒ Delete unused address entries, memos, and records. If necessary, you can save a backup for these records. See explanations for each application.

⇒ If you have installed additional applications on your CLIÉ handheld, remove them to recover memory. See “Removing add-on applications” in the Read This First manual.

⇒ Some applications may not operate properly if the memory is insufficient.
Troubleshooting – Frequently Asked Questions

My CLIÉ handheld keeps turning itself off.

➤ Your CLIÉ handheld is designed to turn itself off after a period of inactivity. This period can be set at one, two, or three minutes. See “Setting the automatic shut-off time” (page 165).

My CLIÉ handheld is not making any sounds.

➤ Check the System Sound setting. See “Setting sounds” (page 166).

My CLIÉ handheld has frozen.

➤ Perform a soft reset. See “Resetting your Sony CLIÉ Handheld” (page 25).

I performed a hard reset, but it does not solve my problem. (PEG-SL10 only)

➤ Leave your CLIÉ handheld for more than 12 hours after removing the batteries.

I cannot use the Jog Dial navigator.

➤ Check that the JogAssist feature is activated. See “Changing the Jog Dial™ navigator preferences” (page 159).

An error message is displayed repeatedly.

➤ Follow the instructions of the message.

Backlight does not turn on when I am adjusting the brightness level. (PEG-SJ30 only)

➤ When you are adjusting the brightness level, the LCD backlight turns on. When the brightness is set to the lowest level, the backlight does not turn on, but this is not a malfunction.
Troubleshooting - Frequently Asked Questions

Tapping and writing problems

When I tap the buttons or screen icons, my CLIÉ handheld activates the wrong feature.

 ➤ Calibrate the screen. See “What you can do with Preferences” (page 154).

When I tap the Menu icon, nothing happens.

 ➤ Not all applications or screens have menus. Try changing to a different application.

I cannot get my CLIÉ handheld to recognize my handwriting.

 ➤ For your CLIÉ handheld to recognize handwriting input with the stylus, you must use Graffiti® writing. See “Using Graffiti® writing to enter data” (page 12).

 ➤ Make the Graffiti character strokes in the Graffiti writing area, not on the display part of the screen.

 ➤ Write Graffiti strokes for letters on the left-hand side of the Graffiti writing area, and the strokes for numbers on the right-hand side of the same area.

 ➤ Make sure that Graffiti has not shifted into extended or punctuation modes. See “Using Graffiti® writing to enter data” (page 12).

 ➤ For tips on successful Graffiti writing, see “Using Graffiti® writing to enter data” (page 12).
Application problems

I tapped the Today button, but it does not show the correct date.

➔ Your CLIÉ handheld is not set to the current date. Make sure the Set Date box in the Date & Time Preferences screen displays the current date. See “Setting the Date & Time preferences” (page 162).

➔ Your CLIÉ handheld is not set to the correct time zone or the correct daylight saving setting. Make sure the Set Time Zone box and the Daylight Saving box in the Date & Time Preferences screen displays the correct setting. See “Setting the Date & Time preferences” (page 162).

I know I entered some records, but they do not appear in the application.

➔ Check the Categories drop-down list (upper-right corner). Choose All to display all of the records for the application.

➔ Check Security and confirm that Current Privacy is set to Show Records.

➔ In To Do List, tap Show and see if “Show Only Due Items” is selected.

I am having problems listing memos the way I want to see them.

➔ If you cannot manually arrange the order of the memos in the list screen, check the Memo Preferences setting. Make sure that Sort by is set to Manual.

➔ If you choose to view your memos alphabetically on the Palm™ Desktop for CLIÉ software and then perform a HotSync® operation, the memos on your CLIÉ handheld still appear in the order defined in the Memo Preferences setting, since the sort settings you use with the Palm Desktop for CLIÉ software are not transferred to your CLIÉ handheld.
Troubleshooting - Frequently Asked Questions

I created an event in Date Book, but it does not appear in the Week view.

⇒ In the Week view, you cannot select overlapping events that have the same start time. If you have two or more events with the same start time, choose the Day view to see overlapping events.

I cannot find an image pasted in an Address Book entry.

⇒ If you use the Palm Desktop for CLIÉ software to change the category of the Address Book entry, you may not be able to locate the pasted image on your CLIÉ handheld. Change the category on your CLIÉ handheld.

I cannot start applications installed in the Memory Stick media.

⇒ In order to open such applications from the Application Launcher screen, a memory space exceeding the application size must be kept free on your CLIÉ handheld.

⇒ Check if the application files or data files (such as image files) essential to starting the applications are stored under the “/PALM/Launcher/” directory of the Memory Stick media. If so, the CLIÉ handheld may not be able to access the data files or application files. Copy or move the file data to the CLIÉ handheld using the Memory Stick Gate application (page 145, 147).

⇒ Verify that you installed application or data from your computer to the CLIÉ handheld by a HotSync operation, and selected Memory Stick as their destination. If you did, copy or move the data to your CLIÉ handheld (page 145, 147).
Troubleshooting - Frequently Asked Questions

**HotSync® operation problems**

**I cannot perform a HotSync® operation. What should I check to make sure I am doing it correctly?**

- Check that the operating system of your computer is Windows® 98 Second Edition/Me/2000 Professional/XP.
- Check the Windows task tray to make sure the HotSync Manager is running. If it is not running, open the HotSync Manager from the Start menu.
- Make sure that the USB cable is connected securely to the computer.

**I performed a HotSync operation, but one of my applications did not synchronize.**

- Click the HotSync Manager and choose Custom. Check that the correct conduit is active.

**I am using Outlook® as my PIM, but I cannot perform a HotSync operation.**

- Click the HotSync Manager and choose Custom. Check that the correct conduit is active.
- Check that the correct conduit is installed. Reinstall the HotSync Manager and make sure the correct conduit is selected.
- Make sure that Intellisync Lite is installed. See “Step 4: Installing the Palm Desktop for CLIÉ software on your computer” in the Read This First manual for details.

**I cannot launch the HotSync Manager.**

- Make sure that you are not running another program, such as a network or facsimile applications, that uses the serial port you selected in the Setup dialog box.
- Back-up the Palm Desktop for CLIÉ software, uninstall it, then reinstall it.
- Make sure that Local USB is selected.
Troubleshooting - Frequently Asked Questions

I tried to perform a local HotSync operation, but it did not complete successfully.

Try each of these in turn:

- Make sure that HotSync Manager is running. If HotSync Manager is running, exit, and restart it.
- Make sure that Local Serial is not selected in the HotSync Manager menu or the Palm Desktop for CLIÉ software menu.
- Check that the USB cable is properly connected to the USB connector of your computer.
- Read the HotSync Log for the user account for which you are performing a HotSync operation.
- Make sure your CLIÉ handheld is securely connected to the USB cable.
- Make sure that the gold-plated connectors on the USB cable and your CLIÉ handheld are clean. Use a pencil eraser to clean the connectors.

I cannot perform an IR HotSync operation.

- Make sure that the HotSync Manager is running and the Serial Port for local operations is set to the simulated port for infrared communication.
- On your CLIÉ handheld, make sure that the HotSync application is set to IR to a PC/Handheld.
- Make sure that the IR port of your CLIÉ handheld is aligned directly opposite to, and within a few inches of, the infrared device of your computer.
- IR HotSync operations do not work after you have received a low battery warning. Check the battery power of your CLIÉ handheld. If necessary, replace the batteries with new ones (PEG-SL10) or recharge your CLIÉ handheld (PEG-SJ20/PEG-SJ30).
- If you have problems using a specific speed, select Prefs, Connection, IR to a PC/Handheld, Edit, then Details. Then select a lower speed in the Details dialog box.

Continued on next page
Troubleshooting - Frequently Asked Questions

My CLIÉ handheld appears to freeze when I place it near my computer.

➤ Move your CLIÉ handheld away from the computer’s infrared port.
➤ Make sure that you turn the Beam Receive function off.

My CLIÉ handheld displays the message “Waiting for sender” when it is near my computer’s infrared port.

➤ Your computer’s infrared port may be set to search automatically for the presence of other infrared devices. Do the following to turn off this option:
1 In the Windows task bar, select Start, point to Settings, and select Control Panel.
2 Double-click Infrared.
3 Click the Options tab.
4 Clear the selection of the option “Search for and provide status for devices within range.”
5 Click Apply and OK.

➤ Move your CLIÉ handheld away from the computer’s infrared port.
➤ Make sure that you turn the Beam Receive function off.

I cannot cancel a HotSync operation midway.

➤ You may not be able to cancel a job a few seconds after you start a HotSync operation via a USB connection. Wait for a few seconds and try again.

I cannot backup some data at a HotSync operation.

➤ Some data is designed not to be backed up by a HotSync operation.
When I tap the HotSync icon on the HotSync screen, nothing happens on the Palm Desktop for CLIE software and my CLIE handheld times out.

- Check the Palm Desktop for CLIE software HotSync Setup options to confirm that you have the correct settings for local HotSync operations.

- Make a copy of your Palm folder. Uninstall and reinstall the Palm Desktop for CLIE software.

- Turn on your CLIE handheld and tap the Home icon. Tap the HotSync icon, then tap Local.

When I perform a HotSync operation, my information does not transfer to the Palm Desktop for CLIE software.

- If you have performed a HotSync operation successfully, but you cannot find the data from your CLIE handheld on the Palm Desktop for CLIE software, check to see that you have the correct user name selected for viewing data.

- Click the HotSync Manager and choose Custom. Check that all conduits are set to synchronize files.

I want to synchronize my computer with more than one CLIE handheld.

- When the computer running the Palm Desktop for CLIE software is to synchronize with more than one CLIE handheld, each CLIE handheld must have a unique user name. Assign a unique user name to your CLIE handheld the first time you perform a HotSync operation.

- Please be aware that synchronizing with more than one CLIE handheld with the same user name causes unpredictable results, and potentially, loss of your personal information.
Connection problems

I have trouble establishing a network connection to my ISP or dial-in server.

► Check the Expanded Service Connection Progress messages to identify the point where the connection fails in the log in procedure. Press the scroll button downwards at any point during log in to display these messages.

► Check the information in the Network Log so your ISP or your System Administrator can pinpoint where the log in procedure communication fails and why.

To view the Network Log, open the Network Preferences screen and tap the Menu icon. Tap Options, then View Log. Tap the up and down arrows of the scroll bar to see the entire Network Log.

Beaming problems

I cannot beam data to another Palm OS PDA.

► Confirm that your CLIÉ handheld and the other Palm OS PDA are between 4 inches (approximately 10 centimeters) and 8 inches (approximately 20 centimeters) apart, and that the path between the two handhelds is clear of obstacles. Beaming distance to other Palm OS PDA may be different.

► Move your CLIÉ handheld closer to the receiving handheld.

► Make sure that the Beam Receive function of the other Palm OS PDA is turned on.
Troubleshooting - Frequently Asked Questions

When someone beams data to my CLIÉ handheld, I get a message telling me it is out of memory.

➤ Your CLIÉ handheld requires a memory space of at least approximately 1.1 times the data size that you are receiving.

➤ Perform a soft reset. See “Resetting your Sony CLIÉ Handheld” (page 25) for more information.

I cannot beam Address Book data.

➤ You cannot beam images to a Palm OS PDA other than a Sony CLIÉ handheld.

Recharging problems (PEG-SJ20/PEG-SJ30)

When I connect my CLIÉ handheld to the AC adapter, it does not recharge.

Confirm that:

➤ Your CLIÉ handheld is connected securely to the AC adapter.

➤ Your AC adapter is plugged into an AC outlet.

➤ You are using the AC adapter that came with your CLIÉ handheld.

➤ Your CLIÉ handheld is turned off; otherwise, it will not fully charge.
Password problems

I forgot the password, and my CLIÉ handheld is not locked.

➤ You can use Security to delete the password, but your CLIÉ handheld deletes all records marked as private. To back up all data including private records, perform a HotSync operation before you delete the password. Then follow these steps to restore your private records onto your CLIÉ handheld:

1. Perform a HotSync operation to back up your data.
2. Tap Forgotten Password in Security to remove the password and delete all private records.
3. Perform a HotSync operation to synchronize your data and restore the private records by transferring them from your computer to your CLIÉ handheld.

I forgot the password and my CLIÉ handheld is locked.

➤ If you assign a password and lock your CLIÉ handheld, you must perform a hard reset to continue using your CLIÉ handheld. See “Resetting your Sony CLIÉ Handheld” (page 25) for more information.
Troubleshooting - Frequently Asked Questions

Memory Stick® media problems

I cannot copy/move data from Memory Stick® media to my CLIÉ handheld.

⇒ Your CLIÉ handheld requires a memory space of at least approximately 1.1 times the data size that you are copying/moving.

I inserted Memory Stick media, but the message “Please insert Memory Stick media” appears.

⇒ Your Memory Stick media is not recognized by your CLIÉ handheld. Remove it and reinsert it.
Troubleshooting - Frequently Asked Questions

If you still cannot perform a HotSync® operation

If you have reviewed items in the troubleshooting list and the HotSync® operation problem persists, review the following.

You cannot perform a HotSync operation before you install the Palm Desktop for CLIÉ software on your computer

If you perform a HotSync operation before you install the CLIÉ drivers, other drivers may be installed. Make sure to install the Palm Desktop for CLIÉ software first and then perform a HotSync operation.

Do not use a USB hub

If you connect the USB cable to your computer via a USB hub, you may not be able to perform a HotSync operation properly. Make sure to connect the USB cable directly to a USB port of your computer.
Some computers have the hub function built into their internal circuitry. Contact your computer manufacturer if the USB port of your computer is connected to an internal USB hub.

Check that the USB port of your computer is enabled

If you are using Windows 95 pre-installed computer or another old type of computer equipped with a USB port, the USB port may be disabled by default. If another device such as a USB mouse cannot be used, check the BIOS setting of your computer.
Also check the Device Manager. Right-click on My Computer and select Properties. Click Device Manager tab and check that USB controller is listed in the Device Manager screen.
Getting Help

Sony offers several support options for your CLIÉ handheld. When you have questions or trouble, please refer to one of the following for a solution:

■ **Read This First (supplied), Operating Instructions (this guide), and Add-on Application Guide (supplied)** describes how to use your CLIÉ handheld.

■ **Your Sony CLIÉ Handheld support Web site**
  http://www.sony.com/peg/support/
  Provides the latest information on your CLIÉ handheld. On this Web site, you will find:
  • Frequently Asked Questions (FAQs)
  • Online Operating Instructions
  • Installation information
  • Software updates
  • Online knowledge base

■ **The Sony e-mail support service** answers your questions by e-mail. Send your question, and a customer service representative will send you a reply. You can use the e-mail form at
  http://www.sony.com/peg/support/

■ **The Sony fax-back service** provides you with answers to commonly asked questions. You can use this automated service to access a list of available topics and then select the topics that you want to receive. To contact the Sony fax-back service, call 1-877-760-SONY (7669).

■ **The Sony Customer Information Service Center** offers information about your CLIÉ handheld and other Sony products that work with your computer. To contact the Sony Customer Information Service Center, call 1-877-760-SONY (7669).
Specifications

**OS**  Palm OS ver. 4.1

**CPU**  Dragonball VZ 33 MHz

**Memory**
- PEG-SL10:
  - ROM 4MB
  - 8MB (SDRAM), User memory range approx. 7MB
- PEG-SJ20/PEG-SJ30:
  - ROM 4MB
  - 16MB (SDRAM), User memory range approx. 15MB

**External input/output**
- Interface connector
- IrDA (1.2)
- Memory Stick slot

**Display**
- PEG-SL10/PEG-SJ20:
  - Monochrome LCD with backlight, 320 × 320 dots, 16 levels
- PEG-SJ30:
  - TFT color LCD with backlight, 320 × 320 dots, 65,536 colors

**Power requirements**
- PEG-SL10:
  - Two AAA (LR03) alkaline batteries: 3 VDC
- PEG-SJ20/PEG-SJ30:
  - AC power adapter (supplied): DC 5.2 V (dedicated connector)
  - Battery: Lithium ion battery (built-in)

**Battery life**
- PEG-SL10: 20 days*
  (Using SONY Alkaline batteries LR03 (SG))
- PEG-SJ20: 15 days*
- PEG-SJ30: 12 days*

* Based on an average of 30 minutes use of PIMs per day, with the backlight off. The battery life span varies depending on the temperature and conditions of use.

**Continuous operation of gMovie (with the backlight on)**
- PEG-SL10: 6 hours
  (Using SONY Alkaline batteries LR03 (SG))
- PEG-SJ20: 5 hours
- PEG-SJ30: 3 hours

Continued on next page
Specifications

Dimensions

PEG-SL10:
Approx. $2\frac{7}{8} \times 4\frac{1}{8} \times 2\frac{21}{32}$ inches (71.8 x 104.0 x 16.5 mm)
(w/h/d)
(projecting parts not included)

PEG-SJ20/PEG-SJ30:
Approx. $2\frac{7}{8} \times 4\frac{1}{8} \times 1\frac{11}{16}$ inches (71.8 x 104.0 x 16.8 mm)
(w/h/d)
(projecting parts not included)

Mass

PEG-SL10:
Approx. 3.6 oz (103 g)
(including the supplied stylus, excluding alkaline batteries)

PEG-SJ20:
Approx. 4.5 oz (128 g)
(including the supplied stylus)

PEG-SJ30:
Approx. 4.8 oz (137 g)
(including the supplied stylus)

Operating temperature

41 ºF - 95 ºF (5 ºC - 35 ºC)

Design and specifications are subject to change without notice.
Index

A

Address Book
  Editing ................................................... 54
  Entering a new entry .............................. 48
  Pasting an image ................................... 54
  Sorting entries ........................................ 51
  Using menus .......................................... 60
  Viewing entries ...................................... 50
Adjusting the screen ............................. 24
Application
  Categorizing .......................................... 81
  Launcher (home) screen ............................ 80
  Selecting/Starting ................................... 80
  Setting applications to start
  automatically ........................................... 136
  Starting an application in
  Memory Stick media ............................... 136
  Troubleshooting ..................................... 203
Application buttons
  Assigning applications to buttons ............ 156
  Selecting applications ............................. 80
Attaching notes ..................................... 97
Automatic shut-off time ....................... 165

B

BACK button .............................................. 8, 159
Backing up data
  By a HotSync operation (to computer) ... 184
  By Memory Stick Backup
    (to Memory Stick media) ....................... 185
  By Memory Stick Gate
    (to Memory Stick media) ....................... 187
Backlight
  Adjusting the brightness ...................... 24
  Turning on and off ................................. 24
Battery considerations
  Tips and notes ................................. 195, 198
  Troubleshooting ................................. 210
Battery life ..................................... 196, 198
Beaming
  Between two handhelds ......................... 129
  Receiving data .................................... 131
  Sending items or categories ................... 130
  Tips on beaming .................................. 131
  Troubleshooting ................................... 209

C

Calculator
  Using buttons ......................................... 79
  Using calculator ................................. 78
  Using menus .......................................... 79
Card Info .............................................. 137
Categories
  Categorizing applications ...................... 81
  Categorizing items .............................. 76, 84
  New categories ...................................... 86
  Viewing items by categories
    ................................................... 50, 63, 72, 85
Choosing fonts .................................. 100
Cleaning .............................................. 194
Contrast .............................................. 24
Copying
  From CLIÉ handheld to
  Memory Stick media ............................ 143
  From Memory Stick media to
  CLIÉ handheld .................................... 145
  Restoring back-up to your
  CLIÉ handheld .................................... 186

Continued on next page
Index

D

Date Book
  Agenda view ........................................ 39
  Day view ........................................... 35
  Editing ............................................. 41
  Month view ....................................... 38
  Repeating or continuous events ............. 31
  Scheduling an event ............................ 28
  Setting alarm .................................... 43
  Using menus ....................................... 46
  Week view ......................................... 36
Deleting
  Data in the Memory Stick media ............ 148
  Items ............................................. 45, 58, 67, 75, 98
Digitizer ............................................ 154
Dragging ............................................. 10

E

Edit menu ............................................ 99
Entering data
  Computer keyboard ................................ 23
  Graffiti writing .................................. 12
  Onscreen keyboard ................................ 21

F

FAQ(Frequently Asked Questions) .......... 200
File Link ............................................ 127
Finding items
  Find option ....................................... 87
  Phone Lookup .................................... 89
Formats .............................................. 160
Formatting Memory Stick media ............ 138
Full-screen dragging ....................... 10, 157

G

Getting Help ...................................... 214
Graffiti® writing
  Accented characters ............................ 19
  Alphabets ......................................... 15
  Basic procedures ................................ 12
  Letters/numbers writing area ............... 12
  Non-English characters ....................... 19
  Numbers ........................................... 16
  Onscreen help ................................... 14
  Overview ......................................... 12
  Punctuation marks .............................. 17
  ShortCuts ......................................... 20, 170
  Symbols and extended characters .......... 18

H

Hard reset .......................................... 26
HotSync operation
  File Link .......................................... 127
  LANSync ........................................... 120, 123
  Network Modem Sync ........................... 120
  Overview ......................................... 102
  Selecting Conduit .............................. 109
  HotSync® button ................................. 102, 158
  HotSync® operation
    Setting setup options ......................... 107
    Troubleshooting ............................... 205
    Via IR port .................................... 111
    Via modem ..................................... 114
    Via network ................................... 120

Continued on next page
## Index

### I

- Importing data from a Windows application ......................................... 125
- IR port ...................................... 111, 129

### J

- Jog Dial navigator
  - Changing preferences ..................... 159
  - Compatible applications .................. 11
  - Displaying the Pop-up application menu ............................................................. 83
  - How to use (pressing/rotating) .......... 11
  - JogAssist function ........................ 159
- JogAssist function .......................... 159

### L

- Locking your CLIÉ handheld .............. 94
- Look up ........................................ 53

### M

- Making items private ...... 44, 76, 91, 96
- Memo Pad
  - Creating a new memo ...................... 70
  - Editing memos ............................. 75
  - Reviewing memos .......................... 72
  - Using menus ................................ 77
- Memory Stick Backup
  - Backing up all CLIÉ data to Memory Stick media .............................................. 185

### Memory Stick Gate

- Copying CLIÉ data to Memory Stick media ...................................................... 143
- Copying Memory Stick data to CLIÉ handheld .............................................. 145
- Deleting data ................................... 148
- Formatting Memory Stick media .......................... 138
- Notes on moving or copying data ........ 142
- Starting ....................................... 140
- Transferring data between two CLIÉ handhelds ............................................ 191
- Using menus ................................... 150

### Memory Stick® media

- Attaching a name............................. 137
- Default folder ................................ 140
- Formatting ...................................... 138
- Inserting and removing ...................... 133
- Installing applications without Memory Stick Gate ........................................... 150
- Notes on using ................................ 134
- Overview ..................................... 132
- Protecting data .............................. 135
- Starting an application ..................... 136
- Troubleshooting ............................. 212
- Types ......................................... 132
- Viewing media information .............. 137

---

**Chapter 6** Additional information
Index

N
Network preferences ......................... 172
  Log in script .................................. 178
  Password ...................................... 173
  Selecting a connection ...................... 174
  Selecting a service .......................... 172
  Service template ............................. 175
  Telephone setting ............................ 174
  User name .................................... 173
  Using menus .................................. 181
Notes on use .................................. 194

O
Onscreen keyboard ............................. 21
Owner information ............................. 169

P
Palm Desktop for CLIÉ
  Basic operations .............................. 105
  Locating screen components ................. 106
  Starting ....................................... 105
Password
  Deleting a password ......................... 92
  Entering a password ......................... 91, 95, 173
  Locking your CLIÉ handheld .................. 94
  Troubleshooting ................................ 211
Phone Lookup .................................. 89
PIM (Personal Information Management)
  Address Book .................................. 48
  Calc (Calculator) .............................. 78
  Common tasks .................................. 80
  Date Book ..................................... 28
  Edit menu ..................................... 99
  Memo Pad ...................................... 70
  To Do List ..................................... 62
POWER button ................................. 8
Precautions .................................... 194
Preferences
  Alarm ........................................... 167
  Beam Receive feature ......................... 168
  Buttons ....................................... 156
  Date & Time preferences ..................... 162
  Digitizer ..................................... 154
  Formats ........................................ 160
  Full-screen pen stroke activities ........... 157
  General preferences .......................... 165
  Graffiti ShortCuts ............................. 170
  HotSync button ................................ 158
  Network preferences .......................... 172
  Overview ..................................... 154
  Owner information ............................ 169
  Password ..................................... 173
  Setting daylight saving time .................. 164
  Setting the date .............................. 162
  Setting the time .............................. 163
  Setting the time zone ......................... 164
  Sounds ........................................ 166
  Time, date, and number formats ............. 161
  User name .................................... 173
Protecting data ............................... 91
Purging records ............................... 98

R
Reset
  Hard reset ..................................... 26
  Reset button .................................. 25, 26
  Soft reset ..................................... 25

Continued on next page
Index

S
Security ................................................ 91
Selecting text in an application ........... 99
Setting
  Alarm .................................................. 167
  Automatic shut-off time ....................... 165
  Date .................................................... 162
  Daylight saving time ............................. 164
  Number formats ................................... 161
  Priorities ................................................ 65
  Sounds ................................................. 166
  Time .................................................... 163
  Time zone ............................................ 164
Soft reset ............................................ 25
Sorting items ................................. 52, 73
Specifications .................................... 215
Stylus
  How to use .............................................. 9
  Taking out the reset tip ....................... 25
Synchronizing with external data ...... 127

T
Tapping .................................................. 9
To Do List
  Changing appearance ............................ 68
  Checking off items ................................ 64
  Creating items ...................................... 62
  Setting priorities ..................................... 65
  Setting the due data ............................... 66
  Using menus .......................................... 69
  Viewing items ........................................ 63
Transferring data between two
CLIÉ handhelds
  Using Memory Stick media .................. 191
  Using Palm Desktop for CLIÉ ............... 189

Troubleshooting
  Applications ........................................... 203
  Beaming .............................................. 209
  Connection .......................................... 209
  HotSync operations ............................. 205
  Memory Stick media ............................. 212
  Operations .......................................... 200
  Password ............................................. 211
  Recharging .......................................... 210
  Tapping and writing ............................ 202
  Turning your CLIÉ handheld on and off
  .......................................................... 8

U
User name .............................................. 173
For the latest support information, check our official Sony CLIÉ Web site

http://www.sony.com/clie/

For information on accessories


http://www.sony.net/